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About This Version 1.01 - September, 2015

1. Summary
For the beta-testing of ParkSEIS during the last several months to crowd-source bug-fixes, several users
actively participated by sending carefully prepared bug reports and suggestions for possible
improvements in various aspects. Their contributions greatly improved the overall user experience and
functionality of the software. Some of the reported bugs were minor, and some were critical.
The most recent issue with help files is described here with a way to resolve it. Additions and
modifications made based on the participants' feedback are explained here. Major bugs are listed in the
table and briefly explained (if necessary) about how they were handled.

2. Help Files Not Opening
(Windows 8 and Adobe Acrobat Reader DC with Protected Mode)
Help files are available at various places of ParkSEIS in the form of user guides in PDF. These files may
not be opening when invoked within the ParkSEIS program, and the PDF reader can freeze up. This
occurs only under Windows 8 with Adobe Acrobat Reader DC installed as default PDF reader, and the
issue has been widely reported online with other programs that attempt to open PDF internally. This is
related to an incompatibility of the reader when the "Protected Mode" is enabled.
To solve this issue, system has to restart first to break the "freeze" of the reader. Then, open the
Acrobat Reader DC, and do the following:
1) Choose Edit -> Preferences.
2) In the Categories list on the left, select Security (Enhanced).
3) In the Sandbox Protections section, deselect Enable Protected Mode At Startup.

2

About This Version 1.01 - September, 2015

3. Additions and Modifications
3.1 Generation of Roll-Along Records
When importing a seismic data file for dispersion image generation, the program will examine the
acquisition format of the input data and will issue the following dialog asking to generate roll-along type
input records if the input format is not such a type. If selected, then the control dialog will appear
where the source offset (X1) and the number of rolling channels can be specified. The default values are
the ones detected by the program as most optimal.

The generation of roll-along type records can also be performed from a display of seismic data by
selecting the "Edit" tab on top. Then, press the roll-along button to display the control dialog shown
above.
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3.2 Horizontal Coordinates for Seismic Display
Options are available for display of horizontal coordinates for station numbers and survey distance.
Right click each button to show the control dialog illustrated below. For both types, three options are
available: receiver, source, and receiver-source midpoint.
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3.3 Undo Edit in 1-D Velocity (Vs) Display
When editing values in a 1-D velocity (Vs) display, previously edited models can be displayed by pressing
the "Undo" button in the "Edit" tab as shown below. Right click the “Undo” button to redo.

3.4 Minimum Depth for Average Vs (Vave)
Minimum depth can be specified in the control dialog to calculate the average velocity (Vave) of a 1-D
velocity profile as shown below.
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3.5 Zero Padding and Reverse Polarity
When exporting seismic data from a display window by pressing the "Cut/Append" button in the "Edit"
tab as shown below, there are now two additional options available: "Reverse Polarity" and zero
padding. The first option will reverse the polarity of seismic data in the output file, and the second
option will add zeros at the end of the current recording time if the "End" time is specified longer than
the current recording time.

6

About This Version 1.01 - September, 2015

4. Table of Bug Fixes
Type Code
DA: Dispersion Analysis, DD: Dispersion Display, GE: General, IA: Inversion Analysis
SR: Source/Receiver (SR) Setup, Vs1D: 1-D Vs Display, UT: Utility
Type

Issues
(Comments on solution)

Fixed
()

DA

After extracting the dispersion curve, attempting to zoom in a specific area in the
dispersion image would delete some data points of the extracted curve. (Press the
zoom button in "Scale" tab, and then specify the area to zoom in)



VS1D

When performing a 1-D inversion from a .dc file and then minimizing the window, the
window disappears and is not able to be maximized again.



DD

When creating seismic data from an inverted model and then creating the OT (or
dispersion image) from that data, it appears that the filters OT-Filt and OT-STK do
nothing, and furthermore right clicking on them does nothing.



SD

When processing seismic data to add noise, there is a problem when clicking Ok button
to process once, and then on the next time clicking cancel, and then trying to process
again.



SR

When importing a file and then looking at the geometry, the windows seem to have
problems where the user is forced to press Alt-F4 to regain control of the program.



DD

In dispersion-image display, the 2-D AGC gain ("Gain" button) appears to be not what it
should look like.



GE

The open-file dialog sometimes does not allow user to change its size.



VS1D

Dispersion curves displayed in the 1-D s-velocity (Vs) profile cannot be flipped
vertically so that they can be better compared with model Vs profile. (This is now
possible by clicking the axis and display a control dialog where there is a separate
option to "invert" the axis)



SR

It does not appear that program has the ability to divide files of shots inside an array
into the roll-along records. (There is an additional option under "Edit" tab in the
seismic display that enables this. Also, the program will detect this automatically at
the necessary stages and inform the user if the new preparation of input data is to be
executed first)



SR

"Invalid floating point operation" error sometimes occurs when the source/receiver
(SR) setup is performed. (This happened when the input record does not have
consecutive channels starting from 1. The program will now detect this and inform the
user of the automatic channel rearrangement)



SR

Display of source/receiver (SR) configuration when importing input SEG-2 files
contained some buttons that, when clicked, made the system freeze up. (Now, these
buttons are disabled when SEG-2 files are imported. They are enabled only when a file
of PS format is imported)
After a setup for source/receiver (SR) configuration for passive data has been executed
for a 2-D receiver array, the array configuration of the output file appears to be wrong
with a certain degree of distortion observed. This happens especially when the size of
the array is relatively small. (This was caused by a round-off error introduced in the



SR
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IA

SR

UT

SR

DA

output header after applying a multiplication factor of '10' although it should be '100.'
This factor is now automatically adjusted based on the array size.)
Sometimes when trying to perform a 2-D inversion and selecting various dispersion
curves, the inversion only selects a couple (or only 1) of the dispersion curves. When
this occurs there appears to be no way of including the missing dispersion curves into
the inversion. (This is because there are multiple dispersion curves that have the same
surface coordinates, and are therefore discarded from the analysis. When this
happens, the program will display notification.)
When setting up the source/receiver configuration with a receiver spacing of 0.5m,
setting the offset at 0.25m or 0.5m completely changed the receiver locations. (This
was caused by an incorrect logic incorporated in the algorithm. Also, the program will
now inform the user that the source offset should be a multiple of the receiver
spacing.)
In the "Walkaway" utility, it is not possible to change the "Selected Record #" displayed
in each tab of STEP 1. (Now, it can be changed by selecting, i.e., by displaying, a proper
record within the corresponding seismic display window.)
Incorrect source/receiver (SR) configuration occurs, especially when the shot point was
inside the receiver array. (Several other glitches, including this, in the SR setup module
have been found and properly repaired.)
During dispersion image generation with a seismic record of a short recording time (for
example, shorter than 100 ms), an error message of "negative, or too low, frequency
detected for surface waves" is issued. (This case is now specially handled during the
FFT operation to avoid this error)









Display of seismic data or dispersion images does not work (additional windows briefly
open and close in an instance). Sometimes, an error message "Floating point division
by zero" is issued. Further analysis of data (for example, dispersion image generation)
then also results in an error. (This occurred under "multi-monitor" environment. This
environment is now automatically detected and handled properly.)
When only ‘Account for mode jump’ is activated in the inversion dialog, software
freezes. (This occurred only when the input dispersion curve has an 'inverse'
dispersion trend at very high frequencies; for example, frequencies higher than 5000
Hz. Actually, the software does not freeze, but it simply progresses so slowly that no
noticeable response can be observed for a while. It may take several hundred times
longer time than with the more common dispersion curves in relatively low
frequencies; for example, frequencies lower than 100 Hz.)
An error message of "Error in opening file <%>" is issued when trying to import data.
(This occurred when the input file name included a period (‘.’) in any part of the
complete path. The program now warns of this and suggests the user change the file
name or folder location.)



VS1D

Referring to the European / German norm, we need to calculate a value Vs3-20m for
Seismic Site Classification for the depth range between 3 m and 20 m below surface.
The calculation of average Vs assumes the starting depth is always zero ('0') although
the ending depth can be freely changed. (There is an additional input box included
now so the starting depth may be specified as well.)



VS1D

In the display of the "Layered Earth Model," the right-hand scale is reversed (0 m at
the bottom, greatest depth at the top). (This occurred due to the previous display of
dispersion curves in the same chart with inverted axis scale. The depth axis will now



GE

IA

GE
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VS1D

always show increasing depth toward bottom.)
Is it possible to add a switch to completely remove the “feet” and “feet/sec” axis
annotations? For us European they are always confusing. (Labeling of any axis can
now be completely removed by unchecking "Visible axis" option included in the Axis
Scale Control dialog, which pops up on clicking the axis.)



GE

An error message "... is not a valid floating point value" is issued and it is impossible to
perform any subsequent operation. (This occurred when the decimal symbol was
something other than a period. The program will detect the environmental setting for
this and notify the user to properly change it by going into the Windows control panel.)



DA

When input data contains very-high-frequency (VHF) surface waves (e.g., > 5 Khz) that
are recorded over a "hard" surface (e.g., pavement) with a significantly short receiver
spacing (e.g., ≤ 0.1m), all processing modules do not act properly. (This was due to an
incorrect detection of input data type and is now fixed. The SR setup, dispersion
analysis, and inversion analysis steps are now properly implemented.)
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About This Version 2.0 - September, 2016

1. Summary
Since version 1.01 was released a year ago, the functionality and user friendliness of ParkSEIS have been
greatly improved mostly due to extensive in-house operations, but also from suggestions and reports
from users. Most bugs found were minor, but a few of them were critical. All bugs we found have been
fixed. Updates, additions, and modifications incorporated into the current version (v. 2.0) are explained
here. Updates are listed with brief explanations in Table 1. Major bug fixes are listed in Table 2. There
are many other updates, upgrades, and bug fixes incorporated in this version that will be self
explanatory during software use.
Items that are considered "upgrades" are briefly explained below.
Velocity (Vs) Cross Section  Topographic Correction
("Display" -> "S-Velocity (Vs) Data" -> "2-D Vs Cross Section")
Topographic correction can now be applied to the 2-D velocity (Vs) cross section simply by importing a
2-column text file in which surface coordinates and elevations (or depths) are specified in the first and
second columns, respectively, separated by a space. The topo-corrected file will be saved as a separate
file, and the subsequent display of the file will accordingly account for the vertical bounds (i.e., top and
bottom) of the cross section.
Velocity (Vs) Cross Section  Interactive Edit
("Display" -> "S-Velocity (Vs) Data" -> "2-D Vs Cross Section")
A 2-D velocity (Vs) cross section is made of multiple 1-D Vs profiles, each of which is indicated by the
"Data Points" at the bottom of the section. Each 1-D profile can be opened simply by right clicking on
the corresponding data point. Further inversion operations then can be executed in this 1-D profile
display with an updated initial model or other inversion-related parameters. This 1-D profile update can
be accomplished through either manual or automatic inversion available in the top menu of the display.
The updated 1-D profile can then be carried over to the initial 2-D Vs cross section to change the overall
subsurface velocity (Vs) structure. In addition, from the 1-D profile display, the original measured
dispersion curve can also be opened with the corresponding dispersion image displayed on the
background, the image from which the curve was originally extracted. Then, the curve extraction can be
performed again based on new criteria, and the updated curve is carried over to the displayed 1-D Vs
profile. In this way, each data point in a 2-D Vs cross section can be completely revisited from the
beginning.
Source/Receiver (SR) Setup From Text-File Specifications
("Setup Source/Receiver (SR)")
Encoding surface coordinates of source and receivers (SR) can now be specified in a text file by using
several keywords such as "RECORD", "SOURCE", "CH1", "CH24", etc. This way of encoding can often be
more convenient than the graphical mode (GUI), especially when the data acquisition involves unusual
complications in geometry. This mode can also provide greater flexibility in SR setup.
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Seismic Modeling Specification from Seismic Data
("Modeling" -> "Seismic Data *")
Modeling a seismic record requires specification of several different characteristics such as source
spectrum (e.g., frequencies of amplitude spectrum), acquisition geometry (e.g., source offset, receiver
spacing, type of receiver array, etc.), and recording parameters (e.g., sampling interval and number of
samples). Values for all these characteristics can now be imported from existing seismic data that has
source/receiver (SR) setup applied [i.e., *(SR).DAT]. Frequency contents of seismic waves will be
specified by analyzing seismic waves in input data. Other parameters will be specified by reading
corresponding information in the header of input data.
Conversion of S-Velocity (Vs) to P-Velocity (Vp) Cross Section
("Display" -> "S-Velocity (Vs) Data" -> "2-D Vs Cross Section" -> "Edit" -> "+/-")
A 2-D S-velocity (Vs) cross section can be converted to a 2-D P-velocity (Vp) cross section by using
Poisson's ratio (POS). Two options are available for the selection of POS. The first option will let the
program use its own algorithm that will use POS values dynamically changing with Vs, while with the
other option a constant value of POS will be applied to all Vs values. The "dynamically varying" POS
algorithm is based on an empirical relationship that determines POS (nonlinearly) based on the Vs value;
for example, the lower Vs will give the higher POS.
Extraction of Dispersion Curve  Dynamic Bounds
("Dispersion" -> "Get Dispersion Curve(s) From Image Data" -> "Bounds" -> "Controls" -> "Bounds")
When the option "Adjust bounds dynamically" is checked, the two (upper and lower) bound curves will
follow the trajectory of the dispersion curve previously extracted. This option can provide a convenient
way of automatically updating bound curves when extracting dispersion curves from dispersion images
(i.e., step 2 of 'dispersion analysis').
Bedrock Contour Specification
("Display" -> "S-Velocity (Vs) Data" -> "2-D Vs Cross Section" -> "Process" -> "Bedrock*")
Multiple contour lines of different velocities (Vs's) can be drawn on the same 2-D Vs cross section.
Chart Scale Specification
("Display" -> "Dispersion Data" -> "Dispersion Image" -> "Scale" -> click "Vertical/Horizontal" Box)
The most optimum display scale will be automatically chosen (vertically and horizontally) based on the
energy trend of displayed image. Previously used (vertical and horizontal) scales can also be chosen
separately.
Common-Offset (CO) Section Generation from Display
("Display" -> "Seismic Data" -> "Edit")
Seismic data with source/receiver (SR) setup applied [*(SR).dat] can be sorted into common-offset (CO)
sections from display. Output will be saved as a separate file.
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2. Velocity (Vs) Cross section  Topographic Correction
Open an existing 2-D velocity (Vs) cross section [*(2DVs).TXT].

Select "Process" tab and click "Topo" (bottom) to open a
prepared 2-column text file (right) of elevation (or depth) data.

If the text file contains elevation data, then select "Yes." If it
contains depth data, then select "No."

Output topo-corrected velocity (Vs) cross section
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3. Velocity (Vs) Cross section  Interactive Edit
Opening an existing 2-D velocity (Vs) cross section [*(2DVs).TXT].

3.1 Edit Data Points in 2-D Velocity (Vs) Cross Section
(a) Shift + Click a data point at the bottom of the cross section.
(b) A corresponding 1-D shear-velocity (Vs) model is displayed that can be updated through manual
and/or automatic inversion process.
(c) A Vs model can be manually updated by using your mouse. Or, it can also be updated through
automatic inversion by clicking the “RUN” button. Then, to update the original velocity (Vs)
cross section, click the “Update” button.
(d) Once a Vs cross section is updated, the edited data point is marked by yellow, and the edit can
be undone (or redone) by clicking (right-clicking) the “Undo” button.
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3.2 Edit Dispersion Curve in 1-D Velocity (Vs) Profile
(a) To edit the original measured dispersion curve that generated the 1-D shear-velocity (Vs) profile
currently displayed, click the “Edit DC” button.
(b) The displayed dispersion curve can be manually edited by using your mouse; e.g., delete, add,
and move data points. Then, click the “INVR” button to run the inversion with the updated
curve.
(c) The inversion control panel will be displayed where inversion parameters can be modified or
adjusted, if necessary. Then, click the “OK” button to run the inversion that will update the 1-D
Vs profile.
(d) The updated 1-D Vs profile now has an updated dispersion curve. Subsequent inversion
processing (either manual or automatic inversion) will run using this updated curve.
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4. Source/Receiver (SR) Setup from Text-File Specifications
When clicking the 'Import a Setting' option in the front page of the SR setup dialog shown below left,
another dialog pops up (below right). On top of this dialog, there is now a new option added that
enables user to import a previously prepared text file. The other four (4) options listed in the box are
explained in section 2.3 of the user guide, "Setup Source/Receiver (SR)." This new option can be used
only for surveys using a linear receiver array. It is, however, not limited by survey type, which can be
one of the following three types; active, passive, and active-passive combined surveys.

This new option applies the SR setup to the input seismic data according to the scheme specified in the
imported text file, where the configuration of source and receivers (SR) is listed according to the format
described below. The format consists of several fields characterized by unique keywords with each field
separated by a comma (','). Each keyword is then accompanied with one or two numerical values as
explained in the following three examples.
Example 1
(Specification with Both Distance and Station Number)
Example 1 is a sample text file created using Windows Notepad that has only one line of SR specification
and other supplementary specifications of distance unit and survey type, both of which are optional:

7

About This Version 2.0 - September, 2016
RECORD is the keyword to specify a record number (1). It should be always accompanied with one
record number.
SOURCE is the keyword to specify location of the source for this particular record number. It should be
accompanied with, at least, one number that represents the surface distance (-12.0) in meters or
feet. (The distance unit specificationfor example, meters or feetis made by a separate line as
described below). It can also be accompanied with a second number (994) that represents the
station number corresponding to the source location (-12.0). Note that station numbers are always
consecutive between the two adjacent receiver locations. Although one receiver spacing can be a
number of any value (e.g., 2.0), the corresponding station interval is always one unit (1).
CH is the keyword to specify a channel number and corresponding location. CH1 represents channel #1,
while CH24 represent channel #24. There is no space between the 'CH' and the channel number.
This channel-number keyword is accompanied with, at least, one number that represents the
surface distance (e.g., 0.0), which can optionally be followed by a second number that represents
the corresponding station number (e.g., 1000). There should be, at least, two fields of channel
specification separated by comma (,). The specifications for the in-between channels will then be
linearly interpolated based on these two bounding specifications. The channel specifications in the
above example indicate that each channel's surface location increases by 2.0 m in distance (i.e., a
2.0-m receiver spacing), while it increases by 1 in station number toward increasing channel
numbers.
UNIT is the keyword to specify distance in either meters (METER or meter) or feet (FEET or feet). This
specification is optional and, if this line is missing, the default unit is the same as the unit specified in
the input seismic data. If this information is missing in the seismic data, then the default unit is FEET.
SURVEY is the keyword to specify the type of MASW survey. Three survey types are available; active
(ACT or ACTIVE), passive (PAS or PASSIVE), and active-passive combined (COM or COMBINED). If this
keyword is missing, the default survey type is ACTIVE. Both active and combined surveys require the
'SOURCE' specification included in each SR line after the 'RECORD' specification as illustrated in the
above example, while the passive survey should not include the 'SOURCE' specification.
Any line that starts with two slashes ('//') indicates a comment line, and is ignored during the import.
The source/receiver (SR) configuration constructed by the above example file is graphically displayed
below with a surface coordinate of distance (left) and station number (right), respectively.
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Example 2
(Specification with Distance Only)
Example 2 is another sample text file that has multiple lines of SR specification with two bounding
record numbers (1 and 24). The SR configurations for those records between these two numbers are
linearly interpolated in surface coordinates for both source and receivers. In addition, only distances are
specified for both source and receivers without station numbers. In this case, the program will assign
station numbers automatically with a convention of '1000' for zero ('0') distance. The resultant SR
configuration for all 24 records in an input seismic data is displayed below with distance (left) and
station (right) surface coordinates used, respectively.

Example 3
(Specification for Passive Survey)
Example 3 is identical to Example 2, but without 'SOURCE' specifications because the survey type is
specified as 'PASSIVE' in the last line. The resultant SR configuration is displayed below with distance
(left) and station (right) surface coordinates used, respectively. It shows locations of the receivers only.
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5. Seismic Modeling Specification from Existing Seismic Data

Click the following button and select a seismic data file with source/receiver (SR) setup [*(SR).DAT].
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6. Conversion of S-Velocity (Vs) to P-Velocity (Vp) Cross Section
Open an existing 2-D velocity (Vs) cross section [*(2DVs).TXT].

Select "Edit" tab and click "+/-" button to display the control dialog shown below. Select "Velocity" and
"Divide (%)" for the variable and operation options, respectively. Then, enter "-3.14159265" in the "Edit
Value" box, which will let the program use its own Poisson's ratio (POS) values [that dynamically vary
with S-velocity (Vs) values]. To use a specific and constant POS value, enter a value of 100xPOS added
by 0.14159265; for example, enter a value of "450.14159265" for POS=0.450, and "330.14159265" for
POS=0.330, etc.

An output P-velocity (Vs) cross section with updated labeling.
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7. Extraction of Dispersion Curve  Dynamic Bounds
Open an existing dispersion-image file [*(*OT).DAT].

Click "Bounds" on top and then "Controls" to display the control dialog below. Select "Algorithm" to
check (or uncheck) the 'Exclude low signal-to-noise (SN) ratio' option that will exclude (if checked) data
points with SN lower than the value specified in the box below. Select "Bounds" tab to check (or
uncheck) the 'Adjust bounds dynamically' option that will follow (if checked) the trajectory of the
previously picked dispersion curve. The 'Bounds degree of phase velocity' option specifies the range
between upper and lower bounds.

8. Bedrock Contour Specification
Uncheck the 'Clear previous contour-velocity curve' option to draw multiple (bedrock) velocity lines.
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9. Chart Scale Specification on Dispersion
Open an existing dispersion-image file [*(*OT).DAT].

With display of a dispersion-image file [*(*OT).DAT], select "Scale" tab and then click anywhere in the
panel of previous "Vertical" and "Horizontal" scales.

10. Common-Offset Section Generation from Display
Open an existing seismic-data file with source/receiver (SR) setup applied [*(SR).DAT].

With display of a seismic-data file with source/receiver (SR) setup applied [*(SR).DAT], select "Edit" tab
and then click the "Generate common-offset sections" button.
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11. Table of Updates
Type Code
DA: Dispersion Analysis, DD: Dispersion Display, SD: Seismic Display, GE: General, IA: Inversion
Analysis, SR: Source/Receiver (SR) Setup, Vs1D: 1-D Vs Display, UT: Utility
Type

Content

Applied
()

SD

In the source/receiver (SR) configuration chart display, the 1st channel is now
indicated by a yellow dot, while all other channels are presented by black dots.



SR

The mid-point of a receiver array is now determined by examining surface
coordinates of all receivers (traces). Previously, it was determined from the first and
last traces in the file, which resulted in incorrect mid-point location if channels are
not regularly arranged.



UT

The maximum number of samples (per channel) in a SEG-2 file that ParkSEIS (PS) can
handle during the conversion process is now 120,000. Previously, it was 90,000.
However, the conversion process will decimate it to 32,000, which is the maximum
number of samples per trace allowed in the converted PS format.



DD

In the display of a dispersion-image file [*(*OT).DAT], adjacent images can be
stacked on top of the current image being displayed by choosing the "OT-Stk" option
in the "Process" tab. This option now has an additional option of "Weighted
stacking" that will apply a Gaussian weight (centered at current image) to the
adjacent images. Previously, it always applied the same weight to all images.
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12. Table of Bug Fixes
Type Code
DA: Dispersion Analysis, DD: Dispersion Display, SD: Seismic Display, GE: General, IA: Inversion
Analysis, SR: Source/Receiver (SR) Setup, Vs1D: 1-D Vs Display, Vs2D: 2-D Vs Display, UT: Utility
Type

Content

Fixed ()

DD
Vs1D
Vs2D

Changing chart scale by clicking an axis often caused troubles in various ways (e.g.,
program hanging, loss of focus, delayed response, etc.). This happened with charts
in dispersion-data [*.DC and *(*OT).DAT] and (1-D and 2-D) velocity (Vs) [*.LYR and
*(2DVs).TXT] displays. This problem has been fixed. The auto-scale check box has
been disabled in the control box. A few other related issues (for example,
displayed file name not accordingly updated after saving current display with a
different name, mouse cursor not properly updated, conflict of axis scales causing
the program to crash, etc.) have been fixed as well.



Vs1D

Some issues with 1-D velocity (Vs) display (*.LYR)  for example, continuous
display of error message "Invalid S-Velocity (Vs) for minimum Poisson's ratio
(=0.0)" and improperly displayed parameters such as Poisson's ratio, density, Qs,
and Qp have been fixed.



UT

Certain SEG-2 data, which is not the original SEG-2 field file but is converted from
a third-party software, has a keyword missing, and this caused a misleading error
message "Negative Sampling Interval (0)!" Now, a correct message will specifically
notify of this missing required keyword. This will enable the user to look for the
original SEG-2 data to begin with.



SD

Processing modules in seismic display (e.g., Filter, F-K, AGC, Mute, etc.) often
caused the program to hang. In addition, the first record in the output file saved
was not the one specified in the control box. These issues have been fixed.



DA

During the generation of dispersion-image files [*(*OT).DAT], the output file would
not be overwritten (even if accordingly specified in the control dialog) but always
appended to the previous file. This has been fixed.



DA

During extraction of dispersion curves from a dispersion-image file, the output file
name for dispersion curve(s) to be saved could not be properly specified, even if
the user wanted to assign a name different than the default. This has been fixed.



SR
SD

Display of source/receiver (SR) chart from a seismic data display (or during the SR
setup session) caused the program to hang if there was only one record in the
input file. This has been fixed.



DD

During the analysis of "F-Sum" included in the "Process" tab of dispersion-image
displays [*.(*OT).DAT], sometimes an error message was issued notifying
"Error! !DCDATA in OTFRQSUMPara::Execute()!" This has been fixed.



Vs2D

When constructing a depth-slice map [*(DS).TXT] from the display of multiple 2-D
velocity (Vs) cross sections [*(2DVs).TXT], the "Access violation..." error message
appeared and the program crashed. This occurred when the cross sections have
different ranges in surface coordinates. This has been fixed.
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About This Version 3.0 - September, 2017

1. Summary
Updates, additions, and modifications incorporated into the current version (3.0) are explained here.
The most significant upgrade incorporated in this version is the addition of the "AUTO" module that fully
automates the complete sequence of dispersion and inversion operations. Minor updates have been
made in modules of the dispersion image generation [*(*OT).dat] and the 1D velocity (Vs) display
[*.LYR], respectively. All bugs we found were minor and have been fixed. Upgrade and maintenance
items are briefly explained below.
AUTO  Automatic Generation of Velocity (Vs) Profiles (1D and 2D) and Dispersion Curve(s)
(Main Menu -> "AUTO")
The generation of the velocity (Vs) profile (1D and 2D) can now be accomplished by one click after
preparation of seismic data with proper acquisition geometry encoded [*(SR).dat]. This module
implements the task of dispersion image preparation and subsequent fundamental-mode (M0)
dispersion-curve extraction through a fully automated process. The algorithm is designed according to
the fundamental-mode (M0) pattern-recognition technique that is facilitated by various types of signalenhancing tactics theoretically and empirically developed during the last three decades of research and
development. The following inversion process is also automatically optimized based on the results from
the automatic dispersion analysis.
Automatic extraction of dispersion curve(s) can also be executed during the conventional mode of
dispersion curve extraction with full manual controls still available.
Performance of this AUTO module has proven highly effective and reliable even in comparison to
conventional (manual) processes performed by an experienced operator. In this sense, a novice in
MASW analysis can use this module as a tutorial guide during the learning process of the conventional
analysis skills. On the other hand, the results from the AUTO process should always be taken with
caution because the process may not be perfect in every aspect, especially when the acquired data
carries extraordinary complications. It is therefore always recommended even for experienced users in
MASW analysis to run both manual and AUTO approaches to crosscheck the results. More details
about the background methodology and how to use this module are explained in section 1. In addition,
a separate user guide ("AUTO") is available from the 'Help' in the main menu as well as in the AUTO
control dialog.
Dispersion Image Generation [*(*OT).dat]  New Options Added
(Main Menu -> "Dispersion" -> "Make Dispersion Image From...")
Two more options are added in the control dialog; filtering background noise ("Noise Filter") and
tapering at lower and upper frequency ends of dispersion image ("OT Tapering"). These options can be
used to improve overall signal-to-noise (SN) ratio of the most dominant energy pattern, for example, M0
energy pattern ("Noise Filter") and also to attenuate computational artifacts in those spectral ranges
where surface waves have insignificant energy ("OT Tapering").
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Seismic Site Characterization (NEHRP vs. Eurocode)
[Main Menu -> "Display" -> "S-Velocity (Vs) Data" -> "1-D Vs Profile (*.LYR)"]
When a site is characterized based on the shear wave velocities (Vs's) in the top 30 m (100 ft), now one
of the two standards can be used; one recommended by the National Earthquake Hazard Reduction
Program (NEHRP) in USA (www.nehrp.gov) and another adopted among European countries (Eurocode).
This option is included in the display module of 1D velocity (Vs) profile (*.LYR). Description tables for
both standards (NEHRP and Eurocode) are available within the display module. They are also available
by going to "Main Menu" -> "Info" -> "Seismic Site Characterization Table."
Errors Fixed and Minor Updates Made
Updates are listed with brief explanations in Table 1. Bug fixes are listed in Table 2. There are other
minor updates, upgrades, and bug fixes incorporated in this version that will be self explanatory during
software use.
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2. AUTO
2.1 Overview
Extraction of the fundamental-mode (M0) dispersion curve is a critical step during MASW analysis, the
accuracy of which has a direct impact on the final velocity (Vs) profile. Up until now, it has been the only
step in ParkSEIS (as with all other MASW analysis tools) that required the user's intervention to identify
the corresponding energy pattern for the M0 trend. This step can be fairly straightforward if the trend is
the only dominant energy pattern present in the dispersion image [also known as "overtone (OT)"
image]. Or, as is more commonly the case, it can be a challenging task if the overtone record includes
other trends created from multiple causes such as higher modes, ambient noise, energy segments
arising from lateral variation of subsurface conditions, computational artifacts due to Gibb's
phenomenon and boundary effects, body wave effects, etc.
As of this version of ParkSEIS, detection of the fundamental-mode (M0) dispersion trend is now handled
through a fully automated process that works on various (theoretical and empirical) aspects of
dispersion image data. The process is similar to a pattern recognition technique that is grounded in the
theory of wavefield transformation that generates the overtone record. The actual technical
implementation is linked to a significant number of empirical parameters that are properly calibrated for
the condition of the original seismic field record as well as the corresponding overtone record. This
empirical calibration has been made using several hundred field data sets acquired at sites of diverse
subsurface conditions.
The detection of M0 trend is made through a comprehensive evaluation of the overtone record, which
evaluates the following five (5) attributes of the record:






Pattern: Recognition of the most dominant surface wave event is assessed in its spectral and
phase velocity attributes. Then, the overall strength and continuity of the pattern is
estimated from the surface wave dispersion perspectives.
Coherency: Most major energy trends are identified and their relative coherencies are
estimated.
Definition: Major energy segments are selected and then evaluated for their strengths in
comparison to those of the body wave segments.
Amplitude: Major energy segments are selected and then evaluated for their energy levels
with respect to the background noise level.
Energy: An absolute amount of surface wave energy is estimated.

The detection process accounts for all of these attributes (with varying degrees of contribution). The
key parameter, however, is the "Pattern" which is calculated first and then upon which other relative
contributions are determined. The detected M0 trend is used to set a specific area (called the "Bound
OT") in the original overtone image to which the subsequent process of the curve extraction should
focus. This is similar to setting the (lower and upper) bounds along the visually identified M0 trend,
which is the mode of operation during a manual process. A flowchart of the overall process is presented
in Figure 1.
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Figure 1. A general flowchart of the automatic detection algorithm (right) in reference to the
flowchart of ParkSEIS (left).
To briefly explain each step in the flowchart:
(a) A seismic data set with field-geometry encoded [*(SR)*.dat] is used as an input to the 2D
wavefield transformation. A dispersion image (overtone) data set [*(Auto-OT).dat] is produced
from this process.
(b) Each overtone record is then evaluated by a pattern recognition method for the amount of
signal wavefields (i.e., M0 surface waves) with respect to all other wavefields (i.e., for SN ratio).
Then, a new set of overtone data [*(Bound-OT).dat] is prepared by applying proper signalenhancing techniques to the original overtone records [*(Auto-OT).dat].
(c) A special type of dispersion curve [*(BoundDC).dc] is extracted from each record in this new
data set. This curve contains information about detected M0 trend in the original overtone
record [*(Auto-OT).dat].
(d) An M0 curve is extracted from each of the original overtone records [*(Auto-OT).dat] by using
the special dispersion curve from (c) as a bound curve. All extracted curves are then saved
and/or passed to the next inversion process to generate a (1D or 2D) velocity (Vs) profile.
To start the automatic process, select "AUTO" item from the main menu (yellow arrow), or select
"AUTO" tab from the tool panel (green arrow) as illustrated below.
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2.2 AUTO for 2D Velocity (Vs) Cross Section
This section describes the automatic process used to generate a 2D velocity (Vs) cross section at the end
[*(2DVs).txt]. It can start from (2.1) original seismic field data in SEG-2 format that may or may not have
the source/receiver (SR) setup encoded, (2.2) a seismic field data set previously prepared that has SR
setup encoded [*(SR)*.dat], or (2.3) an overtone record data set previously prepared [*(Auto-OT).dat].
If the original SEG-2 seismic data set does not have a proper SR setup encoded, then you have to go
through the source/receiver (SR) setup process first before the automatic process takes place.

2.2.1 From Field Seismic Files in SEG-2 Format
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select multiple seismic field files (records) in SEG-2 format (e.g., *.dat, *.sg2, etc.).

If the files contain field geometry information [i.e., source/receiver (SR) setup] in the file header, then
the program will detect it and ask you for review. Otherwise, the program will direct you to the SR
setup process before the automatic process takes place.
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When clicked "Yes" to view the original SR setup, a chart will be displayed as shown below:

Review the configuration on the chart to see if it is the correct SR setup. Then, close it to have the
following dialog displayed:

If the original SR setup is correct, then you can save the SEG-2 files as one file [*(SR).dat] and skip the
subsequent SR setup process. Otherwise, select "Run source/receiver (SR) setup" to start the SR setup
process before the automatic process takes place as shown below [refer to "Setup Source/Receiver (SR)"
user guide for instructions]:
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Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):

At the end of the process, the velocity (Vs) cross section will be displayed as shown below:
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2.2.2 From Seismic Data with Source/Receiver (SR) Setup
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select a seismic data file, previously prepared, that has source/receiver (SR) setup encoded [*(SR)*.dat].

Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):
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At the end of the process, the velocity (Vs) cross section will be displayed as shown below:

2.2.3 From Dispersion Image File
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select an overtone image data file [*(Auto-OT).dat] previously prepared that has multiple number of
overtone records.
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Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):

At the end of the process, the velocity (Vs) cross section will be displayed as shown below:
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2.3 AUTO for 1D Velocity (Vs) Profile
This section describes the automatic process used to generate a 1D velocity (Vs) profile at the end
[*(1DVs).LYR]. It can start from (3.1) original seismic field data in SEG-2 format that may or may not
have the source/receiver (SR) setup encoded, (3.2) a seismic field data set previously prepared that has
SR setup encoded [*(SR)*.dat], or (3.3) an overtone record data set previously prepared [*(AutoOT).dat]. If the original SEG-2 seismic data set does not have a proper SR setup encoded, then you have
to go through the source/receiver (SR) setup process first before the automatic process takes place.

2.3.1 From Field Seismic Files in SEG-2 Format
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select one or multiple seismic field files (records) in SEG-2 format (e.g., *.dat, *.sg2, etc.).

If the files contain field geometry information [i.e., source/receiver (SR) setup] in the file header, then
the program will detect it and ask you for review. Otherwise, the program will direct you to the SR
setup process before the automatic process takes place.
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When clicked "Yes" to view the original SR setup, a chart will be displayed as shown below:

Review the configuration on the chart to see if it is the correct SR setup. Then, close it to have the
following dialog displayed:

If the original SR setup is correct, then you can save the SEG-2 files as one file [*(SR).dat] and skip the
subsequent SR setup process. Otherwise, select "Run source/receiver (SR) setup" to start the SR setup
process before the automatic process takes place as shown below [refer to "Setup Source/Receiver (SR)"
user guide for instructions]:
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Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):

At the end of the process, a 1D velocity (Vs) profile [*(1DVs).LYR} will be displayed as shown below:
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2.3.2 From Seismic Data with Source/Receiver (SR) Setup
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select a seismic data file previously prepared that has source/receiver (SR) setup encoded [*(SR)*.dat].

Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):
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At the end of the process, a 1D velocity (Vs) profile [*(1DVs).LYR] will be displayed as shown below:

2.3.3 From Dispersion Image File
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select an overtone image data file previously prepared [*(Auto-OT).dat].
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Click "Run AUTO" to start the AUTO process (left). Both (dispersion and inversion) analyses will proceed
automatically with the processing status updated in the message panel as shown below (right):

At the end of the process, a 1D velocity (Vs) profile [*(1DVs).LYR] will be displayed as shown below:
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2.4. AUTO for Dispersion Curve Extraction
This section describes the automatic process used to generate dispersion curve(s) (*.DC) from an
overtone data file [*(Auto-OT).dat]. Extracted dispersion curve(s) can be used for the inversion process
to produce a velocity (Vs) profile (1D or 2D). This automatic process can take place in two different
modes; (4.1) a batch mode that generates and saves all dispersion curve(s) without any user
intervention, and (4.2) a pseudo-automatic mode that generates a dispersion curve for each overtone
record being displayed in the chart. The second mode is available during the manual process to extract
dispersion curve(s) from an overtone image file (the 2nd step of manual dispersion analysis).

2.4.1 Batch Process
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select an overtone image data file previously prepared [*(Auto-OT).dat].

The program will detect the number of overtone records present in the input file and also the field
geometry (SR setup) used during the acquisition of the original field files. Then, it will ask the user about
the purpose of the process; i.e., 1D or 2D velocity (Vs) profiling. For 2D profiling, one dispersion curve
will be extracted and saved from each of the overtone records included in the input file. On the other
hand, for 1D profiling, only one dispersion curve will be extracted and saved by stacking all the overtone
records included in the input file before the extraction takes place. The default is the most probable
option the program detected.
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Click "Run AUTO" to start the AUTO process (left). It will proceed automatically with the processing
status updated in the message panel as shown below (right):

At the end of the process, the file name of the saved dispersion curve(s) will be displayed as shown
below:
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2.4.2 AUTO Process on Dispersion Image Chart
This section describes an AUTO process that can take place during the previous (manual) mode of
dispersion-curve extraction (i.e., the 2nd step of dispersion analysis). Input to this process is an
overtone image file [*(*OT).dat]. From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select an overtone image file [*(*OT).dat]:

In the top tool panel of the displayed chart, click "AUTO" button:
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A control dialog will be displayed as shown below. Refer to "Section 6" for options available in this
dialog. Click "OK" to proceed with all default parameters.

If the input file was generated from a previous AUTO run, then the program will detect it and try to use
previous scanning results to facilitate the automatic curve extraction process. Click "Yes" to use them.

Otherwise, the program would want to proceed and run the "global" evaluation first before the
automatic process takes place as shown below. It is always recommended to choose "Yes" (i.e., run the
global evaluation) to enhance the effectiveness of the automatic process. If this global evaluation is not
pre-performed, then the optimization of parameters for the automatic process will be based only on the
local overtone record being processed. This can limit the effectiveness of the automatic process.
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An automatically extracted dispersion curve will be displayed on top of the identified trend of the
fundamental-mode dispersion as shown below. Examine the curve and then click "Save" button. The
process will move to the next overtone record. Continue to click "Save" button after examination of
each extracted curve until all overtone images are processed.

The normal curve-edit process (e.g., delete/add/move data points by using the mouse) can be applied to
the extracted curve at any time before clicking the "Save" button as shown below:
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2.5 Scanning Seismic Data for SN Evaluation
This section describes an automatic process used to evaluate the signal-to-noise (SN) ratio of each
record in a seismic data file [*(SR)*.dat]. Definition of SN ratio is based on the five attributes of an
overtone record (processed from each seismic record) outlined in "Section 1. Overview"; Pattern,
Coherency, Definition, Amplitude, and Energy. The evaluation results can be used to infer the overall
"quality" of original seismic field records. In consequence, they can also be used to evaluate the relative
confidence level of the final velocity (Vs) cross section by considering the record range that was
responsible for specific lateral area in the cross section.
From the main menu, select items as shown below:

Or, from the tool panel, select the button as shown below:

Select a seismic data file previously prepared that has source/receiver (SR) setup encoded [*(SR)*.dat].

If the file was previously processed in AUTO mode, then the program will detect it and try to utilize the
previous results.
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Otherwise, the program will run the scanning again without referring to the previous results as shown
below:

The final scanning results will be displayed in a chart as shown below:

The scanning results shown above indicate that the velocity (Vs) results in 2D cross section
corresponding to record numbers approximately in 80-130 are more reliable in comparison to other
areas. The relationship between record number of seismic data and lateral distances in the cross
section can be found by displaying the table of SR setup from a seismic data display (a button in "View"
tab). Range of SN values and corresponding quality descriptions are presented in the table below:

SN (%)
80-100
60-80
40-60
20-40
0-20

Table 1: Description of SN vs. corresponding attributes.
Category
Quality Description
Excellent
Best quality for AUTO process. Highly reliable results are expected
Good
Good candidate for AUTO process. Reliable results are expected
Fair
Marginal quality for AUTO process. Results should be used with caution.
Poor
Lowest quality for AUTO process. Results should be used with caution.
Bad (Unusable)
Data should not be used for AUTO process.
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2.6 "Options..." in AUTO
Options available during an AUTO process are explained here. By nature of an automated process, it is
not expected that users will have to visit them often for any better optimization than the default
settings the program already provides. However, only those options that can influence the
effectiveness of the overall process are briefly explained in this section to help understand what might
have caused some features observed in the final result of velocity (Vs) profile.
In the main page of the AUTO dialog, there are two main options of "Dispersion" and "Inversion"
analyses as shown below. Both of them are always checked to generate the final velocity (Vs) profile
unless the purpose is to generate only dispersion curves automatically (as explained in Section 4). To
access all other options available, click the "Options..." button as shown below.

Auto Process Tab
Those options that can directly influence on the final velocity (Vs) profiles are included in this tab.
The "Save graphic (*.jpg) of extracted dispersion curve and image" will save, if checked, the image (in
JPG) of extracted dispersion curve superposed on the corresponding dispersion image during the
automatic process of the curve extraction.
Spatial Resolution
This option, shown below, can influence on the (horizontal and vertical) resolution of the final 2D cross
section. In theory, the highest resolution is most desirable. However, there are always adverse
influences from the noise wavefields (i.e., everything rather than the fundamental-mode dispersion
energy trend). Efforts to increase the detection ability of M0 trend in an overtone record will inevitably
decrease the resolution at certain parts of dispersion image. Therefore, in practice, the automatic
process is a tradeoff between a theoretical resolution and a practical effectiveness. Default values (75%)
for both horizontal and vertical resolutions are the most optimum values empirically calibrated. The
lower values will decrease the overall spatial resolution, but make the detection process more effective
by suppressing adverse influences from the noise wavefields. On the other hand, the higher values may
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increase the resolution if noise wavefields are insignificant. Therefore, for a seismic data set with
complications (e.g., strong ambient noise and higher modes, severe lateral variation of subsurface
conditions, poorly developed surface waves, etc.), the lower values (e.g., 50%) for both "Horizontal" and
"Vertical" resolutions will make the automatic process more reliable. If the data set is in good quality,
then the higher values (e.g., 100%) can generate a cross section with the highest spatial resolution the
automatic process can ever achieve. The data quality can be assessed by the "Scanning" option
described in Section 5. If the overall scanning result is "Good-Excellent" (≥ 60%), then the resolution
values can be increased above the default values (e.g., 100%). If the result is "Poor-Bad" (≤ 40%), then it
is recommended to lower the values (e.g., 50%).
Dispersion and Inversion
Options to change parameters for dispersion ("Dispersion Curve") and inversion ("Inversion") analyses
are shown below. They are the same options available when performing each analysis in a manual
mode.

Auto OT Tab
Parameters that can influence some features of the overtone records [*(Auto-OT).dat] are available on
this tab. For example, in the "Frequency range (Hz)" box, you can change the start ("MIN") and ending
("MAX") frequencies, as well as the interval ["Interval (after resampling)"], of the overtone record. All
options available in this tab are directly related to the suppression of computational artifacts inevitably
generated from a 2D wavefield transformation.
Wavelength and Smoothing
The shortest ("MIN") and the longest ("MAX) wavelengths in the overtone record are specified. Energy
outside this bound will be muted (i.e., zeroed). Smoothing of an overtone image is applied by the
parameters specified in the "OT Smoothing (# of samples)" box as shown below. A higher number will
apply a wilder smoothing along the corresponding axis (i.e., "Frequency axis" or "Phase velocity axis").
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Tapering and Filtering
Tapering at the beginning and ending parts of the frequency axis of an overtone record is specified in
the "Tapering" box; 0=no tapering, 1=weak tapering, 2=mild tapering, and 3=strong tapering will be
applied. The exact amount of tapering for each option (0-3) is determined with reference to the spectral
characteristics of the original seismic record. The "Noise filter" specifies the extent (%) of filtering
background noise wavefields in an overtone record.

Auto Bounds Tab
Parameters that can influence some features of the special overtone data set [*(Bound-OT).dat] can be
changed from this tab. This overtone data set is generated by recognizing patterns in the original
overtone record data set [*(Auto-OT).dat]. It is used to generate a special type of dispersion curve
[*(BoundDC).DC] for each overtone record that is in turn used to set the (lower and upper) bounds for
the subsequent process to extract a dispersion curve from the original overtone record [*(Auto-OT).dat].
The "Method" tab shows different options that can be used to extract the bound dispersion curve
[*(BoundDC).DC]. Default option ["coherency (COH) of dispersion pattern detected"] is always
recommended. "Options" and "OT" tabs contain parameters that are important only from coding
perspectives. The "Detection" tab at the bottom of the page shows the mode of detection to be chosen
("Mode to detect"). The "Fundamental mode (M0)" will focus only to the fundamental mode during
the detection process, whereas the "Apparent mode (AM0)" will focus on the pattern created by the
strong energy trend without evaluation of the possible mode(s). All other options are important only
from the coding perspectives.
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SN Options Tab
Parameters related to a specific method of signal-to-noise (SN) ratio evaluation are gathered on this
page. All of them are important only from the coding perspectives.

SN Evaluation Tab
Parameters related to the SN ratio evaluation (by using a specific method) are gathered on this page. All
of them are important only from the coding perspectives.
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3. Dispersion Image Generation - New Options Added
The two options of "OT Tapering" and "Noise Filter" are added in the dispersion-image generation
module that can be reached from the main menu by going to "Dispersion." It can be started by
importing seismic file(s) in SEG-2 format or a file in PS format [*(SR).dat] as illustrated below. It is
assumed input data already has field geometry encoded.

When the control dialog is displayed, click "Options..." and then "Full List" as shown below.

The two options ("OT Tapering" and "Noise Filter") are found in the appropriate tabs as illustrated below.
OT Tapering applies tapering in the dispersion image on both edges of frequency axis. The frequency
ranges for tapering are determined from the spectral analysis of input seismic record. The degree of
tapering is set by a number in 0-3; 0 = no tapering (default), 1 = weak, 2 = mild, and 3 = strong.
Examples with "0" and "2" degrees, respectively, are displayed below.
Noise Filter applies a noise reduction process to attenuate the background energy so that the most
dominant energy trend can become more distinguished. A higher number will apply a wilder filtering of
background noise. Examples of "0" and "25%" are displayed below.
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Locations of "OT Tapering" (left) and "Noise Filter" (right) in the control dialog are illustrated below.

Dispersion images processed with no ("0") (left) and mild ("2") (right) tapering degrees are illustrated
below.

Dispersion images processed with "0%" (left) and "50%" (right) noise filter are illustrated below.
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4. Seismic Site Characterization (NEHRP vs. Eurocode)
Open a 1D velocity (Vs) profile by going to "Display" -> "S-Velocity (Vs) Data" -> "1-D Vs Profile (*.LYR)"
as shown below.

Click "Vs30m" button located at the bottom right corner as shown below.

Choose which standard you would like to use to characterize the site from the dialog as shown below;
default option for US (ft) unit is "NEHRP", while that for metric (m) unit is "Eurocode."
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However, any option can be used for the same profile as shown below; "Eurocode" on left and "NEHRP"
on right.

Description table for the corresponding standard is displayed by choosing "Yes" to the following dialog.

This table can also be displayed by clicking "Vs30m" button in the "View" tab as shown below; normal
click for "NEHRP" and right click for "Eurocode" table.

The tables can also be displayed from the main menu by going to "Info" -> "Seismic Site Characterization
Table" as shown below. The tables are displayed on next page.
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Seismic Site Characterization Tables
"NEHRP (USA)" (top) and "Eurocode" (bottom)
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5. Table 1 - Table of Updates
Type Code
DA: Dispersion Analysis, DD: Dispersion Display, SD: Seismic Display, GE: General, IA: Inversion
Analysis, SR: Source/Receiver (SR) Setup, Vs1D: 1-D Vs Display, UT: Utility
Type

Content

Applied
()

DD

When multiple number of dispersion images (OT's) are stacked to generate a stacked
image, the program offers an option to filter background noise by providing a dialog
where the degree of filtering (%) can be specified (0%=no filtering).



SR

When the source/receiver (SR) setup is run by the graphical Wizard, more warning
and notification messages can be issued at various stages of the execution to avoid
confusions and misconceptions. For example, when a negative value is entered for
the source offset (X1), a warning message will pop up to notify it is a distance (not a
coordinate) that should always be a positive number. Then, the program resets the
number to a positive equivalence of the entered value.
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6. Table 2 - Table of Bug Fixes
Type Code
DA: Dispersion Analysis, DD: Dispersion Display, SD: Seismic Display, GE: General, IA: Inversion
Analysis, SR: Source/Receiver (SR) Setup, Vs1D: 1-D Vs Display, Vs2D: 2-D Vs Display, UT: Utility
Type

Content

Fixed ()

DA

When generating a dispersion image file [*(*OT).dat] from a passive seismic data
set, resulting image data sometimes contains invalid header parameters; for
example, negative number of samples or a negative frequency interval in the file.
This was caused by improper specification of frequency parameters that are used
to generate the image file. This has been fixed so that the program notifies the
issue and automatically adjusts values to avoid the conflict.



DA

When generating a dispersion image file [*(*OT).dat] from a passive seismic data
set, the program sometimes hangs during the evaluation stage of input seismic
data without issuing any notification. This was caused by a glitch in the spectral
evaluation algorithm and has been fixed by replacing it with a more robust
algorithm.



DD

When dispersion curves [*.DC] are displayed, sometimes (depending on the
previous history of the file) the unit in the phase velocity axis is mistakenly labeled
as "m/sec" even if it should be "ft/sec." This has been fixed.



DD

When a dispersion image file [*(*OT).dat] is displayed, the original features of the
image would not be restored when the file has only one image record. This has
been fixed.



GE

When an input file (of any type) is imported from the file open dialog, the program
hangs when there are foreign characters included in the file path without any
message. This has been fixed and the program will notify this so that the user can
fix the source of the issue.



SR

When the source/receiver (SR) setup is run by importing a text file, the comment
line indicator ("//") appearing in the 1st line was not recognized by the program
causing either system crash or invalid output data. This has been fixed.



SR

Decimal points of receiver offsets were previously ignored during the
source/receiver (SR) setup run by importing parameters specified in a text file; for
example, "1.5" was taken as "1.0" previously. It has been fixed so that up to two
(2) decimal points are accounted for if the receiver spacing is smaller than 0.2.
Otherwise, at least one (1) decimal point is accounted for.



Vs2D

When a bedrock velocity contour is drawn in a velocity (Vs) cross section that has a
topographic correction applied, the drawn line does not account for the
topographic variation. This has been fixed.
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Preface
The multichannel analysis of surface waves (MASW) method provides one of the
most critically important geotechnical parameters—the stiffness of ground materials.
It gives this information in terms of seismic shear-wave velocity (Vs) distribution in
both vertical and horizontal directions. From an elastic theory viewpoint, shearwave velocity (Vs) is the most powerful indicator of a material's stiffness.
ParkSeis (PS) generates a shear-wave velocity (Vs) profile (1-D or 2-D) by analyzing
fundamental-mode (M0) Rayleigh-type seismic surface waves. Although there has
been a great deal of research and development in multi-mode utilization, software
that takes full advantage of multi-mode while efficiently handling all the associated complications has
not yet been developed. This is because of the modal characteristics of surface waves that are
ultimately determined by the velocity (Vs) structure, the unknown that we attempt to know through the
MASW analysis. Yet, the traditional approach of the fundamental-mode (M0) inversion provides an
excellent outcome under most common overburden/bedrock settings, and can provide a 1st-degree
approximation of other more complex settings. ParkSeis enables the user to utilize this most reliable
approach.
This software presents the most up-to-date algorithms in the analysis of MASW data that have evolved
over the last two decades of my own career as a researcher and practitioner in this particular field.
Although I personally believe both aspects of my career have helped to make this software robust yet
user friendly, I also know it would be an unrealistic expectation to hope it is completely free of bugs. To
that effect, I would greatly appreciate your user feedback, and look forward to incorporating
suggestions for further development.
January, 2015
Choon B. Park, Ph.D.
Author of ParkSeis (PS)
Park Seismic LLC
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Overview
This user's guide provides a general understanding of the objectives and procedures covered by the
ParkSeis (PS) program. If you are ready to start using the program, you can refer to "Getting Started"
included in the "Help" on the main menu.
ParkSeis (PS) processes Rayleigh-type seismic surface waves acquired from MASW ("multichannel
analysis of surface waves") surveys. PS will generate shear-wave velocity (Vs) profile (1-D or 2-D) by
analyzing the fundamental-mode (M0) dispersion curve of Rayleigh waves. The starting input data file
should consist of one or more of raw field data sets, called "records", recorded by using a multichannel
recording device; for example, a 24-channel engineering seismograph. Although the minimum number
of channels for the input data tested with PS was four (4), it is highly recommended that the recording
device have twelve (12) or more channels. The upper limit is virtually open within the scope of the data
format adopted for this program (the "PS" format), in which the headers are 2-byte integers that can
express a maximum integer up to about 32000.
The basic and minimum input data element for PS is one record that consists of a suite of individual
channel recordings called "traces." The field records should be saved in the SEG-2 format, which is an
engineering standard that most engineering seismographs adopt as the default output format. Other
text data files can be converted to the PS format by using a conversion module ("TXT2PS") included in
the "Utility" of the main menu. All SEG-2 records are internally converted to PS format as soon as they
are imported by the program, and all intermediate and final outputs of seismic data sets will be in this
PS format.
The overall procedure with the PS program to generate a Vs profile (1-D or 2-D) consists of the following
steps:
1.
2.
3.
4.
5.
6.

Field Data (SEG-2 Format)
Internal Format (PS Format)
Source/Receiver (SR) Setup
Dispersion Image Generation
Dispersion Curve (M0) Extraction
Inversion

The general flowchart of the procedure is displayed in Figure 1. Each of these steps is explained in the
following.
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Figure 1. Generalized flowchart of ParkSeis (PS) software

1. Field Data (SEG-2 Format)
Multichannel (e.g., 24-channel) seismic data sets (called "records") are acquired in SEG-2 format,
an engineering standard, by using a multichannel recording device (e.g., seismograph). Usually,
multiple number of records (e.g., 20) are collected during both 1-D and 2-D MASW surveys.
(Visit http://www.masw.comfor information about MASW field surveys) If the operator chooses
to do so at the beginning of the operation, the source/receiver (SR) configuration is usually
encoded by the acquisition software in the proper parts of recorded SEG-2 records. If this
choice is not made at the beginning of the operation, the acquisition software will encode
default settings into the saved SEG-2 records that likely will not reflect the correct configuration
for the particular survey being performed.

2. Internal Format (PS Format)
All SEG-2 records imported by PS are first internally converted to another format called "PS
format" that is a modification of the "KGS format (or modified SEG-Y format)." This conversion
is necessary to handle seismic data in a faster and more accurate manner for advanced and nonconventional wavefield operations commonly used in various stages of MASW data processing.
In PS format, each channel's data set (called a "trace") is saved as a combination of a header (of
120 elements of 2-byte integer each) followed by data samples (of 4-byte floating-point value
each). A complete list of the "PS Header" can be displayed by choosing the "PS Header" under
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the main menu's "Info." All output types of seismic data are saved in PS format with a "DAT"
extension (e.g., "Output.dat").

3. Source/Receiver (SR) Setup
Relative locations of seismic source and receivers are encoded into the header of each channel's
data set ("trace"). Those critical parameters—receiver spacing (dx), source offset (X1),
movement of source and/or receivers, distance within the survey line of source and receivers,
station numbers, etc.—are inserted into the proper headers. In reality, these parameters are
usually set at the beginning of the survey in the acquisition software. If that is the case, then PS
will inform it at the beginning of the SR setup so that the user can examine the encoded
information of the imported SEG-2 records in a displayed chart. If user confirms the displayed
setup is correct, then this SR setup is skipped. If user finds the original field data set does not
have proper information encoded, then this SR setup is crucial and cannot be skipped.
Output from this step will have the same extension as input seismic data (".DAT") with a post fix
of "(SR)" at the end of the file name; for example, "Output(SR).DAT." Description about this step
of analysis can be found in the PS User Guide "Source-Receiver (SR) Setup."

4. Dispersion Image Generation
Once SR setup is complete, the next step is to generate dispersion images; one dispersion image
per record. Because the input seismic data file [e.g., "Output(SR).DAT"] usually has multiple
(e.g., 20) records, the output dispersion image file will accordingly have many images. These
dispersion "images" are actually another instance of numerical data similar to seismic data, and
different from the ordinary graphical images (for example, BMP or JPG files). In fact, they have
the same numeric data format as used in the seismic data (i.e., PS format) and therefore can be
displayed using the seismic data display module (however, there is a dedicated module to
display dispersion images). In this sense, these image data are also called (dispersion-image)
records.
There are many parameters related to dispersion imaging processing, which is basically a
wavefield transformation operation that converts seismic wavefields in offset-time (x-t) domain
into those in phase velocity-frequency (Pv-f) domain. These parameters can influence the
quality and size of the image. In most cases, however, the program will set them to the most
optimal values through many internal automated analysis steps. Output will have the same
extension as input seismic data (".DAT") with a post fix of "(ActiveOT)" at the end of the file
name [or "(PassiveOT)" and "(COMOT)" for passive and combined survey cases, respectively];
for example, "Output(SR)(ActiveOT).DAT." More information about this step of analysis is
provided in the PS User Guide "Dispersion Image Generation."

5. Dispersion Curve (M0) Extraction
For 1-D Vs Profiling
This step extracts and saves the fundamental-mode (M0) dispersion curve from each dispersion
image generated from previous step. Although there may be multiple dispersion images
5
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generated, usually they all originated from the receiver array that stayed at the same surface
location. Therefore, it will have little meaning to extract separate M0 curves from each of these
images. Even if all separate M0 curves are extracted, it will be very unlikely they will all look
identical because each image has slightly different dispersion characteristics dominating over
different frequency and phase velocity ranges. This is because they all had different source
locations and are therefore influenced to a different extent by near-field effects and lateral
subsurface variation. Instead, these images should be stacked (i.e., averaged) to produce one
image that has the most accurate dispersion characteristics over the broadest frequency and
phase velocity ranges through the constructive interference of coherent dispersion trends, while
suppressing inconsistent random noise energy patterns.
Generated dispersion image data [*(ActiveOT).DAT] will be displayed by a dedicated module.
Then, the program will ask if you want to stack the images to produce one final image to be
used for the extraction of an M0 curve. If 'stacking' is not chosen, then the remaining procedure
will be identical to generating a 2-D velocity (Vs) cross section after extraction of all M0 curves.
In this case, the record number (instead of surface distance) will be used as the horizontal
coordinate for the 2-D cross section. However, it is highly recommended that you choose the
stacking option until you become fairly well experienced in recognizing complicated dispersion
patterns. At that point, you will be able to decide if any of the individual images possess the
dispersion pattern superior to that of the stacked image, as is sometimes the case.
Once the stacked image is displayed, then first it will be necessary to visually examine the image
and make an interpretation for the M0 trend. This interpretation usually will be simple and easy
when there is only one obvious trend of coherent energy, which is often the case in most
overburden/bedrock settings (except for "too" shallow bedrock). Once this identification has
been made, then you can define the approximate M0 trend by clicking multiple points (e.g., 5-10)
along the identified image trend. The program will then draw both lower and upper bound
curves within which it will try to extract the most probable M0 curve by examining energy levels
at each frequency. You can freely change these curves to refine the zone of examination.
The extracted dispersion curve will be saved as a text file of its own format with an extension of
".DC" with a post fix of the record number within parentheses [e.g.,
"Output(SR)(ActiveOT)(1).DC"]. There will be only one dispersion curve file (*.DC) saved at the
end of this step. More information about this part of the analysis can be found in the PS User
Guide "Dispersion Curve Extraction (1-D Profile)."

For 2-D Vs Cross Section
This step extracts and saves one fundamental-mode (M0) dispersion curve from each dispersion
image generated from the previous step of "Dispersion Image Generation." First, generated
dispersion image data [*(ActiveOT).DAT] will be displayed by a dedicated module. Then, it will
be necessary to visually examine the image and make an interpretation for the M0 trend. This
interpretation usually will be simple and easy when there is only one obvious trend of coherent
energy, which is often the case in most overburden/bedrock settings (except for "too" shallow
bedrock). Once this identification has been made, then you can define the approximate M0
trend by clicking multiple points (e.g., 5-10) along the identified image trend. The program will
then draw both lower and upper bound curves within which it will try to extract the most
6
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probable M0 curve by examining energy levels at each frequency. You can freely change these
curves to refine the zone of examination.
The extracted dispersion curve will be saved as a text file of its own format with an extension of
".DC" with a post fix of the record number within parentheses [e.g.,
"Output(SR)(ActiveOT)(1).DC"]. At the end of this step there will be as many files saved as there
are input dispersion images (e.g., 20). More information about this part of the analysis can be
found in the PS User Guide "Dispersion Curve Extraction (2-D Cross Section)."

6. Inversion
For 1-D Vs Profiling (Automatic 1st Phase)
This step will generate one 1-D (i.e., depth variation) shear-wave velocity (Vs) profile from the
input M0 dispersion curve previously saved [e.g., "Output(SR)(ActiveOT)(1).DC"].
There are many parameters that can influence the reliability of inversion output. Among them
is the most important, the maximum depth (Zmax) of output, which is the depth to the half
space (i.e., depth to the top of the last layer of infinite thickness, the half space). Zmax is
determined by the program based on the minimum (Xmin) and maximum (Xmax) distances of
the receiver from the source that were used during data acquisition. However, you can always
modify it, as needed, according to your own experience and knowledge. Other inversion
parameters, such as number of layers and searching-algorithm related parameters, are set to
default values by the program although they can always be manually changed by the user.
During the inversion process, the program will display both measured and modeled dispersion
(M0) curves to indicate how closely they match for the solution found by the program.
There will at least two (2) output files saved at the end of the inversion process, all in text files
but with different extensions; 1-D Vs profile file [*(1DVs).LYR] and its modeled dispersion (M0)
curve [*(Model).DC]. The processing history of all inversion parameters (for example, number
of layers, number of iterations, final match between measured and modeled dispersion curves,
etc.) is included in the Vs profile (*.LYR). The Vs profile will show depth variation of shear-wave
velocity (Vs) within the maximum investigation depth (Zmax), whereas the modeled dispersion
curve will show the theoretical M0 curve corresponding to the velocity (Vs) profile.
The Vs profile will be displayed automatically at the end of the inversion process. This will be
the velocity (Vs) model found automatically by the program without user's intervention, based
on its own searching algorithm, and is usually sufficient to dictate the reality. Then, this
completes the entire procedure to generate the 1-D Vs profile. More information about this
part of the analysis can be found in the PS User Guide "Inversion (1-D Profile)."

For 1-D Vs Profiling (Optional 2nd Phase)
However, it is often beneficial to attempt one or more rounds of the inversion process through a
manual searching process possibly followed by another automatic inversion process. This can
often lead to finding a profile whose theoretical (modeled) M0 curve matches the measured M0
curve even better (i.e., a higher match), or a profile that appears more realistic. This is
7
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especially true under two possibilities. First, due to the non-uniqueness of inversion, a property
inherent to all types of inversion processes, the Vs profile found automatically by the program
may appear very unrealistic (for example, a highly oscillating profile) although its M0 curve
matches very closely to the measured one. In this case, it is necessary to manually update the
profile until it looks more realistic while maintaining a comparable (or even improved) match
between the two M0 curves. Second, due to the possible error at one or more data points in
the measured M0 curve (that in turn may be a result of noisy data or analysis error), the
inversion process can sometimes generate an unrealistic Vs profile in response to the searching
algorithm trying to find a solution that satisfies all data points in the input M0 curve as much as
possible. Again, in this case, it will be necessary to manually update the profile, possibly
followed by another automatic inversion after the update. Whenever either or both of these
two possibilities are suspected, another round of inversion will be necessary that should start
with the manual update of the profile by using the computer mouse. The risk of the nonuniqueness issue in inversion will be significantly reduced if the manual update is followed by
another execution of the automatic inversion that will use the updated profile as the initial
velocity model. Extending the degree of freedom in inversion variables by choosing the
'Variable Depth' option on the "Layer (Earth) Model" tab in the control dialog can significantly
improve the effectiveness of the new searching process. More information about this part of
the analysis can be found in the PS User Guide "Inversion (1-D Profile)."

For 2-D Vs Cross Section
This step will generate one 1-D (i.e., depth variation) shear-wave velocity (Vs) profile (*.LYR)
from one input M0 dispersion curve (*.DC), and then produce a 2-D (i.e., depth and surface) Vs
cross section by using multiple 1-D Vs profiles through a proper 2-D interpolation.
There are many parameters that can influence the reliability of this inversion output. Among
them is the most important the maximum depth (Zmax) of output, which is the depth to the half
space (i.e., depth to the top of the last layer of infinite thickness, the half space). Zmax is
determined by the program based on the minimum (Xmin) and maximum (Xmax) distances of
the receiver from the source that were used during data acquisition. However, you can always
modify it according to your own experience and knowledge. Other inversion parameters, such
as number of layers and searching-algorithm related parameters, are set to default values by the
program although they can always be manually changed by the user. During the inversion
process, the program will display both measured and modeled dispersion (M0) curves to
indicate how closely they match for the solution found by the program. The overall matching
variation from one file to another file of the input dispersion curves will also be displayed.
There will be at least three (3) output files saved at the end of an inversion process for 2-D Vs
cross section, all in text files (*.TXT); 2-D Vs cross section file [*(2DVs).TXT], 2-D Vs confidence
file [*(2DConf).TXT], and processing history file [*(HST).TXT]. The Vs cross section file will show
2-D distribution of shear-wave velocity (Vs) within the surveyed surface distance and maximum
investigation depth (Zmax) set during the inversion. The confidence file will show distribution of
relative reliability (%) of analyzed velocity (Vs) values within the cross section. This confidence
concept is directly linked to the sensitivity of modeled dispersion curve [*(Model).DC] to the
velocity (Vs) change at a particular part of the cross section by a certain amount (e.g., ±10 %).
Therefore, it purely reflects the relative level of reliability (0-100%) in the solution-seeking
process with the premise that the input (measured) M0 curve is error free. The history file will
8
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contain all parameters set at the beginning of the inversion process as well as some parameters
related to output Vs values, such as matching degree (%) of the two M0 curves. Some other
types of output can also be chosen at the beginning of the inversion process as secondary
outputs. They may include modeled dispersion curves [*(Model).DC] and 1-D Vs profile
[*(Model).LYR] for each input (measured) M0 curve. Variation of the match between the two
M0 curves [*(*Match).DC] can also be saved with the same file format as dispersion curves so
that it can be displayed by using the dispersion-curve display module. Variation of average 1-D
Vs confidence can also be saved as a file [*(AveConf).DC] so that it can be displayed by using the
same display module.
Both Vs cross section [*(2DVs).TXT] and confidence [*(2DConf).TXT] maps will be displayed at
the end of the inversion process. More information about this part of the analysis can be found
in the PS User Guide "Inversion (2-D Cross Section)."
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MASW

Quick Guide - Generating Velocity (Vs) Profile (1D and 2D)
1. Importing Seismic Field Data
Go to "Process" → "2D S-Velocity
(Vs) Cross Section From " [or "1D
S-Velocity (Vs) Profile From"] →
"Seismic Field Data in SEG-2."

2. Source/Receiver (SR) Setup
The program will ask if the original source/receiver (SR) setup is to be
displayed. Choose "Yes" to display the setup and inspect it carefully. Then,
select one of the two options: (1) "Run the source/ receiver (SR) setup
anyway" or (2) "Save input file(s) now (as one file) and skip the SR setup."
If the original setup is correct, choose the second (default) option.
Otherwise, choose the first option to run the setup (and refer to the user
guide "SR Setup").

3. Dispersion Image Generation
If the program offers an option to generate an intermediate output data
with roll-along format, then choose "Yes" for the 2D Vs cross section and
"No" for the 1D Vs profile. Click "Run Dispersion Image" to start the
process.

4. Dispersion Curve (M0) Extraction
1 and then click several (e.g., 5-10) points
Depress the "Bounds" button ○
along the major energy trend interpreted as the fundamental-mode (M0)
2 to generate the M0 curve and
dispersion pattern. Then, click "Extract"○
3 to save it. Data points during "Bounds" and "Extract" steps
click "Save" ○
can be edited by "click-and-drag" (move), "click one data point (or draw a
rectangle around multiple data points)" (delete), and "click a non-data
point" (add). For a 2D Vs cross section, you will have to repeat the
1 , ○
2 , and ○
3 ) for all dispersion images in the file.
extraction (○

5. Inversion to Generate Vs Profile (1-D and 2-D)
Click "Run" to start the inversion process. In the case of a 1D Vs profile,
the displayed profile [*(1DVs).LYR] may show a realistic velocity structure
with a high match (e.g., ≥ 80%) (displayed on top) between the measured
and modeled M0 curves. This completes the process. Otherwise, you
can perform another round of advanced inversion processing that starts
from the current profile as an initial model. In that case, you can manually
change the profile by using the mouse until it looks more realistic while
maintaining a comparable (or even
improved) match between the two curves.
This manual update can also be followed
by another automatic inversion that may
find another more optimal velocity profile
with an improved match. To do that,
select the "Inversion" tab and click "Run."
To save the updated profile, select the
"Files" tab and click "Save."
September 2016
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Getting Started with Sample Data
Generating 2D Shear-Wave Velocity (Vs) Cross Section
Go to "Process" → "2D S-Velocity (Vs) Cross Section From" → "Seismic Field Data with SR Coded" and
then select "...\ParkSEIS (PS)\Sample Data\Active\Vs2D\DippingBedrock.DAT." Follow procedures
described in "Processing DippingBedrock.DAT" (on page 5) of the user guide "Generating 2-D Cross
Section (Working with Sample Data)" (accessible through "Help" in main menu).

Generating 1D Shear-Wave Velocity (Vs) Profile
Go to "Process" → "1D S-Velocity (Vs) Cross Section From" → "Seismic Field Data with SR Coded" and
then select "...\ParkSEIS (PS)\Sample Data\Active\Vs1D\Vs1DMASW.DAT." Follow procedures described
in "Processing Vs1DMASW.DAT" (on page 7) of the user guide "Generating 1-D Profile (Working with
Sample Data)."

Processing Passive Data for Dispersion Image
Go to "Dispersion" → "Make Dispersion Image From S/R Coded Data" and then select "...\ParkSEIS
(PS)\Sample Data\Passive\PAS(Circle-RA).DAT." Follow procedures described in "Passive Survey" (on
page 9) and "Combining Active and Passive Dispersion Images" (on page 34) of the user guide "Sample
Data."

Back Scattering Analysis (BSA)
Go to "Process" → "Back Scattering Analysis (BSA)" and then select "...\ParkSEIS (PS)\Sample
Data\VOID\VOID(SR).DAT." Follow procedures described in "BSA-VOID(SR).DAT" (on page 17) of the
user guide "Back-Scattering Analysis (BSA)."

Modeling MASW Seismic Data
Go to "Modeling" → "Seismic Data from Layered-Earth Model" and then select "...\ParkSEIS (PS)\Sample
Data\VOID\VOID.LYR" or select any 1D velocity (Vs) file [*(1DVs).LYR] that may have been created.
Click "Run" to perform modeling with all default parameters. Refer to the user guide "Modeling Seismic
Data" for details about parameters.

Data Types Used in ParkSEIS (PS)
General Output Data
Seismic Data (Raw Field)
Seismic Data (PS Converted)
Seismic Data with Source/Receiver (SR) Setup
Dispersion Image
Dispersion Curve
2D Shear-Wave Velocity (VS) Cross Section
2D Shear-Wave Velocity (VS) Confidence
1D Shear-Wave Velocity (VS) Profile
Full List of Seismic Modeling Parameters
Spectra (Amplitude and Phase) Displays
General Text Files
Other Intermediate/Accessory Data
Azimuth Information of Passive Data
Source Distance Information of Passive Data
Color Scheme
Data Base for Chart Displays
General Variables

September 2016

File Extension
*.DAT, *.SG2, *.*
*.DAT
*(SR).DAT
*(ActiveOT).DAT, *(PassiveOT).DAT
*.DC
*(2DVs).TXT
*(2DConf).TXT
*(1DVs).LYR
*.RFL
*.SPC
*.TXT
*(PassiveOT)(AZOT).DAT
*(PassiveOT)(SDOT).DAT
*.CLR, *Color*.INI
*.DB_
*.VA_

ParkSEIS

ParkSEIS User Manual

CHAPTER 3

Main Menu

ParkSEIS

MASW

PS - Main Menu

Table of Contents
Page

1.

Overview

2

2.

Process

6

3.

S-Velocity (Vs)

8

4.

Dispersion

9

5.

Inversion

10

6.

Display

11

7.

Source/Receiver (SR) Setup

12

8.

Modeling

13

9.

Utility

14

10. Settings

16

11. Info

17

1

PS - Main Menu

1. Overview
The ultimate purpose of using ParkSEIS would be to generate either a 1-D (depth) or 2-D (depth and
surface) shear-wave velocity (Vs) profile from acquired seismic field records. The entire processing
procedure to accomplish that are listed below and illustrated as a flowchart in Figure 1.

1. Field Data (SEG-2 Format)
The original field data set has to be prepared, by first downloading field records from the
seismograph. The data set usually consists of a number of multichannel seismic records in
SEG-2 format, which is an engineering standard. [One "record" represents a file of seismic data
recorded from all channels (e.g., 24-channel). A sub data set from each channel is called a
"trace."]
2.

Internal Format (PS Format)
SEG-2 data sets are internally converted to the PS (ParkSEIS) format in order to accommodate
non-conventional aspects of the MASW data analysis. The output file (if saved from this step)
will have a "DAT" extension (e.g., "Output.DAT").

3. Source/Receiver (SR) Setup
This step will encode the field geometry (e.g., receiver spacing, source offset, etc.) and surface
coordinates (e.g., survey distance and station numbers) used during the survey into the header
of each trace. If a proper encoding has been previously applied by acquisition software during
the survey, then the program will provide an opportunity to visually examine the setup in a
chart at the beginning of this step. If the original setup is accepted, then the SR setup will be
skipped and the process will move to the next step in the process. The output file saved from
this step will have a postfix of "(SR)" [e.g., "Output(SR).DAT"]. Refer to PS User Guide "SourceReceiver (SR) Setup" for implementation of this step.

4. Dispersion Image Generation
Each input seismic record (now in PS format) will be transformed to another form of data (also
in PS format) whose amplitudes now represent dispersion energy of surface waves so that they
can construct dispersion patterns upon display. The output file saved from this step will
therefore have as many of such images as number of seismic records in the input file. It will be
saved with a postfix of "(*OT)" [e.g., "Output(SR)(ActiveOT).DAT"]. Refer to PS User Guide
"Dispersion Image Generation" for implementation.

5. Dispersion Curve (M0) Extraction
One dispersion curve of the fundamental mode (M0) is extracted from each of the input
dispersion images previously processed. This M0 curve is saved as a separate file with a "DC"
extension and with the record number appended [e.g., "Output(SR)(ActiveOT)(1).DC"]. At the
end of this step there can be as many "DC" files saved as number of input dispersion images.
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Refer to PS User Guides "Dispersion Curve Extraction (1-D Profile)" and "Dispersion Curve
Extraction (2-D Cross Section)" for implementation.

6. Inversion
Each of input dispersion curve (*.DC) will go through its own process (called "inversion") to find
a 1-D (depth) shear-wave velocity (Vs) model whose theoretical M0 curve best matches the
input curve. The output will be displayed either in the 1-D Vs profile (if only one "DC" file was
imported at the beginning) or in the 2-D Vs cross section (if multiple "DC" files were imported).
The 1-D Vs profile of a "layered" velocity (Vs) model will be saved with "(1DVs)" appended and
the "LYR" extension [e.g., "Output(SR)(ActiveOT)(1)(1DVs).LYR"], while the 2-D Vs cross section
will be saved with "(2DVs)" appended and a "TXT" extension [e.g.,
"Output(SR)(ActiveOT)(2DVs).TXT"]. Refer to PS User Guides "Inversion (1-D Profile)" and
"Inversion (2-D Cross Section)" for implementation.
The flowchart in Figure 1 illustrates how the two special processing modules ["Common-Offset Section"
(step 3.1 in the chart) and "Back-Scattering Analysis (BSA)" (step 5.1 in the chart)] can be implemented
in association with the overall analysis structure. Refer to PS User Guide "Back-Scattering Analysis (BSA)
and Common-Offset (CO) Sections" for implementation of these two steps.
A given processing session may or may not complete all the above steps, depending on the specific
purpose of the session. A session may start at an intermediate step, such as at the extraction of
dispersion curves (step 5), or a session may process only up to the generation of dispersion images for
specific evaluation purposes. The five menus: "Process", "S-Velocity (Vs)", "Dispersion", "Inversion",
and "Source/Receiver (SR) Setup" (Figure 2) will provide such flexibilities in the processing sequence.
On the other hand, the "Modeling" menu will provide tools to help either design a survey or clarify
specific complications encountered at various stages of data analysis. The "Utility" menu will provide
tools to apply nonstandard procedures such as combining seismic records and 1-D velocity (Vs) files.
Both "Modeling" and "Utilities" menus will be very useful, especially for experienced users. Refer to PS
User Guide "Modeling" and "Utility" for implementation of these two modules.
The "Display" menu will provide visualization of different types of data generated at various stages in
the processing sequence. Each display module will also provide additional features for editing and
further analysis within the module. Refer to the appropriate PS User Guide for more details about each
display module.
The "Settings" menu provides environmental options such as display of the top tool panel and sound
options for different types of notifications. The "Info" menu provides information related to this
software, and the "Help" menu will show all help files ("User Guide" files) in PDF for this software.
Buttons in each tab of the top tool panel are linked to individual menu items. For example, the first
button in the "Display" tab is linked to the first menu item in the "Display" menu (i.e., "Seismic Data")
(Figure 3). The main purpose of this "button-driven" execution (rather than "menu-driven") is to
expedite the execution of frequently-used operations. A short description of these operations will be
displayed as the mouse cursor moves over each button (Figure 4).
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Figure 1. Flowchart description of the entire processing sequence to generate shear-wave velocity (Vs)
profiles in either 1-D or 2-D format. Two special processing modules for "Common-Offset (CO)" and
"Back-Scattering Analysis (BSA)" are also illustrated.
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Figure 2. Main menu and the corresponding tool panel displayed above it.

Figure 3. Each button in a tab of the top tool panel is associated with each menu item in the main menu.
For example, the first button in the "Display" tab is associated with the first item in the "Display" menu.

Figure 4. Illustration of the hint displayed that describes the type of operation to be executed when the
mouse cursor moves over a specific button.
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2. Process

Generates a 2-D shear-wave velocity (Vs) cross section [*(2DVs).TXT] from
1 multiple SEG-2 field files (*.DAT, *.*),
○
2 a seismic data file of multiple records with source/receiver (SR) setup encoded [*(SR).DAT],
○
3 a dispersion-image file containing multiple images [*(*OT).DAT], or
○
4 multiple dispersion-curve (*.DC) files.
○

Refer to PS User Guide "Generating 2-D Cross Section (Working with Sample Data)" for more details.

Generates a 1-D shear-wave velocity (Vs) profile [*(1DVs).LYR] from
5 one (or more) SEG-2 field files (*.DAT, *.*),
○
6 a seismic data file of one (or more) records with source/receiver (SR) setup encoded [*(SR).DAT],
○
7 a dispersion-image file containing one (or more) image(s) [*(*OT).DAT], or
○
8 one dispersion-curve file (*.DC).
○

Refer to PS User Guide "Generating 1-D Profile (Working with Sample Data)" for more details.
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Generates a dispersion-image file [*(*OT).DAT] from
9 one or more of SEG-2 files (*.DAT, *.*), or
○
10 one seismic data file of one or more records with source/receiver (SR) setup encoded [*(SR).DAT].
○

Refer to PS User Guide "Dispersion Image Generation" for more details.

11 Generates dispersion curve (*.DC) file(s) from a dispersion-image file [*(*OT).DAT]. Refer to PS User
○
Guides "Dispersion Curve Extraction (1-D Profile)" and "Dispersion Curve Extraction (2-D Cross
Section)" for more details.
12 Generates a dispersion-image file [*(*OT).DAT] if a seismic-data file [*(SR).DAT] is imported, or
○
generates dispersion curve (*.DC) file(s) if a dispersion-image file [*(*OT).DAT] is imported.
13 Generates 1-D [*(1DVs).LYR] or 2-D [*(2DVs).TXT] velocity (Vs) profile if one or multiple dispersion○
curve (*.DC) file(s) are imported. Refer to PS User Guides "Inversion (1-D Profile)" and "Inversion (2D Cross Section)" for more details.
14 Executes "Back-Scattering Analysis (BSA)" by importing a seismic-data file with source/receiver (SR)
○
setup encoded [*(SR).DAT].
15 Generates a file of common-Offset (CO) sections [*(CO).DAT] from a seismic-data file with SR setup
○
encoded [*(SR).DAT]. Refer to PS User Guide "Back-Scattering Analysis (BSA) and Common-Offset
(CO) Sections" for more details.
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3. S-Velocity (Vs)

Generates a 2-D shear-wave velocity (Vs) cross section [*(2DVs).TXT] from
1 multiple SEG-2 field files (*.DAT, *.*),
○
2 a seismic data file of multiple records with source/receiver (SR) setup encoded [*(SR).DAT],
○
3 a dispersion-image file containing multiple images [*(*OT).DAT], or
○
4 multiple dispersion-curve (*.DC) files.
○

Refer to PS User Guide "Generating 2-D Cross Section (Working with Sample Data)" for more details.

Generates a 1-D shear-wave velocity (Vs) profile [*(1DVs).LYR] from
5 one or more SEG-2 field files (*.DAT, *.*),
○
6 a seismic data file of one or more records with source/receiver (SR) setup encoded [*(SR).DAT],
○
7 a dispersion-image file containing one or more images [*(*OT).DAT], or
○
8 one dispersion-curve (*.DC) file.
○

Refer to PS User Guide "Generating 1-D Profile (Working with Sample Data)" for more details.
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4. Dispersion

1 Generates dispersion-curve (*.DC) file(s) from a dispersion-image file [*(*OT).DAT].
○
2 Generates a dispersion-image file [*(*OT).DAT] from one or more of SEG-2 files (*.DAT, *.*).
○
3 Generates a dispersion-image file [*(*OT).DAT] from a seismic-data file of one or more records with
○
source/receiver (SR) setup encoded [*(SR).DAT].

Refer to the following PS User Guides for more details:


Dispersion Image Generation



Dispersion Curve Extraction (1-D Profile)



Dispersion Curve Extraction (2-D Cross Section)

9

PS - Main Menu

5. Inversion

1 Generates a 2-D velocity (Vs) cross section [*(2DVs).TXT] from multiple dispersion-curve (*.DC) files.
○
2 Generates a 1-D velocity (Vs) profile [*(1DVs).LYR] from one dispersion-curve (*.DC) file.
○

Refer to the following PS User Guides for more details:


Inversion (1-D Profile)



Inversion (2-D Cross Section)
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6. Display

Displays the following types of data:
1 seismic data in either PS (one file) or SEG-2 (one or more files) format,
○
2 one or more of dispersion-curve (*.DC) file(s), or
○
3 a dispersion-image file [*(*OT).DAT].
○

Displays the following types of data:
4 a 1-D velocity (Vs) profile [*(1DVs).LYR],
○
5 a 2-D velocity (Vs) cross section [*(2DVs).TXT],
○
6 one or more spectra (*.SPC) file(s) generated from the seismic-data display module,
○
7 generates the display module for spectra (*.SPC) files,
○
8 opens a text file (*.TXT) in a text editor module, or
○
9 generates the text editor module.
○

Refer to the following PS User Guides for more details of each display module:





Seismic-Data Display
Dispersion-Data Display
Velocity (Vs) Display (1-D Profile)
Velocity (Vs) Display (2-D Cross Section)
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7. Source/Receiver (SR) Setup

Generates the source/receiver (SR) encoding module by importing:
1 one or more of SEG-2 files (*.DAT, *.*), or
○
2 one seismic-data file of PS format (*.DAT).
○

Refer to PS User Guide "Source-Receiver (SR) Setup" for more details.
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8. Modeling

1 Generates dispersion curve (*DC) file(s) of multiple modes [0=fundamental, 1=1st higher, 2=2nd
○
higher, etc., modes] from a 1-D velocity (Vs) profile [*.LYR] through a forward modeling.
2 Generates a seismic-data file (*.DAT) from a 1-D velocity (Vs) profile [*.LYR] through a forward
○
modeling based on the reflectivity method.
3 Generates a seismic-data file (*.DAT) from a complete set of modeling parameters (*.RFL) previously
○
saved.

Refer to the following PS User Guides for more details:


Modeling Dispersion Curves



Modeling Seismic Data
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9. Utility

1 Converts SEG-2 (*.DAT, *.*) file(s) into one file of PS format (*.DAT) by displaying a separate
○
execution dialog (the "Utility" form).
2 Generates a seismic-data file of PS format (*.DAT) from a text file (*.TXT) containing seismic data in
○
ASCII format by displaying a separate execution dialog (the "TXT2PS" form).
3 Generates a seismic-data file [*(*).DAT] of a common gather of any type by importing a file with
○
source/receiver (SR) setup encoded [*(SR).DAT]. A separate execution dialog (the "Common
Gather" form) will be displayed.

Generates output of the following types from a seismic-data file with source/receiver (SR) setup
encoded [*(SR).DAT] by displaying a separate execution dialog (the "Common Gather" form):
4 common-offset (CO) gather [*(CO).DAT],
○
5 common-receiver-station gather [*(CRS).DAT],
○
6 common-source-station gather [*(CSS).DAT],
○
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7 common-mid-point gather [*(CMP).DAT],
○
8 common-field-record number gather [*(CFR).DAT],
○
9 common-recording-channel gather [*(CRC).DAT],
○
10 common-header-word gather [*(CHW).DAT], and
○
11 Generates a walkaway seismic record (from one or more input files with SR setup encoded) by
○
displaying a separate execution dialog (the "Utility" form).
12 Enables edit of trace header(s) in a seismic-data file of PS format by displaying a separate execution
○
dialog (the "Utility" form).
13 Enables adding (or subtracting) two seismic records of PS format by displaying a separate execution
○
dialog (the "Utility" form).
14 Enables construction of a 2-D velocity (Vs) cross section by importing multiple 1-D velocity (Vs)
○
profile (*.LYR) files. A separate execution dialog (the "Utility" form) will be displayed.
15 Enables remapping of one or more 1-D velocity (Vs) (*.LYR) file(s) according to a reference depth
○
model provided by another (reference) file (*.LYR). A separate execution dialog (the "Utility" form)
will be displayed.
16 Displays the "Utility" form with all utility operations available.
○

Refer to PS User Guide "Utility" for more details.

15

PS - Main Menu

10. Settings

1 Displays (or hides) the top tool panel.
○
2 Selects the type of messaging sound for this software (choose from 6 different sounds).
○
3 Selects the type of process finishing sound for this software (choose from 3 different sounds).
○
4 Turns off all sounds completely.
○
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11. Info

1 Displays the About box that shows information about this software.
○
2 Displays the Disclaimer about this software.
○
3 Displays the table of PS headers.
○
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Generating a 1-D Shear-Wave Velocity (Vs) Profile
1. Importing Field Files in SEG-2 Format
Go to "Process" → "1D S-Velocity (Vs) Profile From" → "Seismic Field Data in SEG-2."

Import multiple SEG-2 files at the same time.

The program will ask if the original source/receiver (SR) setup (if encoded during data acquisition) is to
be displayed.
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Then, the SR chart will be displayed as shown below. To replace the original setup by ignoring it, click
"Yes" to encode the new setup by running the SR setup module.

If the original SR setup is correct, then you can save imported files as a single SR-coded file [for example,
"SeismicData(SR).dat"] by choosing "No". By choosing “No,” the SR setup will explain that the
source/receiver setup will be bypassed and the saved file will be automatically passed to the next step
("Dispersion Image Generation").
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2. Source/Receiver (SR) Setup
Select "Run Wizard" to encode source/receiver (SR) configuration to each record of the imported files.
Refer to the PS User Guide ("Source-Receiver (SR) Setup") for information about how to run it. The
output will be saved as [*(SR).DAT] at the end of the setup, and will be automatically passed to the next
step ("Dispersion Image Generation").

3. Dispersion Image Generation
Click the "Run Dispersion Image" button to start the process with all default parameters. Refer to PS
User Guide ("Dispersion Image Generation") for information about control parameters included in the
"Options..." of the dialog.
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The output will be saved as [*(SR)(ActiveOT).DAT] and automatically passed to the next step
["Dispersion Curve (M0) Extraction"].

4. Dispersion Curve (M0) Extraction
At the beginning of the process, the program will ask to stack the multiple number of input dispersion
images if they all have the same surface locations. Click "Yes" to stack them and save the stacked image
as a separate image file [*(SR)(ActiveOT)(VStack).DAT].

The stacked image then will be displayed as shown below. Refer to the PS User Guide ["Dispersion
Curve (M0) Extraction"] for information about how to extract the curve.
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5. Inversion (Automatic 1st Phase)
Click "Run" to launch the automatic inversion process with all default parameters. Refer to PS User
Guide ["Inversion (1-D Profile)"] for information about all the parameters included in the "Options..." of
the dialog.

At the end of the process, the output 1-D (depth) shear-wave velocity (Vs) profile will be displayed as
shown below. If the displayed profile shows a realistic velocity variation with a relatively high match
between the measured and modeled M0 curves (e.g., ≥ 80%), then this completes the process.
Otherwise, you can proceed to perform another round of advanced inversion process that starts from
the current velocity (Vs) profile as an initial model. Refer to "Optional 2nd Phase" in the PS User Guide
["Inversion (1-D Profile)"].
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Generating a 2-D Shear-Wave Velocity (Vs) Profile
1. Importing Field Files in SEG-2 Format
Go to "Process" → "2D S-Velocity (Vs) Cross Section From" → "Seismic Field Data in SEG-2."

Import multiple SEG-2 files at the same time.

The program will ask if the original source/receiver (SR) setup (if encoded during data acquisition) is to
be displayed.
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Then, the SR chart will be displayed as shown below. To replace the original setup by ignoring it, click
"Yes" to encode the new setup by running the SR setup module.

If the original SR setup is correct, then you can save imported files as a single SR-coded file [for example,
"SeismicData(SR).dat"] by choosing "No". By choosing “No,” the program will explain that the
source/receiver setup will be bypassed and the saved file will be automatically passed to the next step
("Dispersion Image Generation").
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2. Source/Receiver (SR) Setup
Select "Run Wizard" to encode source/receiver (SR) configuration to each record of the imported field
files. Refer to the PS User Guide ("Source-Receiver (SR) Setup") for information about how to run it.
The output will be saved as [*(SR).DAT] at the end of the setup, and automatically passed to the next
step ("Dispersion Image Generation").

3. Dispersion Image Generation
Click "Run Dispersion Image" button to start the process with all default parameters. Refer to PS User
Guide ("Dispersion Image Generation") for explanations about control parameters included in the
"Options..." of the dialog.
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The output will be saved as [*(SR)(ActiveOT).DAT] and automatically passed to the next step
["Dispersion Curve (M0) Extraction"].

4. Dispersion Curve (M0) Extraction
At the beginning of this process, the first dispersion image will be displayed as shown below. Refer to
the PS User Guide ["Dispersion Curve (M0) Extraction"] for information about how to extract the
fundamental-mode (M0) curves. After all dispersion curves are extracted and saved, they will be
automatically passed to the next step ("Inversion").
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5. Inversion
Click "Run" to launch the automatic inversion process with all default parameters. Refer to PS User
Guide ["Inversion (2-D Cross Section)"] for explanations about all the parameters included in the
"Options..." of the dialog.
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At the end of the inversion process, the following two types of output will be saved and then
automatically displayed within the same form (under "Display 1" and "Display 2" tabs); a 2-D shear-wave
velocity (Vs) cross section map [*(2DVs).TXT], and the corresponding 2-D Vs confidence map
[*(2DConf).TXT], respectively, as shown below. The confidence map shows a distribution of relative
reliability in inversion results (Vs values) so that it can be used as a means to judge credibility of velocity
values in the cross section map that may change from one place to another.
<2-D Vs Cross Section Map>

<2-D Vs Confidence Map>
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About the Sample Data Set ("DippingBedrock.dat")
This sample data set is an output from seismic modeling using the reflectivity method that is also part of
the PS software (available under "Modeling" in the main menu). This data set is used to demonstrate
how to produce a 2-D cross shear-wave velocity (Vs) section. Because it is an output from PS, the data
set is already in PS format, not in SEG-2 format. Other types of sample data are explained in the PS User
Guide "Sample Data."
This sample data set consists of twenty (20) field records of 24-channel acquisition (Figure 1) with a 1-ms
sampling interval (dt) and 1024 samples of recording (i.e., recording time, T, is 1.024 sec). Each of these
records is modeled with a 2-layer earth model (overburden and bedrock) that increases its bedrock
depth systematically so that the resultant effect is a "dipping" bedrock (Figure 1). Shear-wave velocities
of overburden and bedrock were arbitrarily set to 200 m/sec and 1000 m/sec, respectively.
Corresponding Poisson's ratios were set to 0.45 and 0.33, respectively. A constant density of 2 gm/cc
was used for both overburden and bedrock.
The velocity (Vs) model shown below indicates the ideal image of the cross section that can be obtained
by properly processing this sample data set. The source/receiver (SR) configuration chart displayed
below shows relative SR location for each record within the surveyed surface distance. It shows the
receiver spacing (dx) of 1.5-m was used with the source offset (X1) of 9-m (6dx). It also shows the entire
SR configuration moved by 9 meters (6dx) each time after acquiring a record at one location.

Figure 1. Velocity (Vs) model used produce the sample data set ("DippingBedrock.dat") and its
source/receiver (SR) configuration used during the modeling.
2
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Data Processing Steps ─ Overview
By treating this sample data set as a typical field data set from an MASW survey to produce a 2-D shearwave velocity (Vs) cross section, the typical data-processing procedure is demonstrated by following the
steps outlined below. The sample data set consists of twenty (20) field records in PS format. The only
difference in comparison to a real case would be the data format. In a real situation, there would be
multiple individual field files ("records") saved in SEG-2 format at the end of a survey; for example,
"1.dat", "2.dat", "3.dat", etc. You would then have to import (open) all of them at the same time at the
beginning of data-processing flow ("Step 1" below), where they all would be combined within the
program memory in the order of file (record) number to make one file right after they are imported.
The sample data set is like the real data set at this point after combining. However, because the PS
software will convert all SEG-2 files into the PS format internally upon importing them, the
demonstrated procedure outlined here is virtually identical to a real situation.

Step 1: Source/Receiver (SR) Setup
Relative locations of seismic source and receivers are encoded into the header of each channel's
data set ("trace"). The critical parameters of receiver spacing (dx), source offset (X1), movement
of source and/or receivers, distance within the survey line of source and receivers, station
numbers, etc., are inserted into the proper headers. In reality, these parameters are usually set
at the beginning of the survey. If that is the case, then PS will inform it at the beginning of the
SR setup so that the user can visually examine the encoded information in a manner similar to
the chart displayed in Figure 1. If the user confirms the displayed setup is correct, then SR setup
is skipped. If the user finds the original field data set did not have proper information encoded,
then this SR setup is crucial and cannot be skipped.
The sample data set does not have such information encoded. Therefore, you have to input the
source/receiver setup before moving to the next step. Output from this step will have the same
extension as the input seismic data (".DAT") with a post fix of "(SR)" at the end of the file name;
for example, "DippingBedrock(SR).DAT." Explanations about the general use of the SR setup are
provided in the PS User Guide "Source-Receiver (SR) Setup."

Step 2: Dispersion Imaging
Once SR setup is complete, the next step is to generate dispersion images; one dispersion image
per field record. Because the input seismic data file has twenty (20) records, the output
dispersion image file will also have 20 images. These dispersion "images" are actually another
instance of numerical data similar to seismic data, and different from the ordinary graphical
images (for example, BMP or JPG files). In fact, they have the same numeric data format as used
in the seismic data (i.e., PS format) and therefore can be displayed using the seismic data display
module (however, there is a dedicated module to display dispersion images).
There are many parameters related to the dispersion imaging process, which is basically a
wavefield transformation operation that converts seismic wavefields in offset-time (x-t) domain
into those in phase velocity-frequency (Pv-f) domain. These parameters can influence the
quality and size of the image. However, in most cases, the program will set them to optimal
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values through many internal automated analysis steps. Output will have the same extension as
input seismic data (".DAT") with a post fix of "(ActiveOT)" at the end of the file name; for
example, "DippingBedrock(SR)(ActiveOT).DAT." Explanations about the general use of this part
of the analysis are provided in the PS User Guide "Dispersion Image Generation."

Step 3: Dispersion Curve Extraction
This step extracts and saves one fundamental-mode (M0) dispersion curve from each dispersion
image generated from previous step. Generated dispersion image data, [*(ActiveOT).DAT], will
be displayed by a dedicated module. First it will be necessary to visually examine the image and
make an interpretation for the M0 trend. This interpretation is usually simple and easy when
there is only one obvious trend of coherent energy, which is the case in most
overburden/bedrock settings (except for "too" shallow bedrock). Once this identification has
been made, then you can define the approximate trend of M0 by clicking multiple points (e.g.,
5-10) along the identified image trend. The program will draw both lower and upper bound
curves within which it will try to extract the most probable M0 curve by examining energy levels
at each frequency. You can freely change these curves to refine the zone of examination.
Each extracted dispersion curve will be saved as a text file of its own format with an extension of
".DC" and a post fix of the record number in parentheses [e.g.,
"DippingBedrock(SR)(ActiveOT)(1).DC"]. There will be a total of twenty (20) files saved at the
end of this step. General description of this part of analysis can be found in the PS User Guide
"Dispersion Curve Extraction (2-D Cross Section)."

Step 4: Inversion for 2-D Shear-Wave Velocity (Vs) Cross Section
This step will generate one 1-D (i.e., depth variation) shear-wave velocity (Vs) profile from one
input M0 dispersion curve (*.DC), and then through a proper interpolation produce a 2-D (i.e.,
depth and surface) Vs cross section from multiple 1-D Vs profiles.
There are many parameters that can influence the reliability of inversion output. Among them
the most important is the maximum depth (Zmax) of output, which is the depth to the half
space (i.e., depth to the top of the last layer of infinite thickness, the half space). Zmax is
determined by the program based on the minimum (Xmin) and maximum (Xmax) distance of
receivers from the source that were used during the survey. You can always modify Zmax
according to your own experience and knowledge. Other inversion parameters such as number
of layers and searching-algorithm related parameters are set to default values by the program
although they can always be manually changed by the user. During the inversion process, the
program will display both measured and modeled dispersion curves to indicate how closely they
match for the solution found by the program. The overall matching variation from one file (*.DC)
to another (*.DC) will also be displayed.
There will at least three (3) output files saved at the end of an inversion process, all in text files
(*.TXT)—a 2-D Vs cross section file [*(2DVs).TXT], a 2-D Vs confidence file [*(2DConf).TXT], and
the processing history file [*(HST).TXT]. The Vs cross section file will show 2-D distribution of
shear-wave velocity (Vs) within the surveyed surface distance and maximum investigation depth
(Zmax) set during the inversion, and the confidence file will show distribution of relative
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reliability (%) of analyzed velocity (Vs) values within the cross section. This confidence concept
is closely related to the sensitivity of modeled dispersion curves [*(Model).DC] to the velocity
(Vs) change by a certain amount (e.g., ±10%) at the corresponding part of the cross section.
Therefore, it purely reflects the relative reliability level (0-100%) in the solution seeking process
provided that the input (measured) M0 curve is error free. The history file will contain all
parameters set at the beginning of the inversion process as well as some parameters related to
output Vs values, such as the matching degree (%) of the two M0 curves. Some other types of
output can be chosen at the beginning of the inversion process as secondary outputs. They may
include modeled dispersion curves [*(Model).DC] and 1-D Vs profile [*(Model).LYR] for each
input (measured) M0 curve. Variation of the match between the two M0 curves [*(*Match).DC]
can also be saved with the same file format as dispersion curve so that it can be displayed by
using the dispersion-curve display module. Variation of average 1-D Vs confidence can also be
saved as a file [*(AveConf).DC] so that it can also be displayed by using the same display module.
Both Vs cross section [*(2DVs).TXT] and confidence [*(2DConf).TXT] maps will be displayed at
the end of the inversion process. General description of this part of the analysis can be found in
the PS User Guide "Inversion (2-D Cross Section)."

Processing "DippingBedrock.dat"
The entire data-processing procedure with the sample data set, "DippingBedrock.DAT", is explained
below. A yellow arrow
in the figure indicates a mouse click on the selected place, and a red arrow
indicates places and items that need attention.

Step 1: Source/Receiver (SR) Setup
From main menu, "Setup Source/Receiver (SR)" → "From Formatted Seismic Data (*.dat)"

Open "DippingBedrock.DAT."
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Select and click the "Run Wizard" button.

Check and select distance unit ("meter") and then click "Next".

Select "Active" and then click "Next".
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Select "1-D" and then click "Next".

Enter "1.5" for receiver spacing and then click "Next".

Select "Off the 1st Channel" and then click "Next".
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Enter "9" for source offset (X1) and then click "Next".

Check and confirm receiver spacing (dx) and source offset (X1). Click "Next".

Select "Both Source and RA Moved" and then click "Next".
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Enter "9" for Move Interval, and then click "Next".

Enter "0.0" for "Ref. Distance" and then "1.5" for next distance.
"Ref. Distance" is an arbitrary surface distance coordinate used as a reference point, so it can be any
number. The distance for the next channel should be offset (+ or -) by one receiver spacing (dx).
Enter "1001" and "1002" for the station numbers for the first two channel positions. Click "Next". These
are arbitrary "station" numbers that must be consecutive. The general convention for station
numbering is "1001, 1002, etc." for line 1, and "2001, 2002, etc." for line 2, and so on. They can also
decrease instead of increase.
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Review and click "Next".

Click "Run" to launch the SR setup process. It will ask for the output file name first. The default output
file name is "DippingBedrock(SR).DAT."

At the end of the process, the SR configuration chart will be displayed that shows relative location of
source and receivers within the entire distance of the survey. The configuration can also be displayed in
stations by clicking the "Stations" button on the top menu. Close the chart.
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Click "Exit". It will show the file name that saves all the setup parameters so that you can import them
by opening the file at the beginning of the SR setup process next time.

Click "Yes" to move to next step, "Dispersion Image Generation" ("Step 2"). The output file saved
previously ("DippingBedrock(SR).DAT") will be automatically transferred to the next step.

In case you need to manually import the SR-encoded file [*(SR).dat] to generate dispersion images, you
can do so by going to "Dispersion" in the main menu, and then selecting "Make Dispersion Image From
S/R Coded Data [*(SR).dat]" as shown below.
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Step 2: Dispersion Imaging
The following dialog will be displayed at the beginning of this step. Although there are many control
parameters that can be accessed by clicking "Options..." button on top, it is usually sufficient to proceed
with default values determined by the program based on its own wavefield detection algorithm.
Click "Run Dispersion Image" to launch the process.

Once the process is complete, the output file of dispersion image data will be saved as
"DippingBedrock(ActiveOT).dat" and will be automatically transferred to next step ("Step 3: Dispersion
Curve Extraction") when you click "OK".

In case you need to manually import the dispersion image file [*(ActiveOT).dat] to extract dispersion
curves, you can do so by going to "Dispersion" in the main menu, and then selecting "Get Dispersion
Curve(s) From Image Data [*(*OT).dat] as shown below.

Detailed description about this part of the analysis is provided in the PS User Guide "Dispersion Image
Generation."
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Step 3: Dispersion Curve Extraction
A chart showing the first dispersion image in the output file from previous step ("Step 2") will be
displayed with "Dispersion Analysis" tab selected in the top tool panel. (This tab will not be available
when this chart is used only for display purposes) There are five (5) buttons in the tab arranged in the
order of common use. Before proceeding to extract dispersion curves, it will first be necessary to go
through constituent dispersion images, at least for several places along the survey line like at the
beginning, in the middle and at the end. This is important to properly interpret the image for the
correct trend of the fundamental-mode (M0) dispersion, especially when there are strong and
complicated image patterns created from higher modes.
To view dispersion images at different locations, choose the "Multi-OT" tab on the top tool panel, which
will show buttons to navigate through different images.

Dispersion images at three different locations are displayed below. Images in the middle and at the end
of the survey line show a typical "single coherent" tren in which phase velocity increases at low
frequencies and decreases at the higher frequencies approaching an asymptotic constant value at about
200 m/sec, which indicates the velocity (Vs) of overburden (Vs1) is in that range (i.e., Vs1≈200 m/sec).
This "asymptotic frequency" becomes lower at the end of the survey, indicating the depth of the
overburden/bedrock interface is deeper. Other energy trends occurring at the higher frequencies and
phase velocities are those of higher modes (e.g., M1, M2, etc.) and aliased M0.
On the other hand, the image at the beginning shows a somewhat complicated pattern with two
separate strong energy trends, both of which appear to be aligned along a constant phase velocity of
about 1000 m/sec. This is a typical image pattern when the overburden thickness (H) is too "thin"; for
example, less than a few receiver spacings (e.g., 1-3dx). In this case, those strong energy trends usually
tend to align (horizontally) at a constant value that corresponds to the phase velocity of bedrock (Vphs),
which is in theory about 95% of the shear-wave velocity (Vs) (i.e., Vphs≈0.95Vs). The weak energy trend
of decreasing phase velocity occurring at frequencies higher than about 100 Hz appears to be part of the
M0 trend that will eventually approach the asymptotic phase velocity at the highest frequency ever
imaged. This indicates the strong energy trend occurring at the lower frequencies can be part of the M0
trend.
Sometimes, this "horizontal" alignment of higher mode energy is observed also at the place where the
overburden thickness becomes somewhat significant. In this case, it is usually less conspicuous because
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of the weaker and fragmented energy patterns, which are observed in the other two images at
frequencies around and higher than 150 Hz.
From the previous interpretations made by inspecting multiple dispersion images, we can conclude that
velocities of overburden (Vs1) and bedrock (Vs2) will be around 200 m/sec and 1000 m/sec, respectively,
and the depth to the bedrock increases toward the end of the survey line.
At the beginning
(Record # 1)

In the middle
(Record # 10)

M1? or Higher Modes (HM's)
Aliased M0
HM's

M0

M0

At the end
(Record # 20)

M0

The following image shows a summary of interpretations. Click the "Dispersion Analysis" tab to come
back to the process mode.
Detailed description of this part of the analysis is provided in the PS User Guide "Dispersion Curve
Extraction (2-D Cross Section)."
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Step 3-1: Bounds
This is the step to set lower and upper bounds of phase velocities for the fundamental-mode dispersion
curve to extract. Depress the "Bounds" button and then click along the M0 trend to add reference
points ("circles") with lower and upper bounds ("asterisks").
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<Moving Reference and Bounds Points>
Reference points can be moved freely (up and down, left and right), whereas bounds points can be
moved only up and down at the fixed horizontal location of the corresponding reference point.

<Deleting Reference Points>
Drag and draw a zone to delete multiple points, or click individual points to delete one by one. The
corresponding bounds points will also be deleted.

<Example After Delete According To the Actions Indicated Above>
16

PS - Generating 2-D Shear-Wave Velocity (Vs) Cross Section

<Finishing Up Reference Points and Bounds Points Properly Around M0 Trend>
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Step 3-2: Controls
Parameters related to the extracted dispersion curve can be controlled. Click "Controls" button to show
the dialog of control parameters. Default values are usually sufficient.

Step 3-3: Extract
This step will extract the curve by picking data points of maximum amplitude at each frequency in the
dispersion image. Click "Extract" button that will show the extracted curve on top of the image.

dispersion curve
signal-to-noise ratio
(SN) curve
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<Editing Extracted Curve ─ Deleting Points>
Drag and draw a zone to delete multiple points, or click individual points to delete one by one.

deleting multiple
points

deleting one point

<Editing Extracted Curve ─ Adding Points>
Click anyplace on the M0 trend to add points one by one. Corresponding points for SN will also be
added by detecting the energy at the clicked points.
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Step 3-4: Save
Click the "Save" button to save the extracted curve (*.DC). The default file name will have the record
number attached at the end of common file name.

This will complete the process for "one" record, and the program will move to next image automatically.
From there on, the same sequence or process can be applied to save subsequent dispersion curve files.
The only adjustment to be made will be the accommodation of bounds so that they encompass the
correct M0 trend that may change from one image to another.
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<Moving To Next Record and Adjusting Bounds>
Adjust both reference and bounds points properly to account for M0 trend change.

<Editing Extracted M0 Curve>
Editing curve by deleting some points.
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<Changing Bounds by Pressing "Bounds" Button Whenever Necessary>
Especially, the first and last reference points may have to be adjusted to account for the change in M0
trend. As depth to bedrock increases, the first and last reference points will have to be gradually moved
toward lower frequencies.

You can always go back to previous image by using the navigation buttons in the "Multi-OT" tab and
then perform the extraction and saving process again to replace the previously saved curve. At the end
of the process after saving all extracted M0 curves, it will ask you to proceed to the last step ("Step 4").
All previously saved M0 curves (*.DC) will be automatically transferred at this stage.

In case you need to manually import these files, you can do so by going to "Inversion" in the main menu
and selecting "Make 2D Vs Cross Section From Dispersion Curves (*.dc)" as shown below. You will then
have to select all these files at the same time (e.g., "*(1).DC", "*(2).DC", "*(3).DC", etc.).

A complete set of extracted dispersion curves and corresponding images are displayed at the end in the
section <Sample Example of Extracted Dispersion Curves>.
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Step 4: Inversion
The following dialog will be displayed at the beginning of this step. Although there are many control
parameters that can be accessed by clicking the "Options..." button at the top, it is usually sufficient to
proceed with default values determined by the program based on the range of wavelengths in input
dispersion curves and also on the offset range used during data acquisition. For detailed information
about this part of the analysis, refer to the PS User Guide "Inversion (2-D Cross Section)."
Click "Run" to launch the process.

The following dialog will be displayed to confirm the maximum depth (Zmax) of the inversion that is
originally determined by the program based on the average offset range used during data acquisition.
This is one of the most important parameters in the inversion process that is directly related to the
resolution of the final 2-D shear-wave velocity (Vs) map. If you click "No", then the program will show
the relevant tab where you can adjust Zmax as well as other parameters. Otherwise, click "Yes."
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First, the process to determine the depth to the velocity (Vs) interface will take place. This is the depth
where the most abrupt change in velocity occurs. This process is termed in the control diagram as
"Bedrock Detection."

The next processing step to take place will find the velocity (Vs) model whose theoretical (i.e., modeled)
dispersion curve best matches the measured curve. This is accomplished through an iterative process
during which intermediate dispersion curves will be displayed to show corresponding match. The
overall match will also be displayed in a single-column graph as well as a 2-D chart form showing its
variation with surface location.
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As shown below, at the end of the inversion process two types of output will be saved and then
automatically displayed within the same form (under "Display 1" and "Display 2" tabs)—a 2-D shearwave velocity (Vs) cross section map [*(2DVs).TXT], and the corresponding 2-D Vs confidence map
[*(2DConf).TXT], respectively. The velocity color scheme in the 2-D Vs cross section is automatically
determined by the program based on the velocity value distribution in the input file [*(2DVs).TXT]. This
can be changed through a control dialog explained below. Notice that the cross section map shown
below used the color scheme displayed on top that is matched within the Vs range of 0-1200 m/sec.
The confidence map shows distribution of relative reliability in inversion results (Vs values) so it can be
used in link to judge credibility of velocity values in a cross section map that may change from one place
to another.
<2-D Vs Cross Section Map>

<2-D Vs Confidence Map>
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<To Change Velocity (Vs) Color Scale>
Select the "View" tab in the top tool panel. Then, click the "Controls" button to display the control
dialog. Enter values for "MIN" and "MAX" to specify the velocity range and then click the "Update
Image" button at the bottom. Many parameters related to the 2-D interpolation (e.g., interpolation
schemes) and display (e.g., changing axis scale, labeling, etc.) of the input text file (*.TXT) in the usual
three-column format (i.e., X, Depth, Value) can be accessed through this dialog.

In case you need to manually open the 2D Vs cross section file, you can do so by going to "Display" in the
main menu, and then "S-Velocity (Vs) Data" →"2-D Vs Cross Section (*.TXT)" as shown below.

The corresponding confidence map can be automatically imported within the cross section display form
by selecting the "View" tab in the top tool panel and then clicking the "2DConf" button as shown below.
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<Sample Example of Extracted Dispersion Curves; Record # 1-10>
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<Sample Example of Extracted Dispersion Curves; Record # 11-20>
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About the Sample Data Set ("Vs1DMASW.dat")
This sample data set simulates a set of data from an MASW survey to produce a 1-D shear-wave velocity
(Vs) profile commonly used to dictate depth variation of stiffness at a fairly confined area. Typical
application would be the MASW survey for geotechnical investigation of wind-turbine sites. The data
set is an output from a seismic modeling based on the reflectivity method that is also part of the PS
software (available under the "Modeling" menu). This data set is used to demonstrate how to produce a
1-D shear-wave velocity (Vs) profile. Because it is an output from PS, the data set is already in PS format,
not in SEG-2 format. It consists of eight (8) field records of 24-channel acquisition with a 1-ms sampling
interval (dt) and 1024 samples of recording (i.e., recording time, T, is 1.024 sec). These records are
modeled with a 2-layer earth model (overburden and bedrock), as shown below. Two different source
orientations (i.e., forward and reverse shots) and four different source offsets (X1's) are used to produce
eight (8) unique records for the combination of the two variables. This is a common practice to
maximize the robustness of data analysis. For example, use of different X1's minimizes any adverse
influence from the near-field effects, whereas acquiring data from both ends of the receiver array tends
to average out any lateral variation in the subsurface velocity model (e.g., dipping or uneven bedrock
surface) so that the analysis can achieve the highest resolution in vertical variation.
Shear-wave velocities of overburden and bedrock were arbitrarily set to 200 m/sec and 1000 m/sec,
respectively. Corresponding Poisson's ratios were set to 0.45 and 0.33, respectively. A constant density
of 2 gm/cc was used for both overburden and bedrock. The source/receiver (SR) configuration chart
displayed below the velocity model shows relative SR location for each record. It shows the receiver
array stayed at the same surface location for all eight (8) records, with only the source moving to change
offsets (X1's) and orientations. Forward shots refer to those impacts made off the first channel,
whereas reverse shots refer to those made off the last (24th) channel. Table 1 summarizes locations of
source and receivers for each record in the sample data set.
Other types of sample data are explained in the PS User Guide "Sample Data."

Figure 1. Shear-wave velocity (Vs) model used to generate synthetic data "Vs1DMASW.dat."
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Figure 2. Source and receiver (SR) configuration used to generate model data set "Vs1DMASW.dat."
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Data Processing Steps ─ Overview
By treating this sample data set as a typical field data set from an MASW survey to produce a 1-D shearwave velocity (Vs) profile, the typical data-processing procedure is demonstrated by following the steps
outlined below. The sample data set consists of eight (8) field records in PS format. The only difference
in comparison to a real case would be the data format. In a real situation, there would be multiple
individual field files ("records") saved in SEG-2 format at the end of a survey; for example, "1.dat",
"2.dat", "3.dat", etc. Then, you will have to import (open) all of them at the same time at the beginning
of the data-processing flow ("Step 1" below),where they are all combined within the program's internal
memory, in the order of file (record) number, to make one file right after they are imported. The
sample data set is like the real data set at this point after combining. In this sense, the demonstrated
procedure outlined here is virtually identical to a real situation.

Step 1: Source/Receiver (SR) Setup
Relative locations of seismic source and receivers are encoded into the header of each channel's
data set ("trace"). The critical parameters of receiver spacing (dx), source offset (X1), movement
of source and/or receivers, distance within the survey line of source and receivers, station
numbers, etc., are inserted into the proper headers. In reality, these parameters are usually set
at the beginning of the survey. If that is the case, then PS will inform it at the beginning of the
SR setup so that the user can visually examine the encoded information in a manner similar to
the chart displayed in Figure $. If user confirms the displayed setup is correct, then this SR setup
is skipped. If user finds the original field data set did not have proper information encoded, then
this SR setup is crucial and cannot be skipped.
The sample data set does not have such information encoded. Therefore, you have to input the
source/receiver setup before moving to the next step. Output from this step will have the same
extension as input seismic data (".DAT") with a post fix of "(SR)" at the end of the file name; for
example, "Vs1DMASW(SR).DAT." Explanations about the general use of the SR setup are
provided in the PS User Guide "Source-Receiver (SR) Setup."

Step 2: Dispersion Imaging
Once SR setup is complete, the next step is to generate dispersion images; one dispersion image
per field record. Because the input seismic data file has eight (8) records, the output dispersion
image file will also have 8 images. These dispersion "images" are actually another instance of
numerical data similar to seismic data, and different from the ordinary graphical images (e.g.,
BMP or JPG files). In fact, they have the same numeric data format as used in the seismic data
(i.e., PS format) and therefore can be displayed by using the seismic data display module.
However, PS has a separate module dedicated for dispersion image displays in the main menu
('Display' → 'Dispersion Data' → 'Dispersion Image').
There are many parameters related to dispersion imaging process, which is basically a wavefield
transformation operation that converts seismic wavefields in an offset-time (x-t) domain into
those in a phase velocity-frequency (Pv-f) domain. These parameters can influence the quality
and size of the image. In most cases, however, the program will set them to the most optimal
4

PS - Generating 1-D Profile (Working with Sample Data)
values through many internal automated analysis steps. Output will have the same extension as
input seismic data (".DAT") with a post fix of "(ActiveOT)" at the end of the file name; for
example, "Vs1DMASW(SR)(ActiveOT).DAT." Explanations about the general use of this part of
the analysis are provided in the PS User Guide "Dispersion Image Generation."

Step 3: Dispersion Curve Extraction
This step extracts and saves the fundamental-mode (M0) dispersion curve from each dispersion
image generated from previous step. Although there are eight (8) dispersion images generated,
they all originated from the receiver array that stayed at the same surface location. Therefore,
it will have little meaning to extract separate M0 curves from each of these images. Even if all
separate M0 curves are extracted, it will be very unlikely they will all look identical because each
image has slightly different dispersion characteristics dominating over different frequency and
phase velocity ranges. This is because they all had different source locations and are therefore
influenced to a different extent by near-field effects and lateral subsurface variation. Instead,
these images should be stacked to produce one image that has the most accurate dispersion
characteristics over the broadest frequency and phase velocity ranges through the constructive
interference of coherent dispersion trends, while suppressing inconsistent random noise energy
patterns.
Generated dispersion image data [*(ActiveOT).DAT] will be displayed by a dedicated module.
Then, the program will ask if you want to stack the images to produce one final image to be
used for the extraction of an M0 curve. If 'stacking' is not chosen, then the remaining procedure
will be identical to generating a 2-D velocity (Vs) cross section after extraction of all eight M0
curves. In this case, the record number (instead of surface distance) will be used as the
horizontal coordinate for the 2-D cross section. However, it is highly recommended that you
choose the stacking option until you become fairly well experienced in recognizing complicated
dispersion patterns. At that point, you will be able to decide if any of the individual images
possess the dispersion pattern superior to that of the stacked image, as is sometimes the case.
Once the stacked image is displayed, then first it will be necessary to visually examine the image
and make an interpretation for the M0 trend. This interpretation usually will be simple and easy
when there is only one obvious trend of coherent energy, which is often the case in most
overburden/bedrock settings (except for "too" shallow bedrock). Once this identification has
been made, then you can define the approximate M0 trend by clicking multiple points (e.g., 5-10)
along the identified image trend. The program will then draw both lower and upper bound
curves within which it will try to extract the most probable M0 curve by examining energy levels
at each frequency. You can freely change these curves to refine the zone of examination.
The extracted dispersion curve will be saved as a text file of its own format with an extension of
".DC" with a post fix of the record number within parentheses [e.g.,
"Output(SR)(ActiveOT)(1).DC"]. There will be only one dispersion curve file (*.DC) saved at the
end of this step. General description of this part of analysis can be found in the PS User Guide
"Dispersion Curve Extraction (1-D Profile)."
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Step 4: Inversion for 1-D Shear-Wave Velocity (Vs) Profile (Automatic 1st
Phase)
This step will generate one 1-D (i.e., depth variation) shear-wave velocity (Vs) profile from the
input M0 dispersion curve (*.DC) previously saved at the end of the Step 3.
There are many parameters that can influence the reliability of inversion output. Among them
is the most important, the maximum depth (Zmax) of output, which is the depth to the half
space (i.e., depth to the top of the last layer of infinite thickness, the half space). Zmax is
determined by the program based on the minimum (Xmin) and maximum (Xmax) distances of
the receiver from the source that were used during the survey. However, you can always
modify it, as needed, according to your own experience and knowledge. Other inversion
parameters, such as number of layers and searching-algorithm related parameters, are set to
default values by the program although they can always be manually changed by the user.
During the inversion process, the program will display both measured and modeled dispersion
curves to indicate how closely they match for the solution found by the program.
There will at least two (2) output files saved at the end of the inversion process, all in text files
but with different extensions; 1-D Vs profile file [*(1DVs).LYR] and its modeled dispersion curve
[*(Model).DC]. The processing history of all inversion parameters (for example, number of
layers, number of iterations, final match between measured and modeled dispersion curves, etc.)
is included in the Vs profile (*.LYR). The Vs profile will show depth variation of shear-wave
velocity (Vs) within the maximum investigation depth (Zmax) set during the inversion, whereas
the modeled dispersion curve will show the theoretical M0 curve corresponding to the velocity
(Vs) profile.
The Vs profile will be displayed automatically at the end of the inversion process. This will be
the velocity (Vs) model found automatically by the program without user's intervention, based
on its own searching algorithm, and is usually sufficient to dictate the reality. Then, this
completes the entire procedure to generate the 1-D Vs profile. General description of this part
of the analysis can be found in the PS User Guide "Inversion (1-D Profile)."

Step 5: Inversion for 1-D Shear-Wave Velocity (Vs) Profile (Optional 2nd
Phase)
However, it is often beneficial to attempt one or a few more rounds of the inversion process
through a manual searching process followed by another automatic inversion process. This can
often lead to finding a profile whose M0 curve matches the measured curve even better (i.e., a
higher match), or a profile that appears more realistic. This is especially true under two
possibilities. First, due to the non-uniqueness of inversion, a property inherent to all types of
inversion processes, the Vs profile found automatically by the program may appear very
unrealistic (for example, a highly oscillating profile) although its M0 curve matches very closely
to the measured one. In this case, it is necessary to manually update the profile until it looks
more realistic while maintaining a comparable (or even improved) match between the two M0
curves. Second, due to the possible error at one or more data points in the measured M0 curve
(that in turn may be a result of noisy data or analysis error), the inversion process can
sometimes generate an unrealistic Vs profile in response to the searching algorithm trying to
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find a solution that satisfies all data points in the input M0 curve as much as possible. Again, in
this case, it will be necessary to manually update the profile, possibly followed by another
automatic inversion after the update. Whenever either or both of these two possibilities are
suspected, another round of inversion will be necessary that should start with the manual
update of the profile by using the computer mouse. The risk of the non-uniqueness issue in
inversion will be significantly reduced if the manual update is followed by another execution of
the automatic inversion that will use the updated profile as the initial velocity model. Extending
the degree of freedom in inversion variables by choosing the 'Variable Depth' option can
significantly improve the effectiveness of the new searching process. General description of this
part of the analysis can be found in the PS User Guide "Inversion (1-D Profile)."

Processing "Vs1DMASW.dat"
The entire data-processing procedure with the sample data set "Vs1DMASW.DAT” is demonstrated. A
yellow arrow
in the figure indicates a mouse click on the selected place, and a red arrow
indicates places and items that need attention.

Step 1: Source/Receiver (SR) Setup
From main menu, "Setup Source/Receiver (SR)" → "From Formatted Seismic Data (*.dat)"

Open " Vs1DMASW.DAT."

7

PS - Generating 1-D Profile (Working with Sample Data)
Select and click "Run Wizard" button.

Check and select distance unit ("meter") and then click "Next" button.

Select "Active" and then click "Next" button.
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Select "1-D" and then click "Next" button.

Enter "1.0" for receiver spacing and then click "Next" button.

Select "Off the 1st Channel" and then click "Next" button.
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Enter "1.0" for source offset (X1) and then click "Next" button.

Check and confirm receiver spacing (dx) and source offset (X1). Then, click "Next" button.

Select "Source Moved (RA did NOT)" and then click "Next" button.
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Enter "5" for Move Interval, and then click "Next" button.

Enter "0.0" for "Ref. Distance" and then "1.0" for next distance.
"Ref. Distance" is an arbitrary surface distance coordinate used as a reference point. Therefore, it can
be any number. But, the distance for next channel should be offset (+ or -) by one receiver spacing (dx).
Enter "1001" and "1002" for the station numbers for the first two channel positions. Then, click "Next"
button. These are arbitrary "station" numbers that must be consecutive. The general convention for
station numbering is "1001, 1002, etc." for line 1, and "2001, 2002, etc." for line 2, and so on. They can
also decrease instead of increase.
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Review and click "Next" button.

Make sure to specify begin and end record numbers correctly here. The previous specification of
moving 5 meters (5dx) is valid only for the next record (2), and therefore the end record number should
be '2'. The other records will be handled separately (two records at a time) after completion of these
two records. Click "Run" to launch the SR setup process.
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It will ask for output file name first. Default output file name is "Vs1DMASW(SR).DAT."

The source/receiver (SR) configuration chart will be displayed that shows relative location of source and
receivers for the first two records (1 and 2). The configuration can also be displayed in "Stations" by
clicking the button at the top. Close the chart.

It is now time to set up SR for next two records (3 and 4). The box shown below reminds you of this.
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Select '3' and '4' for the begin and end records, respectively. Then, click 'Locations' button at the top.

Make sure the "Off the 1st Channel" button is selected and then click "Next" button.
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Enter '12' for source offset (X1) and then click 'Next' button.

Check and confirm receiver spacing (dx) and source offset (X1). Then, click 'Next' button.

Make sure the 'Source Moved (RA did NOT)' button is selected and then click 'Next' button.
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Enter '12' for Move Interval, and then click 'Next' button.

Make sure you use the same convention previously used for distance and station numbering; x = 0.0 m
(station number = 1001) at 24th channel, and x = 1.0 m (station number = 1002) at 23rd channel, etc.

Review and click "Next" button.
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Make sure begin and end records are set to '3' and '4,' respectively. Then, click 'Run' button.

The source/receiver (SR) configuration chart will be displayed, showing the relative location of source
and receivers for all records in the output file (1, 2, 3, and 4). Close the chart.

Now, it is time to setup SR for the next two records (5 and 6). The box shown below reminds you of this.
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Select '5' and '6' for the begin and end records, respectively. Then, click 'Locations' button on top.

Now, make sure the "Off the Last Channel" button is selected because the two records were acquired
with the source on the opposite side of receiver array (i.e., "reverse shots"). Click the "Next" button.
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Confirm source location and enter "1" for the source offset (X1). Click "Next" button.

Confirm receiver spacing (dx) and source offset (X1). Click "Next" button.

Make sure "Source Moved (RA did NOT)" button is selected. Click "Next" button.
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Enter "5" for the move Interval, and then click "Next" button.

Make sure you use the same convention previously used for distance and station numbering; x = 0.0 m
(station number = 1001) at 24th channel, and x = 1.0 m (station number = 1002) at 23rd channel, etc.
Now, displayed configuration requires this information to be set for the first two channels (1st and 2nd).
Therefore, enter "23" ("1024") and "22" ("1023") for distance (station number) of the first two channels,
respectively.

Review and click "Next" button.
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Make sure begin and end records are set to '5' and '6,' respectively. Then, click 'Run' button.

The source/receiver (SR) configuration chart will be displayed showing relative location of source and
receivers for all records saved in the output file (1, 2, 3, 4, 5, and 6). Make sure the last two records (5
and 6) have the source located at a negative distance because they are "reverse" shots. Close the chart.

Now, it is time to setup SR for the last two records (7 and 8). The box shown below reminds you of this.
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Select '7' and '8' for the begin and end records, respectively. Then, click 'Locations' button on top.

Make sure "Off the Last Channel" button is selected. Click "Next" button.

Confirm source location and enter "12" for the source offset (X1). Click "Next" button.
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Confirm receiver spacing (dx) and source offset (X1). Click "Next" button.

Make sure "Source Moved (RA did NOT)" button is selected. Click "Next" button.

Enter "12" for the move Interval, and then click "Next" button.
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Make sure you use the same convention previously used for distance and station numbering; x = 23 m
(station number = 1024) at 24th channel, and x = 22 m (station number = 1023) at 23rd channel, etc.

Review and click "Next" button.

Make sure begin and end records are set to '7' and '8,' respectively. Then, click 'Run' button.
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The source/receiver (SR) configuration chart will be displayed showing the relative location of source
and receivers for all records saved in the output file (1 - 8). Close the chart.

Now, SR setup is complete. Click "Next" button.

Click "Yes" to move to next step, "Dispersion Image Generation" (Step 2). The output file saved
previously ["Vs1DMASW(SR).DAT"] will be automatically transferred to next step.
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In case you need to manually import the SR-encoded file [*(SR).dat] to generate dispersion images, you
can do so by going to "Dispersion" in the main menu, and then selecting "Make Dispersion Image From
S/R Coded Data [*(SR).dat]" as shown below.

Step 2: Dispersion Imaging
The following dialog will be displayed at the beginning of this step. Although there are many control
parameters that can be accessed by clicking the "Options..." button at the top, it is usually sufficient to
proceed with default values determined by the program based on its own wavefield detection algorithm.
Detailed description about this part of the analysis is provided in the PS User Guide "Dispersion Image
Generation."
Click "Run Dispersion Image" to launch the process.

Once the process is complete, the output file of dispersion image data will be saved as
"Vs1DMASW(ActiveOT).dat" and will be automatically transferred to next step (Step 3: Dispersion Curve
Extraction) when you click "OK" button.
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In case you need to manually import the dispersion image file [*(ActiveOT).dat] to extract dispersion
curves, you can do so by going to "Dispersion" in the main menu, and then selecting "Get Dispersion
Curve(s) From Image Data [*(*OT).dat] as shown below.

Step 3: Dispersion Curve Extraction
This step extracts and saves the fundamental-mode (M0) dispersion curve from the dispersion image
generated in the previous step. Although there are eight (8) dispersion images generated, they all
originated from the receiver array that stayed at the same surface location. Therefore at the beginning
of this step, the program will ask to stack all of them to make one stacked image. Click "Yes" and specify
the output file name for the stacked image [*(ActiveOT)(VStack).dat]. Another dialog will ask how you
want to handle the surface coordinate information of the stacked image such as source offset and
locations. Click "Yes" to properly update them (i.e., average them). Description of this part of the
analysis is presented in the PS User Guide "Dispersion Curve Extraction (1-D Profile)."
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A chart showing the stacked dispersion image will be displayed with "Dispersion Analysis" tab chosen in
the top tool panel. (This tab will not be available when this chart is used only for display purposes.)
There are five (5) buttons in the tab arranged in the order of common use. Before proceeding to extract
the fundamental-mode (M0) dispersion curve, first it will be necessary to make a proper interpretation
of the displayed image. For that, it will be useful to draw grid lines on the image. Select "Scale" tab on
the top tool panel and then select the "Grids" button. The image shows a coherent dispersion trend
starting at about 15 Hz (almost appearing as a vertical streak) that rapidly becomes an asymptotic trend
at frequencies higher than about 30 Hz. The vertical streak near the vertical axis is a computational
artifact generated from the 2-D wavefield transformation that may or may not become significant
depending on the spectral characteristics of surface waves as well as acquisition geometries. There is
another weak asymptotic trend occurring at frequencies higher than about 120 Hz with a phase velocity
approaching about 1000 m/sec. This type of pseudo-asymptotic trend occurring at relatively high
frequencies (e.g., > 100 Hz) is usually associated with shear-wave refraction from the bedrock surface.
The theory indicates the upper bound of this trend (~1000 m/sec) can be used as an approximation of
the bedrock Vs. Then, it sets the upper bound in picking the M0 curve along the vertical trend near
15 Hz. Considering the theoretical relationship that phase velocity (Vphs) of surface wave is slightly less
than Vs (e.g., Vphs ≈ 0.93Vs), the highest Vphs in the picked M0 curve should not exceed ~9300 m/sec.
Then, choose the "Dispersion Analysis" tab to come back to the process mode.

Detailed description of this part of the analysis is provided in the PS User Guide "Dispersion Curve
Extraction (1-D Profile)."

28

PS - Generating 1-D Profile (Working with Sample Data)
Step 3-1: Bounds
This is the step to set lower and upper bounds of phase velocities for the fundamental-mode dispersion
curve to extract. Select the "Bounds" button and then click along the M0 trend to add reference points
("circles") with lower and upper bounds ("asterisks").

<Deleting Reference Points>
Drag and draw a zone to delete multiple points as illustrated below.

Or, click individual point to delete one by one as illustrated below.
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<Adding Reference Points>
Reference points can be added anytime while the "Bounds" button is selected by clicking any place on
the image as illustrated below.

<Moving Reference and Bounds Points>
Reference points can be moved freely (up and down, left and right), whereas bounds points can be
moved up and down only at the fixed horizontal location of the corresponding reference point.
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Step 3-2: Controls
Parameters related to the extracted dispersion curve can be controlled. Click "Controls" button to show
the dialog of control parameters. Default values are usually sufficient.

Step 3-3: Extract
This step will extract the curve by picking data points of maximum amplitude at each frequency in the
dispersion image. Click "Extract" button to display the extracted curve on top of the image.
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<Editing Extracted Curve ─ Deleting Points>
Drag and draw a zone to delete multiple points, or click individual points to delete one by one as
illustrated below.

<Editing Extracted Curve ─ Adding Points>
Click anyplace on the M0 trend to add points one by one as illustrated below. Corresponding points for
SN will also be added by detecting the energy at the clicked points.

<Moving Data Points>
Data points in the extracted curve can be moved freely (up and down, left and right) as illustrated below.
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Step 3-4: Save
Click "Save" button to save extracted curve (*.DC). The default file name will have the record number
attached at the end of output file name [e.g., *(1).DC].

The program will then ask you to proceed to the last step ("Step 4"). The previously saved M0 curve
(*.DC) will be automatically transferred.

In case you need to manually import this dispersion curve, you can do so by going to "Inversion" in the
main menu and then selecting "Make 1D Vs Profile from Dispersion Curve (*.dc)" as shown below.
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Step 4: Inversion (Automatic 1st Phase)
The following dialog will be displayed at the beginning of this step. Although there are many control
parameters that can be accessed by clicking the "Options..." button at the top, it is usually sufficient to
proceed with default values determined by the program based on the range of wavelengths in the input
dispersion curve and also on the offset range used during data acquisition. For detailed information
about this part of the analysis, refer to the PS User Guide "Inversion (1-D Profile)."
Click "Run" to launch the process.

The following dialog will be displayed to confirm the maximum depth (Zmax) of the inversion that is
originally determined by the program based on the average offset range used during data acquisition.
This is one of the most important parameters in inversion process, directly related to the resolution of
the final 1-D shear-wave velocity (Vs) profile. If you click "No", the program will display the relevant tab
where you can adjust Zmax as well as other parameters. Otherwise, click "Yes."
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First, the process to determine the depth to the velocity (Vs) interface will take place. This is the depth
where the most abrupt change in velocity occurs. This process is termed in the control diagram as
"Bedrock Detection." The program then starts the process to search for detailed velocity variations.

The 1-D Vs profile, saved as a layered-earth model [*(1DVs).LYR], will be displayed automatically at the
end of the inversion process in the dedicated module as shown below. The two dispersion curves of
measured and modeled M0 curves are also displayed to indicate the match between them with one of
the two vertical axes of the chart represent frequency of the curve. The match (%) is indicated in the
title bar of the display window. It is the velocity (Vs) model found automatically by the program without
user's intervention based on its own searching algorithm, and is usually sufficient to dictate the reality.
This completes the entire procedure to generate a 1-D Vs profile.

In case you need to display this output file [*(1DVs).LYR], you can do so by going to "Display" →
"S-Velocity (Vs) Data" → "1-D Vs Profile (*.LYR)" under the main menu as illustrated below.
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Step 5: Inversion (Optional 2nd Phase)
However, it is often beneficial to attempt one or more passes of the inversion process through a manual
searching process followed by another automatic inversion process. This can often lead to finding a
profile whose M0 curve matches the measured curve even better and/or a profile that appears more
realistic. The module displaying the inversion output of the 1-D Vs profile has all the functions ready for
this purpose. For example, the individual layer can be changed in its velocity and thickness by the clickand-drag motion of mouse toward either horizontal (velocity) or vertical (thickness) direction. If you do
so, the displayed model dispersion curve [*(Model).DC] will be updated accordingly, with the new match
(%) indicated in the title bar of the display window. For detailed information about this part of the
analysis, refer to the PS User Guide "Inversion (1-D Profile)."
The example below illustrates that several layers are changed in velocity (Vs) by using the click-and-drag
motions of the mouse so that the overall profile may look more realistic.
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The window title bar shows the match improved, indicating that the manual update was successful.

Now, because the "initial" velocity model has been slightly updated, another automatic inversion may
find a "further improved" velocity profile. So, it is now suggested to run it again by selecting the
"Inversion" tab on the menu panel, and then clicking the "RUN" button as illustrated below. The new
match (85.33 %) now shows a little improvement. This is usually the case if the new automatic inversion
process could not find another model significantly different from the current one that maintains
comparable or an improved match in M0 curves.

It is also worthwhile to try to introduce another degree of freedom in the process by choosing the
option of "Variable max. depths" as illustrated below. PS will then execute the automatic inversion
process for as many different depth models as selected (e.g., 10) that are created by either contracting
(< 100 %) or stretching (> 100%) the current velocity model. The example illustrated below indicates
that the process will examine ten (10) different initial models within 75% - 125% of the current velocity
model. From the search with all these different models, the program will show at the end the model
that has the best (i.e., highest) match.
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Click the "Run" button to perform this "Variable max. depths" inversion. After a while, the final solution
of a velocity model will be displayed. The example below indicates the match improved noticeably from
85.33% to 89.34%. Above all, the profile looks quite realistic.
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Now may be the time to save it as the final solution.
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1. Overview
The main purpose of running source/receiver (SR) setup is to encode the proper distance and location
information into the header of each channel's data in the recorded field files (records). This setup is
usually encoded into original field records during the field operation by the acquisition software if the
operator arranges necessary parameters properly at the beginning of data acquisition. This can be
checked at the early stage of SR setup when importing field records of SEG-2 format (and, if they are
confirmed to have the correct setup encoded, then they can be saved as a single file in the PS-format
[*(SR).dat] ready for the regular MASW analysis and this separate setup procedure will be skipped). If
the SR setup was ignored during data acquisition or the original setup is in error, then the correct setup
can be encoded by running this "Source/Receiver (SR) Setup" module from the main menu.

The overall procedure of SR setup consists of following three (3) steps:

Step 1. Pre-Setup
Prerequisite information is gathered or confirmed at this step such as the unit of distance (feet
or meters), number of channels detected from input, survey type [active, passive, and
combined (active + passive) surveys], and receiver array (RA) type (1-D or 2-D).

Step 2. Source/Receiver (SR) Specification
Actual settings of relative location (in distance and station numbers) of the seismic source (for
active and combined survey cases) and individual receivers are specified either all at once
through one systematic sequence to all input records, or through a multiple sequence of
different settings applied to different portions of the records. This SR specification is treated
differently for 1-D and 2-D receiver array (RA) types, respectively.

Step 3. Specification of Files To Apply and Running Setup
By default, all setup parameters arranged through the previous two steps will be applied to all
input records. Otherwise, the proper range of input records to apply the setup to can be
chosen at this step before running the actual setup. In this case, multiple setup sequences can
be run for different ranges of input records by repeating all three (3) steps and saving
(appending) outputs under the same file name.
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To import multiple seismic files of SEG-2 format from the main menu, go to "Setup Source/Receiver
(SR)" → "From SEG-2 Seismic Field Data (*.dat)" and select the files at the same time as illustrated below.
Then, the program will detect if any encoded SR setup is found. If so, then you select to view the entire
setup in a chart for visual inspection and confirmation. If the displayed setup is confirmed correct, then
you can save input record(s) as a single file of PS-format ready for the regular MASW data analysis and
skip the separate setup. Otherwise, you need to run your own setup by following the procedures
outlined here.
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The SR setup can also be applied to a previously saved file of PS-format from the main menu. In this
case, only one file is selected for input. To import an input seismic data file of PS-format from the main
menu, "Setup Source/Receiver (SR)" → "From Formatted Seismic Data (*.dat)" and select one file as
illustrated below.

Once the input data set is imported, then the SR setup main menu will be displayed as shown below.
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2. Source/Receiver (SR) Setup ─ Main Menu
Main menu consists of three options; "Run Wizard", "Start with a Common Example", and "Import a
Previous Setting", each of which is explained below.

2.1 Run Wizard
This will enable you to follow a sequence of graphical displays to specify all necessary source/receiver
(SR) configuration parameters such as receiver spacing (dx), source offset (X1), source location, how the
survey proceeded, etc. This option of "Run Wizard" is further explained in the last two sections of
"Source/Receiver (SR) Setup for 1-D Vs Profile" and "Source/Receiver (SR) Setup for 2-D Vs Cross
Section."

2.2 Start with a Common Example
This will enable you to choose one of the typical settings commonly used in MASW surveys (1-D and 2-D).
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It will first draw attention to a few key parameters related to the specific input data set imported for the
setup: total number of channels in each of the input records, range of input file numbers, and distance
unit used during data acquisition. Be sure to select the appropriate distance unit before proceeding to
the next step. The default unit is the one detected from the input data.

Then, you are to choose one of the three survey types; active, passive, and (active+passive) combined
survey. Each of these options is explained. First, select the "Active" button as shown below.
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The following six (6) cases are then displayed based on the relative move of source and receivers during
the survey, from which you can choose the closest case to the input data. Each case is explained
clockwise from the top left case: "both (source and receivers) moved toward source", "only source
moved away from receivers", "source was located off the end of receiver array (RA)", "both moved
toward receivers", "only source moved toward receivers", and "source was located inside the receiver
array (RA)." Depending on the case you choose, the next step will be at the place where the receiver
spacing (dx) is to be entered, from which all remaining procedures will be identical (or similar) to the
one explained in the corresponding steps in the last two sections for 1-D and 2-D setup.

If you selected "Passive" as your survey type in the earlier dialog, the procedure is as follows.
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For Passive surveys the following dialog for 2-D receiver array (RA) setup will be displayed. (If the 1-D
linear RA was used during the passive survey, then you can choose the "Combined" survey type in the
previous dialog by inventing a fictitious source point, which does not affect the processing scheme at all).
Once you select a specific type of 2-D RA, then the next step will follow the corresponding procedure
outlined in the section "Setting Up a 2-D Receiver Array."

If you selected "Combined" as your survey type in the earlier dialog, the procedure is as follows.
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For Combined surveys the following dialog allows you to choose the type of receiver array (1-D or 2-D).
If the "1-D" case is chosen, then the remaining procedure will be identical to the case of "Active" survey
type, whereas the "2-D" case will be identical to the "Passive" case, with only a couple additional steps
such as specification of the source location, and the move of source and/or receiver array after
recording at each location.

2.3 Import a Previous Setting
This procedure enables you to import either the settings last used or those previously saved. After
completing the setup each time, two types of parameters will be saved in two separate files as shown in
the information dialog displayed after the main dialog below; one file (*.VA_) contains all the variables
set during the entire procedure [e.g., survey type, receiver spacing (dx), source offset (X1), etc.], and
another file (*.DB_) contains surface coordinate information (i.e., distance and station numbers) of
source and receivers associated with an individual file (record) number in the input data set.

9

PS - Source/Receiver (SR) Setup

Once you choose to "Import a Previous Setting" on the main menu, the following dialog will be displayed
asking you to choose what type(s) of saved data you want to import. The first option ("Last variables
used") will import only those variables last used; the second option ["Variables from a saved file
(*.VA_)"] will allow you to choose a saved file from which to import the variables. The third option
["Total configuration last used (active only)"] will import the complete surface coordinates of source and
receivers last used; the last option ["Total configuration from a saved file (active only)(*.DB_)"] will let
you choose a saved file for this purpose. Depending on which option you choose, the next step will be
different. The dialog and figure below are shown after the default option ("Last variables used") has
been chosen.
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3. Setup for a 1-D Vs Profile
(Working with Sample Data "Vs1DMASW.dat")
This sample data set simulates a set of data from an MASW survey to produce a 1-D shear-wave velocity
(Vs) profile commonly used to dictate depth variation of stiffness at a fairly confined area. Typical
application would be the MASW survey for geotechnical investigation of wind-turbine sites. The data
set is an output from a seismic modeling based on the reflectivity method that is also part of the PS
software (available under "Modeling" main menu). This data set consists of eight (8) field records of 24channel acquisition all bundled in one single file of PS-format, i.e., not in SEG-2 format. Two different
source orientations (i.e., forward and reverse shots) and four different source offsets (X1's) are used to
produce eight (8) unique records. This is a common practice to maximize the robustness of data analysis.
For example, use of different X1's minimizes any adverse influence from the near-field effects, whereas
acquiring data from both ends of the receiver array tends to average out any lateral variation in the
subsurface velocity model (e.g., dipping or uneven bedrock surface) so that the analysis can achieve the
highest resolution in vertical variation.
The source/receiver (SR) configuration chart displayed below (Figure 1) shows relative SR location for
each record. It shows the receiver array stayed at the same surface location for all eight (8) records,
with only the source moving to change offsets (X1's) and orientations. Forward shots refer to those
impacts made off the first channel, and reverse shots refer to those made off the last (24th) channel.
The table in Figure 2 summarizes locations of source and receivers for each record in the sample data
set. The entire procedure to encode the proper SR configuration with this sample data set is
demonstrated below. A yellow arrow
in the figure indicates a mouse click on the selected place, and
a red arrow
indicates places and items that need attention.
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Figure 2. Source and receiver (SR) configuration used to generate model data set "Vs1DMASW.dat."
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From main menu, "Setup Source/Receiver (SR)" → "From Formatted Seismic Data (*.dat)"

Open " Vs1DMASW.DAT."

If original field files of SEG-2 format are to be imported instead of a data set already in the PS format,
then choose "From SEG-2 Seismic Field Data" as shown below. In this case, import all multiple field files
("records") at the same time as illustrated below.
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3.1 Pre-Setup
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3.2 SR Specification
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Enter "0.0" for "Ref. Distance" and then "1.0" for next distance.
"Ref. Distance" is an arbitrary surface distance coordinate used as a reference point. Therefore, it can
be any number. But, the distance for the next channel should be offset (+ or -) by one receiver spacing
(dx). Enter "1001" and "1002" for the station numbers for the first two channel positions. Then, click
"Next" button. These are arbitrary "station" numbers that must be consecutive. The general
convention for station numbering is "1001, 1002, etc." for line 1, and "2001, 2002, etc." for line 2, and so
on. They can also decrease instead of increase.
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Review and click "Next" button.

3.3 Specification of Input Records and Running Setup
Make sure to specify begin and end record numbers correctly here. The previous specification of
moving 5 meters (5dx) is valid only for next record (2), and therefore the end record number should be
'2'. The other records will be handled separately (two records at a time) after completion of these two
records. Click "Run" to launch the SR setup process.

18

PS - Source/Receiver (SR) Setup
It will ask for output file name first. Default output file name is "Vs1DMASW(SR).DAT."

The source/receiver (SR) configuration chart will be displayed that shows the relative location of source
and receivers for the first two records (1 and 2). The configuration can also be displayed in "Stations" by
clicking the button on top menu. Close the chart.

It is now time to set up SR for next two records (3 and 4). The box shown below reminds you of this.
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3.4 Repeating Setup for Different Records
Select '3' and '4' for the begin and end records, respectively. Then, click 'Locations' button at the top.

20

PS - Source/Receiver (SR) Setup

21

PS - Source/Receiver (SR) Setup
Make sure you use the same convention previously used for distance and station numbering; x = 0.0 m
(station number = 1001) at 24th channel, and x = 1.0 m (station number = 1002) at 23rd channel, etc.
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It is now time to set up SR for next two records (5 and 6). The box shown below reminds you of this.

Select '5' and '6' for the begin and end records, respectively. Then, click 'Locations' button at the top.
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Now, make sure "Off the Last Channel" button is selected because the two records were acquired with
the source on the opposite side of receiver array (i.e., "reverse shots"). Click "Next" button.
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Make sure you use the same convention previously used for distance and station numbering; x = 0.0 m
(station number = 1001) at 24th channel, and x = 1.0 m (station number = 1002) at 23rd channel, etc.
Now, displayed configuration requires this information to be set for the first two channels (1st and 2nd).
Therefore, enter "23" ("1024") and "22" ("1023") for distance (station number) of the first two channels,
respectively.
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Make sure begin and end records are set to '5' and '6,' respectively. Then, click 'Run' button.

The source/receiver (SR) configuration chart will be displayed that shows relative location of source and
receivers for all records saved in the output file (1, 2, 3, 4, 5, and 6). Make sure the last two records (5
and 6) have source located at a negative distance because they are "reverse" shots. Close the chart.
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Now, it is time to set up SR for the last two records (7 and 8). The box shown below reminds you of this.
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Confirm source location and enter "12" for the source offset (X1). Click "Next" button.
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Make sure you use the same convention previously used for distance and station numbering; x = 23 m
(station number = 1024) at 24th channel, and x = 22 m (station number = 1023) at 23rd channel, etc.
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Make sure begin and end records are set to '7' and '8,' respectively. Then, click 'Run' button.

The source/receiver (SR) configuration chart will be displayed that shows relative location of source and
receivers for all the records saved in the output file (1 - 8). Close the chart.
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Now, SR setup is complete. Click "Next" button.

All variables (*.VA_) and configuration (*.DB_) information will be saved for future use.
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4. Setup for a 2-D Vs Cross Section
(Working with Sample Data "DippingBedrock.dat")
The sample data set for 2-D Vs cross section generation ("DippingBedrock.dat") is an output from a
seismic modeling using the reflectivity method that is also part of the PS (available under "Modeling"
main menu). It consists of twenty (20) field records of 24-channel acquisition all bundled in one single
file of PS-format, i.e., not in SEG-2 format. The source/receiver (SR) configuration chart displayed below
(Figure 1) shows relative SR location for each record included the sample data set within the surveyed
(i.e., modeled) surface distance. It shows the receiver spacing (dx) of 1.5-m was used with the source
offset (X1) of 9-m (6dx). It also shows the entire SR configuration moved by 9 meters (6dx) each time
after acquiring a record at one location. The entire procedure to encode the proper SR configuration
with this sample data set is demonstrated below. A yellow arrow
in the figure indicates a mouse
click on the selected place, and a red arrow
indicates places and items that need attention.

Figure 1. Velocity (Vs) model used produce the sample data set ("DippingBedrock.dat") and the
source/receiver (SR) configuration used during the modeling.
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From the main menu, "Setup Source/Receiver (SR)" → "From Formatted Seismic Data (*.dat)"

Open "DippingBedrock.DAT."

If original field files of SEG-2 format are to be imported instead of a data set already in the PS format,
then choose "From SEG-2 Seismic Field Data" as shown below. In this case, import all multiple field files
("records") at the same time as illustrated below.
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4.1 Pre-Setup
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4.2 SR Specification
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Enter "0.0" for "Ref. Distance" and then "1.5" for next distance.
"Ref. Distance" is an arbitrary surface distance coordinate used as a reference point. Therefore, it can
be any number. But, the distance for the next channel should be offset (+ or -) by one receiver spacing
(dx). Enter "1001" and "1002" for the station numbers for the first two channel positions. Then, click
"Next" button. These are arbitrary "station" numbers that must be consecutive. The general
convention for station numbering is "1001, 1002, etc." for line 1, and "2001, 2002, etc." for line 2, and so
on. They can also decrease instead of increase.
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4.3 Specification of Input Records and Running Setup
Click "Run" to launch the SR setup process. It will ask for the output file name first. Default output file
name is "DippingBedrock(SR).DAT."
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At the end of the process, the SR configuration chart will be displayed that shows relative locations of
source and receivers within the entire distance of survey. The configuration can also be displayed in
"Stations" by clicking the button on top menu. Close the chart.

Click "Exit" button. It will show the file name where all the setup parameters will be saved so that you
can import them by opening the file at the beginning of the next SR setup process.

All variables (*.VA_) and configuration (*.DB_) information will be saved for future use.
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5. Setup for a Passive Survey

5.1 Passive Survey with 1-D Receiver Array (RA)
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If the receiver array moved regularly like an active survey, then you can treat the input as a data set
from a "combined" survey that will make the entire setup procedure more intuitive. Otherwise, you can
proceed with the current "passive survey" option.
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5.1.1 Specification of Surface Location
Record numbers are associated with surface distance and station numbers as shown below. If more
than one record was acquired at a given location, then it can be specified so in the "Records/Location"
edit box. The "Use Below" buttons under "Distance" and "Station #" will enable the automatic listing of
values in the corresponding combo boxes by calculating distances and station numbers based on the
values specified in the "Begin" and "Interval" edit boxes. The "Link distance with receiver station
number" check box will force (if checked) the station numbers to change by the distance interval. The
dialog with all three combo boxes expanded shows item values set by clicking the "Use Below" buttons.
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5.1.2 Run and Check
Click "Run" and output will be saved as a single file of PS-format [*(SR).dat].

The saved file can be opened for display by going to "Display" → "Seismic Data"

Once the file is displayed, its encoded SR setup can be displayed by clicking "SR setup" button.
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SR Setup Chart

Configuration of the receiver array (RA) can also be displayed by clicking "Receiver Array" button.

Receiver Array (RA) Chart
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5.2 Passive Survey with 2-D Receiver Array (RA)

5.2.1 Setting Up 2-D Receiver Arrays (RA's)
(Circle, Cross, L-Shape, and Random Arrays)
Example of Circular RA
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Example of Cross RA
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Example of L-shaped RA
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Example of Random RA
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5.2.2 Specification of Surface Location
Record numbers are associated with surface distance and station numbers as shown below. If more
than one record was acquired at a given location, then it can be specified so in the "Records/Location"
edit box. The "Use Below" buttons under "Distance" and "Station #" will enable the automatic listing of
values in the corresponding combo boxes by calculating distances and station numbers based on the
values specified in the "Begin" and "Interval" edit boxes. The "Link distance with receiver station
number" check box will force (if checked) the station numbers to change by the distance interval. The
dialog with all three combo boxes expanded shows item values set by clicking the "Use Below" buttons.
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5.2.3 Run and Check
Illustrated below is for the case of "Circular" receiver array (RA)

The saved file can be opened for display by going to "Display" → "Seismic Data"

Once the file is displayed, its encoded SR setup can be displayed by clicking the "SR setup" button.
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SR Setup Chart

Configuration of the receiver array (RA) can also be displayed by clicking the "Receiver Array" button.

Receiver Array (RA) Chart
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6. Setup for (Active/Passive) Combined Survey

6.1 Combined Survey with 1-D Receiver Array (RA)

This case will be identical to the active survey with 1-D RA described in sections 3 and 4.
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6.2 Combined Survey with 2-D Receiver Array (RA)

Receiver array (RA) types will be identical to those described in section 5.2 ["Passive Survey with 2-D
Receiver Array (RA)"] and the remaining procedure will be identical to that described in the same
section. The only difference is specification of the source location in the array chart as illustrated below.
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Select (depress) the "source edit" button in the tool panel so you can click and drag the source to a
proper location.

First, it may be necessary to have a larger scale for the chart display. To change the scale of the chart
display, select the "Chart" tab and click the "Controls" button in the tool panel of the chart form. Then,
select one of the sample scale presets.
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After setting the source at the proper location, click "Exit" to return to the setup dialog.

From here the remaining procedure is identical to that of the "Passive Survey with 2-D Receiver Array
(RA)" described in sections 5.2.2 and 5.2.3.
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(Using Text-File Commands)
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Source/Receiver (SR) Setup By Importing a Text File (*.TXT)
When clicking the 'Import a Setting' option in the front page of the SR setup dialog shown below left,
another dialog pops up (below right). On top of this dialog, there is now a new option added that
enables user to import a text file previously prepared. The other four (4) options listed in the box are
explained in section 2.3 of the user guide "Setup Source/Receiver (SR)." This new option can be used
only for surveys using the linear receiver array. It is, however, not limited by survey type, which can be
one of the following three types; active, passive, and active-passive combined surveys.

This new option applies the SR setup to the input seismic data according to the scheme specified in the
imported text file where the configuration of source and receivers (SR) is listed according to the format
described below. The format consists of several fields characterized by unique keywords with each field
separated by a comma (','). Each keyword is then accompanied with one or two numerical values as
explained below by using three different examples.

Example 1
(Specification with Both Distance and Station Number)
Following is an example text file created by using Windows Notepad that has only one line of SR
specification and other supplementary specifications of distance unit and survey type, both of which are
optional:
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RECORD is the keyword to specify a record number (1). It should be always accompanied with one
record number.
SOURCE is the keyword to specify location of the source for this particular record number. It should be
accompanied with, at least, one number that represents the surface distance (-12.0) in meters or
feet. (The distance unit specificationfor example, meters or feetis made by a separate line as
described below). It can also be accompanied with a second number (994) that represents the
station number corresponding to the source location (-12.0). It should be noted that station
numbers are always consecutive between the two adjacent receiver locations. Although one
receiver spacing can be a number of any value (e.g., 2.0), the corresponding station interval is
always one unit (1).
CH is the keyword to specify a channel number and corresponding location. CH1 represents the channel
#1, while CH24 represent the channel #24. There is no space between the 'CH' and the channel
number. This channel-number keyword is accompanied with, at least, one number that represents
the surface distance (e.g., 0.0), which can optionally be followed by a second number that
represents the corresponding station number(e.g., 1000). There should be, at least, two fields of
channel specification separated by comma (,) between them. The specifications for the in-between
channels will then be linearly interpolated based on these two bounding specifications. The channel
specifications in the above example indicate that each channel's surface location increases by 2.0 m
in distance (i.e., a 2.0-m receiver spacing), while it increases by 1 in station number toward
increasing channel numbers.
UNIT is the keyword to specify distance unit either in meters (METER or meter) or in feet (FEET or feet).
This specification is optional and, if this line is missing, the default unit is the same as the unit
specified in the input seismic data. If this information is missing in the seismic data, then the default
unit is FEET.
SURVEY is the keyword to specify the type of MASW survey among the three available ones; active (ACT
or ACTIVE), passive (PAS or PASSIVE), and active-passive combined (COM or COMBINED) survey
types. If this keyword is missing, the default survey type is ACTIVE. Both active and combined
surveys require the 'SOURCE' specification included in each SR line after the 'RECORD' specification
as illustrated in the above example, while the passive survey should not include the 'SOURCE'
specification.
Any line that starts with two slashes ('//') indicates a comment line, and is ignored during the import.
The source/receiver (SR) configuration constructed by the above example file is graphically displayed
below with a surface coordinate of distance (left) and station number (right), respectively.
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Example 2
(Specification with Distance Only)
Following is another example of text file that has multiple lines of SR specification with two bounding
record numbers (1 and 24). The SR configurations for those records in-between these two numbers are
linearly interpolated in surface coordinates for both source and receivers. In addition, only distances are
specified for both source and receivers without station numbers. In this case, the program will assign
station numbers automatically with a convention of '1000' for zero ('0') distance. The resultant SR
configuration for all 24 records in an input seismic data is displayed below with distance (left) and
station (right) surface coordinates used, respectively.

Example 3
(Specification for Passive Survey)
Following is another example that is identical to the previous case of active survey (i.e., Example 2), but
without 'SOURCE' specifications because survey type is specified as 'PASSIVE' in the last line. The
resultant SR configuration is displayed below with distance (left) and station (right) surface coordinates
used, respectively. It shows locations of the receivers only.
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PS - Dispersion Image Generation

1. Overview
This module generates dispersion image data [*(*OT).dat] from raw field records of either SEG-2 format
(e.g., *.dat) or PS format that has source/receiver (SR) configuration encoded [*(SR).dat]. The image
data set will also have the same PS format adopted for all types of seismic data saved by the PS program.
The specific type of data (e.g., seismic or dispersion image) will be detected by the software based on
specific codes embedded in the data headers. The image data set is generated by two-dimensional (2-D)
wavefield transformation methods applied to the field data that must have correct information about
source-receiver distance for each channel's data (trace). The program will detect this at the beginning
and will not proceed if proper information is not detected.
The wavefield transformation method of Park et al. (1998) is the fundamental algorithm used. Significant improvements have been made since this algorithm was first published. These improvements
allow this method to produce more accurate images even with relative low signal-to-noise ratio (SN) in
the input data. Improvements by Park (2011) provided an option that can selectively apply the
transformation to relevant offset ranges for different wavelengths so that the high-frequency portion of
the dispersion can be more clearly imaged. In addition, many other factors have been discovered
through extensive study that can contribute positively to a "better-quality" dispersion image if properly
controlled. These additional factors have been included as controllable parameters at the appropriate
places in the dialog.
The imaging method for passive data originally started with the method by Park et al. (2004) that later
turned out to be quite analogous to the spectral auto-correlation (SPAC) method by Aki (1957), only
expressed in a different mathematical formulation with a few extra variables. This method then evolved
to Park and Miller (2008) to handle traffic-generated passive surface waves more effectively. This
further evolved into the method by Park (2008) that utilized the conventional active scheme by
accurately detecting the incoming angle (azimuth) of those passive surface waves of major contribution.
The most recent method by Park (2010) further elaborated this approach by accounting for possible
changes in azimuth during the long recording time (i.e., dynamic detection of azimuth). Although this
dynamic method is the most recent method that can account for many complications, it is by no means
absolutely superior to its predecessors without any exceptions. In fact, depending on the specific
situation, one of the old methods might provide more accurate results by addressing some particular
characteristics better than any other method could. Therefore, all these methods are included in the
dialog as selectable options. The program, however, will choose as the default what it determines to be
the optimal method by examining a few key features of the input data, such as type of receiver array
used (e.g., 1-D or 2-D), recording time, etc.
The imaging method for data sets from the active/passive combined survey will be an exact combination
of both active and passive schemes. The early portion of the input data (e.g., ≤ 2 seconds) will be
treated as active data, while the remaining portion will be treated as passive data.
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2. Importing Input Data
To import field files (records) of SEG-2 format, go to "Dispersion" → "Make Dispersion Image From
SEG-2 Data" in main menu. Then, select all the files at the same time. If input records require a new
source/receiver (SR) configuration setup, then the program will launch the SR setup first. See PS User
Guide "Source/Receiver (SR) Setup" for more information about encoding the SR setup.

To import a data set of field records already in PS format with a proper source/receiver (SR) configuration encoded, go to "Dispersion" → "Make Dispersion Image From S/R Coded Data" and then select one
file.
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3. Main Dialog
After importing input data, the following main dialog will appear. Click "Run Dispersion Image" to
launch the process with default processing parameters (which are automatically chosen by the program
after examination of key characteristics of input data such as spectral contents, phase velocity ranges
detected, receiver spacing, source offset, number of channels, etc.). Click the "Options..." button to
have access to all such parameters.

Control parameters are grouped into four (4) categories: "Frequency/Velocity", "Active MASW", "Passive
MASW", and "Full List."
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4. Frequency/Velocity

Ranges in frequency (f) and phase velocity (Vphs) are specified here that are used during the 2-D (f-Vphs)
wavefield transformation. MIN and MAX values of frequency (f) and phase velocity (Vphs) will
determine the size of the dispersion image by setting corresponding values for horizontal (f) and vertical
(Vphs) axes of the image space. The "Restore" button will restore values for all the parameters last used.
Clicking "Open" will allow import of a set of previously saved parameters or clicking "Save" will save a
current set of parameters as a file (*.VA_).
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5. Active MASW

5.1 Offsets
If the "Process SODI" box is checked, offset-selective (instead of "full-offset") processing will be applied
in which the processing offset range changes with wavelengths (see Park, 2011). The degree (%) that
can be adjusted by the sliding bar on the right controls the extent of the selectiveness; the greater the
percent, the more aggressive. Minimum and maximum (MIN and MAX) offset in the lower box will set
the offset range manually in either percent of wavelength (%) or source distance (that will be common
for all wavelengths).
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5.2 Contrast
This controls the relative "brightness" in a dispersion image that can make patterns of certain weak
energy more ("Lower" contrast) or less ("Higher" contrast) pronounced. This is sometimes useful to
subdue higher modes patterns and emphasize patterns of the fundamental mode.

5.3 Algorithm
The "Normal" algorithm will use only the relative arrival time (i.e. phase) difference between different
channels during the image construction, whereas the "Advanced" option will attempt to account for the
absolute arrival times (phases) of surface waves for different frequencies. The former algorithm will
suppress computational artifacts (e.g., side lobes), whereas the latter will increase the resolution of
dispersion patterns.
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6. Full List

6.1 Attributes
The "White Balance (%)" will add, if a non-zero value is chosen, an infinitesimal amount of random noise
during the wavefield transformation (FFT) to suppress most of computational artifacts (e.g., linear
streaks). However, it will mask useful dispersion patterns of weak energy (if they exist) especially at the
lowest frequency end of the image. If the box is checked, the "Spectrum bounds" will set the processing
frequency range only within the detected range of significant energy (e.g., ~90%). The "BB ratio (%)"
controls the width of broad band (BB) used during the wavefield calculation for each wavelength. A
non-zero value will lead to a summation of wavefields at ambient frequencies. If the box is checked, the
"Normalize FFT" applies the normalization of individual frequency component after the Fast Fourier
Transformation (FFT) has been applied to the input seismic data. If a non-zero value is chosen, the
"Complex taper (%)" applies tapering at both spatial edges (i.e., sides) of the input seismic record after
FFT. This can sometimes lead to the reduction of computational artifacts in the image depending on the
energy distribution in the input seismic data.
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If the box is checked, the "Geophone Filter" mutes all amplitudes in the image space that exist at
frequencies lower than the value specified in the "Geophone (Hz)" box on the left. If a non-zero value is
chosen, the "Cut streaks (%)" will apply the muting for the zone influenced by the spatial aliasing effects.
A greater value will apply more aggressive muting. If the box is checked, the "Filter Higher Velocity" will
apply frequency-wave number (f-k) filtering to the input seismic data to remove all linear events faster
than the highest phase velocity specified in the "Frequency/Velocity" tab. If checked, the "Oversample
Offset" will apply the spatial interpolation to the input seismic data to help reduce the harmful influence
of the spatial aliasing effects. This can also make the high phase-velocity dispersion patterns smear
depending on the highest phase velocity specified in the tab.

6.2 Others
The "Processing range" specifies the input records that are used to generate dispersion images. The
"Stack same mid-station OT's" will stack (if checked) all dispersion images of the same surface location
(mid-station) and then save the stacked image as output. If checked, the "Append output" will add
generated dispersion image data at the end of the existing file of the same type.
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7. Passive MASW
The "Passive MASW" button is enabled only when input data is from either a passive or an
(active/passive) combined survey.

7.1 Azimuth
The "Search quadrants" indicates those quadrants of azimuth within which incoming surface waves will
be searched. When a 1-D receiver array (RA) was used during the survey, then the survey line's
orientation is assumed to be in the E-W direction and only two consecutive quadrants (either SW - SE or
NW - NE) are selected by the program. For 2-D RA, all four (4) quadrants are selected. The "Angle
increment (degrees)" sets the interval of azimuth in degrees during the searching process. The "Save
azimuth record(s)" will, if checked, save separate record(s) of detected azimuth-energy distribution for
each input seismic record that will show relative distribution of surface wave energy for different
azimuths and also for different frequencies. If a non-zero value is chosen, the "Offline distance* (m):"
value will account for the offline effect of surface waves by considering a cylindrical (instead of planar)
propagation of surface waves; but only inline (plane wave) propagation will be considered if a zero value
is entered. See Park and Miller (2008) for more details about the algorithm. For inline propagation,
both directions (forward and reverse) are considered by default as possible incoming directions of
surface waves.
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7.2 Process Scheme
Each scheme is briefly described in the Overview of this guide, and fully described in the following
publications:





DAD ─
PWA ─
PRM ─
DRD ─

Park (2010)
Park (2008)
Park et al. (2004)
Park (2010); Park and Miller (2008)

If a 1-D receiver array (RA) was used, the DRD will be the default option. The DAD will be the default if a
2-D RA was used.
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7.3 Dynamic Azimuth Detection (DAD)
This section contains all the parameters related to the DAD scheme by Park (2010). The "Azimuth
scanning" tab holds parameters for start, end, and interval of the three variables used during the
detection (scanning) of surface waves—frequency, phase velocity, and azimuth. The "BB Ratio" will
apply, if a non-zero value is chosen, the broad band (BB) summation of ambient frequencies during the
scanning. If checked, the "Ignore previous process" will ignore all previous intermediate results that are
automatically saved during the entire DAD process (e.g., azimuth-energy distribution records, sourcedistance distribution records, etc.). Therefore, each DAD process will be a "fresh" start if this option is
checked. The "Process using DAD" will apply, if checked, the actual DAD algorithm and, otherwise, all
parameters in DAD tab will not be used. This option will be checked by default only when a 2-D receiver
array (RA) was used during the survey. If a 1-D RA was used, then the dynamic inline detection (instead
of dynamic azimuth detection) will be applied to detect the orientation of incoming surface waves (i.e.,
forward or reverse).

The "Trial distance option" determines whether a dynamically changing interval of distance (i.e., a
smaller interval near the survey location) is used or a constant interval is used during the source point
detection. Usually, this option makes little difference in result.
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The "Length of subrecord (ms)" determines the time length (ms) of individual subrecords created by
dividing the long input record. The default value is determined based on the total recording time of the
input record. The "Overlapping window on top and bottom (ms)" is the time length (ms) at the
beginning and ending parts of one subrecord that overlaps with corresponding parts of the previous and
next subrecords, respectively. The "Min. S/N to accept subrecord (%)" sets the minimum signal-to-noise
ratio (S/N) of the detected (strongest) surface wave event in one subrecord to be used to construct the
dispersion image. If the detected S/N is lower, then the particular subrecord is ignored during image
construction.

If checked, the "Active/Passive Combined Survey" option will enable the manual specification of source
orientation and distance for the active portion of the record (e.g., 0-2 sec portion). Assuming the
channel number increases from left to right, depressing the left arrow indicates the forward orientation
of source. If input seismic file has been properly coded for the survey type ("Combined Survey") during
the source/receiver (SR) setup procedure, then the correct information about source encoded in the
data will be used regardless of the information provided in this tab.
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Dispersion Curve Extraction (1-D Profile)

1. Overview
This step extracts and saves the fundamental-mode (M0) dispersion curve from the dispersion image
previously generated and saved. (See PS User Guide "Dispersion Image Generation" for description of
this part of the analysis) To import a dispersion image file [*(ActiveOT).dat], go to "Dispersion" in the
main menu, and then select "Get Dispersion Curve(s) From Image Data [*(*OT).dat] as shown below.

Although there may be multiple [for example, eight (8)] dispersion images generated, usually they all
originated from the receiver array that stayed at the same surface location. Therefore at the beginning
of this step, the program will ask to stack all of them to make one stacked image. Click "Yes" and specify
output file name for the stacked image [*(ActiveOT)(VStack).dat]. Another dialog will ask how you want
to handle the surface coordinate information of the stacked image such as source offset and locations.
Click "Yes" to properly update them (i.e., average them).
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A chart showing the stacked dispersion image will be displayed with "Dispersion Analysis" tab selected in
the top tool panel. (This tab will not be available when this chart is used just for display purposes.)
There are five (5) buttons in the tab arranged in the order of common use. Before proceeding to extract
the fundamental-mode (M0) dispersion curve, it will be necessary to first make a proper interpretation
of the displayed image. To do that, it will be useful to draw grid lines on the image. Select the "Scale"
tab on the top tool panel and then depress the "Grids" button. The image shows a coherent dispersion
trend starting at about 15 Hz (almost appearing as a vertical streak) that rapidly becomes an asymptotic
trend at frequencies higher than about 30 Hz. The vertical streak near the vertical axis is a
computational artifact generated from the 2-D wavefield transformation that may or may not become
significant depending on the spectral characteristics of surface waves as well as acquisition geometries.
There is another weak asymptotic trend occurring at frequencies higher than about 120 Hz with a phase
velocity nearing 1000 m/sec. This type of pseudo-asymptotic trend occurring at relatively high
frequencies (e.g., > 100 Hz) is usually associated with shear-wave refraction from the bedrock surface.
The theory indicates the upper bound of this trend (~1000 m/sec) can be used as an approximation of
the bedrock Vs. Then, it sets the upper bounds in picking the M0 curve along the vertical trend near
15 Hz. Considering the theoretical relationship that phase velocity (Vphs) of surface waves is slightly less
than Vs (e.g., Vphs ≈ 0.93Vs), the highest Vphs in the picked M0 curve should not exceed ~9300 m/sec.
Then, choose "Dispersion Analysis" tab to come back to the process mode.
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2. Bounds
This step is to set lower and upper bounds for a dispersion pattern which is identified as the
fundamental-mode (M0) dispersion. The program will then seek the M0 curve by examining all
amplitudes of the image data within the bounds.
Depress the "Bounds" button and then click along the M0 trend to add reference points ("circles") with
lower and upper bounds ("asterisks").

<Deleting Reference Points>
Drag and draw a zone to delete multiple points as illustrated below.
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Or, click individual points to delete one by one as illustrated below.

<Adding Reference Points>
Reference points can be added anytime while the "Bounds" button is depressed by clicking any place on
the image as illustrated below.

<Moving Reference and Bounds Points>
Reference points can be moved freely (up and down, left and right), whereas bounds points can be
moved up and down only at the fixed horizontal location of the corresponding reference point.
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3. Controls
This dialog contains those parameters that can influence the effectiveness of the curve (M0) extraction.
Click the "Controls" button to show the dialog box of control parameters. Default values are usually
sufficient.

4. Extract
This will actually extract the curve (M0) that is ready for manual edit (for example, moving, deleting, and
adding data points). Click the "Extract" button to show the extracted curve on top of the image.
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<Editing Extracted Curve ─ Deleting Points>
Drag and draw a zone to delete multiple points, or click individual points to delete one by one as
illustrated below.

<Editing Extracted Curve ─ Adding Points>
Click anyplace on the M0 trend to add points one by one as illustrated below. Corresponding points for
SN will also be added by detecting the energy at the clicked points.

<Moving Data Points>
Data points in the extracted curve can be moved freely (up and down, left and right) as illustrated below.
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5. Save
Click the "Save" button to save the extracted curve (*.DC). The default file name will have the record
number attached at the end of the output file name [e.g., *(1).DC]. Specification of output file name will
be necessary only the first time, and the subsequent curves being saved (if there are more) will have the
same file name. To change this name, right-click the "Save" button at any time.

Then, the program will ask you to proceed to the last step ("Step 4"). The previously saved M0 curve
(*.DC) will be automatically transferred.

If you need to manually import this dispersion curve, you can do so by going to "Inversion" in the main
menu and then selecting "Make 1D Vs Profile from Dispersion Curve (*.dc)" as shown below.
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6. Inversion
Click the "Inversion" button at any time to move on to inversion of the extracted M0 curve(s). See PS
User Guide "Inversion (1-D Profile)" for description of this part of the analysis.
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PS - Dispersion Curve Extraction (2-D Cross Section)

1. Overview
This step extracts and saves the fundamental-mode (M0) dispersion curves from the dispersion image
previously generated and saved. (See PS User Guide "Dispersion Image Generation" for description of
this part of the analysis) To import a dispersion image file [*(ActiveOT).dat], go to "Dispersion" in the
main menu, and then select "Get Dispersion Curve(s) From Image Data [*(*OT).dat] as shown below.

A chart showing the first dispersion image in the input file will be displayed with "Dispersion Analysis"
tab chosen in the top tool panel. (This tab will not be available when this chart is used just for display.)
There are five (5) buttons in the tab arranged in the order of common use. Before proceeding to extract
dispersion curves, it will be necessary to first go through constituent dispersion images, at least for
several places along the survey line like at the beginning, in the middle and at the end. This is important
to properly interpret the image for the correct trend of the fundamental-mode (M0) dispersion,
especially when there are strong and complicated image patterns created from higher modes.
To view dispersion images at different locations, choose the "Multi-OT" tab on the top tool panel.
Buttons will then be available that will allow you to navigate through the different images.

Dispersion images at three different locations are displayed below. Images in the middle and at the end
of the survey line show a "typical" dispersion trend—that is, a "single coherent" trend—in which phase
velocity increases at low frequencies and decreases at the higher frequencies approaching an asymptotic constant value at about 200 m/sec, which indicates the velocity (Vs) of overburden (Vs1) is in that
range (i.e., Vs1≈200 m/sec). This "asymptotic frequency" becomes lower at the end of the survey, indicating the depth of the overburden/bedrock interface is deeper. Other energy trends occurring at the
higher frequencies and phase velocities are those of higher modes (e.g., M1, M2, etc.) and aliased M0.
On the other hand, the image at the beginning shows a somewhat complicated pattern with two
separate strong energy trends, both of which appear to be aligned along a constant phase velocity of
about 1000 m/sec. This is a typical image pattern when the overburden thickness (H) is too "thin"; for
example, less than a few receiver spacings (e.g., 1-3dx). In this case, those strong energy trends usually
2
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tend to align (horizontally) at a constant value that corresponds to the phase velocity of bedrock (Vphs),
which is in theory about 95% of shear-wave velocity (Vs) (i.e., Vphs≈0.95Vs). The weak energy trend of
decreasing phase velocity occurring at frequencies higher than about 100 Hz appears to be part of the
M0 trend that will eventually approach the asymptotic phase velocity at the highest frequency ever
imaged. This indicates that the strong energy trend occurring at the lower frequencies can be part of
the M0 trend.
Sometimes, this "horizontal" alignment of higher-mode energy is observed also at the place where the
overburden thickness becomes somewhat significant. In this case, it is usually less conspicuous because
of the weaker and fragmented energy patterns that are observed in the other two images at frequencies
around and higher than 150 Hz.
From the previous interpretations made by inspecting multiple dispersion images, we can conclude that
velocities of overburden (Vs1) and bedrock (Vs2) will be around 200 m/sec and 1000 m/sec, respectively,
and the depth to the bedrock increases toward the end of the survey line.
At the beginning
(Record # 1)

In the middle
(Record # 10)

M1? or Higher Modes (HM's)

Aliased M0
HM's

M0

M0

At the end
(Record # 20)

M0

The following image shows a summary of interpretations. Click the "Dispersion Analysis" tab to come
back to the process mode.
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2. Bounds
This step sets lower and upper bounds for a dispersion pattern that is identified as the fundamentalmode (M0) dispersion. The program will then seek the M0 curve by examining all amplitudes of the
image data within the bounds. Depress the "Bounds" button and then click along the M0 trend to add
reference points ("circles") with lower and upper bounds ("asterisks").

<Moving Reference and Bounds Points>
Reference points can be moved freely (up and down, left and right), whereas bounds points can be
moved only up and down at the fixed horizontal location of the corresponding reference point.
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<Deleting Reference Points>
Drag and draw a zone to delete multiple points, or click individual points to delete one by one.
Corresponding bounds points will also be deleted.
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<Example After Deleting According To the Actions Indicated Above>

<Finishing Up Reference Points and Bounds Points Properly Around M0 Trend>
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3. Controls
This dialog contains those parameters that can influence the effectiveness of the curve (M0) extraction.
Click the "Controls" button to show the dialog of control parameters. Default values are usually
sufficient.

4. Extract
Click the "Extract" button to show the extracted curve on top of the image.

signal-to-noise
ratio (SN) curve

dispersion curve
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<Editing Extracted Curve ─ Deleting Points>
Drag and draw a zone to delete multiple points. Or, click individual points to delete one by one.

deleting
multiple points

deleting one point

<Editing Extracted Curve ─ Adding Points>
Click anyplace on the M0 trend to add points one by one. Corresponding points for SN will also be
added by detecting the energy at the clicked points.
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5. Save
Click the "Save" button to save an extracted curve (*.DC). The default file name will have a record
number attached at the end of the common file name. Specification of output file name will be
necessary only the first time, and subsequent curves being saved will have the same file name. To
change this name, right-click the "Save" button at any time.

This will complete the process for "one" record, and the program will move to the next image automatically. From there on, the same process sequence can be applied to save subsequent dispersion
curve files. The only adjustment to be made will be the accommodation of bounds so that they
encompass the correct M0 trend that may change from one image to another.
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<Moving To Next Record and Adjusting Bounds>
Adjust both reference and bounds points properly to account for M0 trend change.

<Editing Extracted M0 Curve>
Editing curve by deleting some points.
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<Changing Bounds by Depressing the "Bounds" Button Whenever Necessary>
The first and last reference points especially may have to be adjusted to account for changes in the M0
trend. As depth to bedrock increases, the first and last reference points will have to be gradually moved
toward lower frequencies.

You can always go back to previous images by using the navigation buttons in the "Multi-OT" tab and
then perform the extraction and saving process again to replace previously saved curves. At the end of
the process after saving all extracted M0 curves, it will ask you to proceed to the last step ("Step 4"). All
previously saved M0 curves (*.DC) will be automatically transferred at this stage.

In case you need to manually import these files, you can do so by going to "Inversion" in the main menu
and then selecting "Make 2D Vs Cross Section From Dispersion Curves (*.dc)" as shown below. You will
then have to select all these files at the same time (e.g., "*(1).DC", "*(2).DC", "*(3).DC", etc.).

A complete set of extracted dispersion curves and corresponding images are displayed at the end in the
section <Sample Example of Extracted Dispersion Curves>.
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6. Inversion
Click the "Inversion" button at any time to move on to the inversion of the extracted M0 curve(s).
Detailed description about the inversion process is provided in the PS User Guide "Inversion (2-D Cross
Section)."

12

ParkSEIS User Manual

7.2.1

Inversion for 1-D Profile

ParkSEIS

MASW

PS - Inversion of Dispersion Curve

Table of Contents
Page

1.

Overview

2

2.

Importing Input Data

3

3.

Main Dialog

3

4.

Inversion Controls

5

4.1 Input Files

5

4.2 Inversion Parameters

6

4.2.1 Search

6

4.2.2 Layer (Earth) Model

7

4.2.3 Secondary Outputs

10

4.3 Output Files (1-D Vs)

11

5.

Layer Model

12

6.

Approx. Inversion

12

7.

Run (1-D Vs Profile)

13

7.1 Automatic Inversion

13

7.2 Optional Manual Inversion

15

1

PS - Inversion of Dispersion Curve

1. Overview
This module generates a shear-wave velocity (Vs) profile (1-D or 2-D) from input dispersion curve(s). It
will be a 1-D (depth) profile if only one dispersion-curve file (*.DC) is imported, whereas a 2-D (depth
and surface distance) Vs cross section will be produced if multiple files are imported. Each dispersion
curve will be analyzed (i.e., inverted) to find a 1-D Vs profile whose "theoretical" (or "modeled")
fundamental-mode (M0) dispersion curve fits the input "measured" curve most closely through a
generic searching algorithm. In this sense, all input dispersion curves to produce the 2-D Vs cross
section are inverted "almost" independently to produce individual 1-D Vs profiles that will then be used
to construct the final Vs cross section through an appropriate spatial interpolation scheme (e.g., bilinear
scheme). The reason we say "almost" is due to a slight interaction between adjacent dispersion curves
during the initial velocity (Vs) model creation that is executed at the beginning of the inversion process.
This interaction occurs if the option "Detect Bedrock" is selected (default) that will first analyze all input
dispersion curves only to find the simplest velocity model consisting of overburden/bedrock (i.e., 2-layer
model). Then, based on this 2-D velocity model, preliminary bedrock topography is constructed with a
proper lateral continuity applied, and the corresponding velocities are assigned for the overburden and
bedrock. This 2-D information will then serve as a global initial model to which, at the beginning of the
searching process, the inversion of each dispersion curve will refer at the corresponding surface location
for the starting (initial) (1-D) velocity model.
The searching algorithm is based on the sensitivity matrix (called a "Jacobian" matrix) that depicts the
relative change in phase velocity of the theoretical (modeled) dispersion curve for a unit change in
velocity of a particular layer in the model. Although this fundamental philosophy seems straightforward,
there are a significant number of empirical parameters introduced in the algorithm that are necessary to
make the searching process more accurate, stable, and faster. Some of these parameters are included
in the "Options..." section in the main dialog so that they can be adjusted whenever necessary.
Otherwise, the program will automatically assign the most optimum values based on the examination
results of input dispersion curve(s) in some key acquisition and processing attributes such as offset
range used during data acquisition, frequency (wavelength) range in measured dispersion curve(s), etc.
P-wave velocity (Vp) of each layer is determined by the Poisson's ratio (POS) during the inversion
process. The POS is dynamically assigned based on the searched value of Vs; for example, POS = 0.45 for
Vs = 150 m/sec, and POS = 0.33 for Vs = 1500 m/sec. Although the influence of POS is usually minimal,
this dynamic estimation of POS has been proven more effective through extensive modeling
experiments. The default value of density is 2.0 gram/cc for all layers.
Demonstration of the complete procedure by using a sample data set is provided in the PS User Guide
"Generating 1-D Profile (Working with Sample Data)."
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2. Importing Input Data
To generate a 1-D (depth) shear-wave velocity (Vs) profile, go to "Inversion" → "Make 1D Vs Profile from
Dispersion Curve" and select one dispersion-curve file (*.DC).

3. Main Dialog
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4. Inversion Controls

4.1 Input Files
In the "Dispersion Curves and S/N" tab, all input dispersion curves are displayed in a chart to allow for
visual inspection. A specific curve can be marked by selecting the corresponding item in the file name
list box. Any curve can be "unchecked" to be excluded from the inversion analysis.

5

PS - Inversion of Dispersion Curve
In the "Frequency Range" tab, the frequency of input dispersion curves used for inversion can be
redefined (if necessary) to a narrower range by entering (non-zero) values in the "MIN" and "MAX"
boxes.

4.2 Inversion Parameters

4.2.1 Search
Search Integrity (Number of Iteration): This specifies the total number of searching processes, each of
which will use the output from the previous search as the initial (starting) model.
Number of Testing Phase Velocity for Each Iteration: This is related to the total number of examining
velocities (Vs's) at a certain stage of the searching process. This is directly related to the resolution
in testing velocities.
Min. Match To Stop (%) (0=open): This criterion will stop the searching process if met before the
number of iterations is reached.
Depth/Wavelength ratio for initial model: This is the ratio used during initial velocity model creation.
6
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Account for phase-velocity bounds on detecting interface: If checked, this will account for the
minimum and maximum phase velocities in the input dispersion curve to estimate initial velocities
of overburden and bedrock during the "Detect Bedrock" process (if this option is also checked).
Account for mode jump in inverse dispersion: If checked, this will generate apparent dispersion curves
instead of the fundamental-mode (M0) curves by accounting for the mode jump during the
theoretical dispersion curve generation. This can significantly prolong the process time.

4.2.2 Layer (Earth) Model
Number of Layer: Total number of layers (including the last half space) used in the velocity model.
Max. depth (Zmax)*: Depth to top of the deepest (last) layer (i.e., half space) in the velocity model.
Zmax Bound*: A non-zero value will limit Zmax smaller than this value. This option will be active only
when the "Variable max. depths" has been checked.
Variable max. depths: If checked, Zmax will become another searching variable during the inversion.
The initial velocity model will be scaled according to the new examining Zmax for each inversion for
a given maximum depth (Zmax). The "Depths Model" tab on the right side will be enabled only
when this option is checked.
No. of different depths: Total number of different Zmax that will be examined at each iteration.
Min. depth (%): Minimum Zmax considered as percent of the specified maximum depth (Zmax).
Max. depth (%): Maximum Zmax considered as percent of the specified maximum depth (Zmax).
Only to Initial Model: The "Variable max. depths" will be applied only during the initial model creation.
*A zero value (0) indicates an optimum value will be determined by the program.
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Detect Bedrock: If checked, the initial model creation will search for the simplest velocity model of
overburden/bedrock first. Then, the actual multi-layered (e.g., 10-layer) initial model will be created
based on results from this process.
Detect intensity (%): This determines the number of different depths that will be searched; the higher
this number, the more depths that will be examined.
Min. Depth (Zmin)*: Minimum Zmax to be examined.
Max. Depth (Zmax)*: Maximum Zmax to be examined.
Lateral continuity (0-10): If a non-zero value is entered, this will apply the lateral averaging (smoothing)
of the created 2-D overburden/bedrock model in velocity and bedrock topography.
*A zero value (0) indicates the optimum value will be determined by the program.

If the "Specify Layer Model" button is clicked, then the following table will be displayed showing
numerical values of all parameters in the velocity (or "layered-earth") model. Individual values can be
viewed and manually edited. (Note Q values, Qs and Qp, are not used during the inversion.) If this
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display is closed by clicking the "OK" button, then this layer model will become the initial velocity model
common to all input dispersion curves.

Then, the following two options will be available. The "Use specified layer for initial model" will use, if
checked, all parameters specified in the layer model [i.e., Vs, Vp (or POS), depths, and density], whereas
the "Use only depth model in the specified layer" will use only the depth model (i.e., a series of
different thicknesses) during the initial model creation. To go back to the original default options for the
"Layer (Earth) Model" tab, uncheck "Use specified layer for initial model" option.
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4.2.3 Secondary Outputs
Map of output (Vs) confidence (%) [...(2DConf).TXT]: This will generate, if checked, the 2-D confidence
(%) map in association with the 2-D velocity (Vs) cross section that will show relative distribution of
reliability in the corresponding part of the velocity section. This "reliability" concept is directly
linked to the sensitivity of velocity (Vs) change to the modeled dispersion curve; the higher
sensitivity corresponds to the more reliable inversion result.
Modeled layer [*(Model).LYR]*: If checked, the final 1-D Vs profile (*.LYR) inverted from each input
dispersion curve will be saved.
Modeled dispersion curve [*(Model).DC]*: If checked, the theoretical (i.e., modeled) fundamentalmode (M0) dispersion curve will be saved for each input (measured) dispersion curve.
Initial match variation curve [*(InitMatch).DC]**: If checked, the match between the M0 curve
modeled from the initial velocity model and the input curve will be saved in a file (*.DC) so that the
variation (from one surface location to another) can be displayed at the end of inversion for 2-D Vs
cross section.
Final match variation curve [*(FinalMatch).DC]**: If checked, the match between the M0 curve
modeled from the final velocity model and the input curve will be saved in a file (*.DC) so that the
variation (from one surface location to another) can be displayed at the end of inversion for 2-D Vs
cross section.
Average confidence variation curve [*(AveConf).DC]**: If checked, the overall confidence for one input
dispersion curve is saved in a file (*.DC) so that the variation (from one surface location to another)
can be displayed at the end of inversion for 2-D Vs cross section.
*This type will show the inversion solution for each measured dispersion curve
**This type will show variation with surface coordinates.
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4.3 Output Files (1-D Vs)
The name of the output 1-D velocity (Vs) profile (*.LYR) can be changed. The default name will have
"(Vs1D)" appended at the end of the name of the input dispersion curve file. There is an option
"Append output to 2-D Vs file (*.txt)" that will add the current 1-D velocity (Vs) output to the existing (or
create a new) text file for 2-D Vs cross section [*(Vs2D).TXT] and its corresponding confidence file
[*(2DConf).TXT].
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5. Layer Model
This button will display a table of all numerical values for the velocity (or "layered-earth") model in
which individual values can be viewed and edited. This model can then be used as a common initial
model during the inversion. This button works the same way as the "Specify Layer Model" button does
as explained in section 4.2.2 [Layer (Earth) Model].

6. Approx. Inversion
This button performs an inversion based on the input dispersion curves simply by remapping
wavelengths to depths according to a constant ratio (0.333). This will be a fast process that can be used
as a "quick" check-up process.
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7. Run (1-D Vs Profile)
Inversion for 1-D velocity (Vs) profile consists of two phases—the first automatic inversion and a second
(optional) manual inversion.

7.1 Automatic Inversion
Click "Run" to launch the process.

The following dialog will be displayed to confirm the maximum depth (Zmax) of the inversion that is
originally determined by the program based on the average offset range used during data acquisition.
This is one of the most important parameters in the inversion process that is directly related to the
resolution of the final 1-D shear-wave velocity (Vs) profile. If you click "No", the program will show the
relevant tab where you can adjust Zmax as well as other parameters. Otherwise, click "Yes."
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First, the process to determine the depth to the velocity (Vs) interface (i.e., depth to bedrock) will take
place. This is the depth where the most abrupt change in velocity occurs. This process is termed in the
control diagram as "Bedrock Detection." Then, the program starts the process to search for detailed
velocity variations.

The 1-D Vs profile, saved as a layered-earth model [*(1DVs).LYR], will be displayed automatically at the
end of the inversion process in the dedicated module, as shown below. The two dispersion curves—
measured and modeled M0—are also displayed to indicate the match between them with one of the
two vertical axes of the chart representing frequency of the curve. The match (%) is indicated in the title
bar of the display window. It is the velocity (Vs) model found automatically by the program without
user's intervention based on its own searching algorithm, and is usually sufficient to dictate the reality.
This completes the procedure to generate the 1-D Vs profile.
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In case you need to display this output file [*(1DVs).LYR], you can do so by going to "Display" →
"S-Velocity (Vs) Data" → "1-D Vs Profile (*.LYR)" under the main menu, as illustrated below.

7.2 Optional Manual Inversion
It is often beneficial to attempt one or more additional passes of the inversion process through a manual
searching process followed by another automatic inversion process. This can often lead to finding a
profile whose M0 curve matches the measured curve even better and/or a profile that appears more
realistic. The module displaying the inversion output of a 1-D Vs profile has all the functions ready for
this purpose. For example, the velocity and thickness of an individual layer can be changed by the clickand-drag motion of the mouse in either the horizontal (velocity) or vertical (thickness) direction. The
displayed model dispersion curve [*(Model).DC] will be updated, with the new match (%) indicated in
the top title bar of the display window.
The example below shows that several layers have been changed in velocity (Vs) by using the click-anddrag motions of the mouse so that the overall profile looks more realistic.
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The top title bar shows that the match improved, indicating that the manual update was successful.

Now, because the "initial" velocity model has been slightly updated, another automatic inversion may
find a "further improved" velocity profile. Run another automatic inversion by selecting the "Inversion"
tab on the menu panel, and then clicking the "RUN" button, as illustrated below. The new match
(85.33 %) shows it is a little improved. This is usually the case if the new automatic inversion process
could not find another model significantly different from the current model that maintains a comparable
or improved match in M0 curves.

It is worthwhile then to try to introduce another degree of freedom in the process by choosing the
option of "Variable max. depths", as illustrated below. The program will then execute the automatic
inversion process for as many different depths models as selected (e.g., 10) that are created by either
contracting (< 100 %) or stretching (> 100%) the current velocity model. The example illustrated below
tells us that the process will examine ten (10) different initial models within 75% - 125% scale of the
current velocity model. From the search with all these different models, the program will show at the
end the model that has the best (i.e., highest) match.
16
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Click the "Run" button to perform this "Variable max. depths" inversion. After a while, the final velocity
model solution will be displayed. The example below shows that the match improved noticeably from
85.33% to 89.34%. Above all, the profile looks quite realistic.

Now may be the time to save it as the final solution.
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1. Overview
This module generates a shear-wave velocity (Vs) profile (1-D or 2-D) from input dispersion curve(s). It
will be a 1-D (depth) profile if only one dispersion-curve file (*.DC) is imported, whereas a 2-D (depth
and surface distance) Vs cross section will be produced if multiple files are imported. Each dispersion
curve will be analyzed (i.e., inverted) to find a 1-D Vs profile whose "theoretical" (or "modeled")
fundamental-mode (M0) dispersion curve fits the input "measured" curve most closely through a
generic searching algorithm. In this sense, all input dispersion curves to produce the 2-D Vs cross
section are inverted "almost" independently to produce individual 1-D Vs profiles that will then be used
to construct the final Vs cross section through an appropriate spatial interpolation scheme (e.g., bilinear
scheme). The reason we say "almost" is due to a slight interaction between adjacent dispersion curves
during the initial velocity (Vs) model creation that is executed at the beginning of the inversion process.
This interaction occurs if the option "Detect Bedrock" is selected (default) that will first analyze all input
dispersion curves only to find the simplest velocity model consisting of overburden/bedrock (i.e., 2-layer
model). Then, based on this 2-D velocity model, preliminary bedrock topography is constructed with a
proper lateral continuity applied, and the corresponding velocities are assigned for the overburden and
bedrock. This 2-D information will then serve as a global initial model to which, at the beginning of the
searching process, the inversion of each dispersion curve will refer at the corresponding surface location
for the starting (initial) (1-D) velocity model.
The searching algorithm is based on the sensitivity matrix (called a "Jacobian" matrix) that depicts the
relative change in phase velocity of the theoretical (modeled) dispersion curve for a unit change in
velocity of a particular layer in the model. Although this fundamental philosophy seems straightforward,
there are a significant number of empirical parameters introduced in the algorithm that are necessary to
make the searching process more accurate, stable, and faster. Some of these parameters are included
in the "Options..." section in the main dialog so that they can be adjusted whenever necessary.
Otherwise, the program will automatically assign the most optimum values based on the examination
results of input dispersion curve(s) in some key acquisition and processing attributes such as offset
range used during data acquisition, frequency (wavelength) range in measured dispersion curve(s), etc.
P-wave velocity (Vp) of each layer is determined by the Poisson's ratio (POS) during the inversion
process. The POS is dynamically assigned based on the searched value of Vs; for example, POS = 0.45 for
Vs = 150 m/sec, and POS = 0.33 for Vs = 1500 m/sec. Although the influence of POS is usually minimal,
this dynamic estimation of POS has been proven more effective through extensive modeling
experiments. The default value of density is 2.0 gram/cc for all layers.
Demonstration of the complete procedure by using a sample data set is provided in the PS User Guide
"Generating 2-D Cross Section (Working with Sample Data)."
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2. Importing Input Data
To generate a 1-D (depth) shear-wave velocity (Vs) profile, go to "Inversion" → "Make 1D Vs Profile from
Dispersion Curve" and select one dispersion-curve file (*.DC).

To generate a 2-D (depth and surface distance) shear-wave velocity (Vs) cross section, go to "Inversion"
→ "Make 2D Vs Cross Section from Dispersion Curves" and select multiple dispersion-curve (*.DC) files
at the same time that were previously prepared by analyzing a data set from the same (one) survey line.
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3. Main Dialog
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4. Inversion Controls

4.1 Input Files
In the "Dispersion Curves and S/N" tab, all input dispersion curves are displayed in a chart to allow for
visual inspection. A specific curve can be marked by selecting the corresponding item in the file name
list box. Any curve can be "unchecked" to be excluded from the inversion analysis.
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In the "Frequency Range" tab, the frequency of input dispersion curves used for inversion can be
redefined (if necessary) to a narrower range by entering (non-zero) values in the "MIN" and "MAX"
boxes.

4.2 Inversion Parameters

4.2.1 Search
Search Integrity (Number of Iteration): This specifies the total number of searching processes, each of
which will use the output from the previous search as the initial (starting) model.
Number of Testing Phase Velocity for Each Iteration: This is related to the total number of examining
velocities (Vs's) at a certain stage of the searching process. This is directly related to the resolution
in testing velocities.
Min. Match To Stop (%) (0=open): This criterion will stop the searching process if met before the
number of iterations is reached.
Depth/Wavelength ratio for initial model: This is the ratio used during initial velocity model creation.
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Account for phase-velocity bounds on detecting interface: If checked, this will account for the
minimum and maximum phase velocities in the input dispersion curve to estimate initial velocities
of overburden and bedrock during the "Detect Bedrock" process (if this option is also checked).
Account for mode jump in inverse dispersion: If checked, this will generate apparent dispersion curves
instead of the fundamental-mode (M0) curves by accounting for the mode jump during the
theoretical dispersion curve generation. This can significantly prolong the process time.

4.2.2 Layer (Earth) Model
Number of Layer: Total number of layers (including the last half space) used in the velocity model.
Max. depth (Zmax)*: Depth to top of the deepest (last) layer (i.e., half space) in the velocity model.
Zmax Bound*: A non-zero value will limit Zmax smaller than this value. This option will be active only
when the "Variable max. depths" has been checked.
Variable max. depths: If checked, Zmax will become another searching variable during the inversion.
The initial velocity model will be scaled according to the new examining Zmax for each inversion for
a given maximum depth (Zmax). The "Depths Model" tab on the right side will be enabled only
when this option is checked.
No. of different depths: Total number of different Zmax that will be examined at each iteration.
Min. depth (%): Minimum Zmax considered as percent of the specified maximum depth (Zmax).
Max. depth (%): Maximum Zmax considered as percent of the specified maximum depth (Zmax).
Only to Initial Model: The "Variable max. depths" will be applied only during the initial model creation.
*A zero value (0) indicates an optimum value will be determined by the program.
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Detect Bedrock: If checked, the initial model creation will search for the simplest velocity model of
overburden/bedrock first. Then, the actual multi-layered (e.g., 10-layer) initial model will be created
based on results from this process.
Detect intensity (%): This determines the number of different depths that will be searched; the higher
this number, the more depths that will be examined.
Min. Depth (Zmin)*: Minimum Zmax to be examined.
Max. Depth (Zmax)*: Maximum Zmax to be examined.
Lateral continuity (0-10): If a non-zero value is entered, this will apply the lateral averaging (smoothing)
of the created 2-D overburden/bedrock model in velocity and bedrock topography.
*A zero value (0) indicates the optimum value will be determined by the program.

If the "Specify Layer Model" button is clicked, then the following table will be displayed showing
numerical values of all parameters in the velocity (or "layered-earth") model. Individual values can be
viewed and manually edited. (Note Q values, Qs and Qp, are not used during the inversion.) If this
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display is closed by clicking the "OK" button, then this layer model will become the initial velocity model
common to all input dispersion curves.

Then, the following two options will be available. The "Use specified layer for initial model" will use, if
checked, all parameters specified in the layer model [i.e., Vs, Vp (or POS), depths, and density], whereas
the "Use only depth model in the specified layer" will use only the depth model (i.e., a series of
different thicknesses) during the initial model creation. To go back to the original default options for the
"Layer (Earth) Model" tab, uncheck "Use specified layer for initial model" option.
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4.2.3 Secondary Outputs
Map of output (Vs) confidence (%) [...(2DConf).TXT]: This will generate, if checked, the 2-D confidence
(%) map in association with the 2-D velocity (Vs) cross section that will show relative distribution of
reliability in the corresponding part of the velocity section. This "reliability" concept is directly
linked to the sensitivity of velocity (Vs) change to the modeled dispersion curve; the higher
sensitivity corresponds to the more reliable inversion result.
Modeled layer [*(Model).LYR]*: If checked, the final 1-D Vs profile (*.LYR) inverted from each input
dispersion curve will be saved.
Modeled dispersion curve [*(Model).DC]*: If checked, the theoretical (i.e., modeled) fundamentalmode (M0) dispersion curve will be saved for each input (measured) dispersion curve.
Initial match variation curve [*(InitMatch).DC]**: If checked, the match between the M0 curve
modeled from the initial velocity model and the input curve will be saved in a file (*.DC) so that the
variation (from one surface location to another) can be displayed at the end of inversion for 2-D Vs
cross section.
Final match variation curve [*(FinalMatch).DC]**: If checked, the match between the M0 curve
modeled from the final velocity model and the input curve will be saved in a file (*.DC) so that the
variation (from one surface location to another) can be displayed at the end of inversion for 2-D Vs
cross section.
Average confidence variation curve [*(AveConf).DC]**: If checked, the overall confidence for one input
dispersion curve is saved in a file (*.DC) so that the variation (from one surface location to another)
can be displayed at the end of inversion for 2-D Vs cross section.
*This type will show the inversion solution for each measured dispersion curve
**This type will show variation with surface coordinates.
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4.3 Output Files (2-D Vs)
The name of the output 2-D velocity (Vs) cross section can be changed. The default name will have
"(Vs2D)" appended at the end of the common name of the input dispersion curve files. The 2-D
confidence file will have "(2DConf)" appended. Both types of output will be text files (*.TXT).
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5. Layer Model
This button will display a table of all numerical values for the velocity (or "layered-earth") model in
which individual values can be viewed and edited. This model can then be used as a common initial
model during the inversion. This button works the same way as the "Specify Layer Model" button does
as explained in section 4.2.2 [Layer (Earth) Model].

6. Approx. Inversion
This button performs an inversion based on the input dispersion curves simply by remapping
wavelengths to depths according to a constant ratio (0.333). This will be a fast process that can be used
as a "quick" check-up process.
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7. Run (2-D Vs Cross Section)
Click "Run" to launch the process.

The following dialog will be displayed to confirm the maximum depth (Zmax) of the inversion that is
originally determined by the program based on the average offset range used during data acquisition.
This is one of the most important parameters in the inversion process that is directly related to the
resolution of the final 2-D shear-wave velocity (Vs) map. If you click "No", then the program will show
the relevant tab where you can adjust Zmax as well as other parameters. Otherwise, click "Yes."

13

PS - Inversion of Dispersion Curves
First, the process to determine the depth to the velocity (Vs) interface (i.e., bedrock depth) will take
place. This is the depth where the most abrupt change in velocity occurs. This process is termed in the
control diagram as "Bedrock Detection."

Then, the next processing step to find the velocity (Vs) model whose theoretical (i.e., modeled)
dispersion curve best matches the measured curve will take place. This is accomplished through an
iterative process during which intermediate dispersion curves will be displayed to show the
corresponding match. The overall match will also be displayed in a single-column graph as well as a 2-D
chart form showing its variation with surface location.
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At the end of the inversion process, the following two types of output will be saved and then
automatically displayed within the same form (under "Display 1" and "Display 2" tabs); a 2-D shear-wave
velocity (Vs) cross section map [*(2DVs).TXT], and the corresponding 2-D Vs confidence map
[*(2DConf).TXT], respectively, as shown below. The velocity color scheme in the 2-D Vs cross section is
automatically determined by the program based on the velocity value distribution in the input file
[*(2DVs).TXT]; this can be changed through a control dialog explained below. Notice that the cross
section map shown below used the color scheme displayed at the top that is matched within the Vs
range of 0-1200 m/sec. The confidence map shows the distribution of relative reliability in inversion
results (Vs values) so that it can be used to judge credibility of velocity values in the cross section map
that may change from one place to another.
<2-D Vs Cross Section Map>

<2-D Vs Confidence Map>
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<To Change Velocity (Vs) Color Scale>
Select the "View" tab in the top tool panel. Then, click the "Controls" button to display the control
dialog. Enter values for "MIN" and "MAX" to specify the range of velocity and then click "Update Image"
button at the bottom. Many parameters related to the 2-D interpolation (e.g., interpolation schemes)
and display (e.g., changing axis scale, labeling, etc.) of the input text file (*.TXT) in the usual threecolumn format (i.e., X, Depth, Value) can be accessed through this dialog.

In case you need to manually open the 2D Vs cross section file, you can do so by going to "Display" in the
main menu, and then "S-Velocity (Vs) Data" → "2-D Vs Cross Section (*.TXT)", as shown below.

The corresponding confidence map can be automatically imported within the cross section display form
by selecting the "View" tab in the top tool panel and then clicking the "2DConf" button, as shown below.
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1. File

Opens another file to replace current display.
Opens another file in a new display window.
Saves currently displayed part of the record as a seismic data file (*.dat).
Saves current display as an image file (*.jpg, *.bmp).
Prints current display (or multiple records).
Opens dispersion-curve (*.dc) file(s) in a separate window.
Opens a dispersion-image file [*(*OT).dat] in a separate window for "linked-display" mode.
Closes and exits this module.

2. Data

Displays first record in the file.
Displays previous record in the file.
Displays next record in the file.
Displays last record in the file.
Jumps into a specified record in the file.
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Displays information about the input data file (e.g., sampling interval, recording time, etc.).
Views contents of all header words for all traces in current record.
Animated display of multiple records. Right click to specify record range and animation speed.
Resample record(s) in time (t) and space (x). Following control dialog will appear.

2.1 Resample
The following control dialog has three tabs— "Space", "Time", and "Records"—in which resampling
intervals in space (x) and time (t) and resampling record range, respectively, can be specified. A
resampling interval greater than one (1) will "decimate" current data samples, while a fractional interval
will "interpolate" them. A fractional part will be ignored if the interval is greater than one (1).

The interpolation in time will use the frequency-domain (f) approach, while the space interpolation will
use the time-space (f-k) domain approach.

3

PS - Seismic Data Display

3. Edit

*

Flips current record in the order of channel arrangement. Right click to save all flipped records
as a separate file (*.dat).

*

Exports currently displayed seismic data as a text file (*.txt). Right click to invoke the control
dialog explained in section 3.1.
Cuts and appends seismic traces and records into a separate file. A control dialog will appear,
which is explained in section 3.2.

3.1 Export Data
This module outputs seismic data as a text file (*.txt) by using the 3-column format. Although the type
of output for the first two columns can be chosen as shown in the dialog below, the last column always
contains the value of seismic data (i.e., amplitude of seismic wave at a specific time). Resampling (i.e.,
down sampling) can also be chosen by entering a number greater than one (1) in the edit box.
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3.2 Cut/Append Records and Traces
This module can selectively output seismic record(s) and trace(s) based on specific needs that can be
accomplished by properly selecting one or more options available within the multiple tabs in the dialog
as shown below.
Record

Begin/End
Record(s) / Move
Skip
All records
Normalize records
Rearrange RCD #

Specifies the range of records for output.
Logical number of record(s) collected at the same place before moving to the
next selection of records.
Number of records to skip (i.e., not to output) before moving to the next
selection of records.
When checked, all records in the input file are selected (by selecting the first
and last record numbers in the "Begin" and "End" boxes).
Normalizes each record before output (with a normalization amplitude of
"100.0").
Will show options to specify the beginning and increment of output record
number.
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Trace

Begin/End

Increment
All traces
Normalize traces
Rearrange channels

Specifies the beginning and end trace numbers to output. Trace number always
starts from "1" at the beginning, and "0" means default values in the input data
(i.e., first and last traces for "Begin" and "End").
Increment in "Begin" and "End" trace numbers when moving to the next
selection of records.
Selects first and last traces for the "Begin" and "End" records, respectively.
Normalizes each trace before output (with a normalization amplitude of
"100.0").
Will show options to specify the beginning and increment of the channel
number in the output.
Time

Begin/End
Starting and ending times for output.
Apply begin time as recording delay time
Will encode the beginning time of output (if other than "0") as recording delay
time in the trace header.
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Zero Data

Apply to traces
Apply to time

Will show options to specify beginning and ending traces to erase data values
(i.e., fill with zeros).
Will show options to specify beginning and ending times to erase data values.
Stacking

stack records
stack header #
Show header table
stack traces

Will stack records in the specified range into one "stacked" record before output.
Header word # of each trace that is used to stack traces of the same value.
Will display the file (*.pdf) describing all ParkSeis header words.
When checked, will stack all traces in a record before output.

Append Output
Will append output to the end of an existing data file.
Save Output As (*.dat) Allows user to specify output file name (*.dat)
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4. View

Displays the dialog containing all the controls (see section 4.1 for more details). This can also be
executed by double clicking on the display.
If depressed, applies trace normalization.
If depressed, turns the wiggle display into variable-area display.
Displays the average amplitude spectrum of the current record displayed.
Changes vertical display scale (left click = up, right click = down).
Changes horizontal display scale (left click = up, right click = down).
Selects (or deselects) particular trace being clicked.
Zooms into the rectangular area drawn by the mouse.
If depressed, draws time lines.
Displays current record in its entire number of traces for the entire recording time.
Displays a table of source/receivers (SR) configuration in a separate chart.
Displays the receiver array for the current record with the source location marked (if exists).
Changes display gain (dB) (left click = up, right click = down).
Shows trace number (if depressed) on top of the display.
Shows station number (if depressed) on top of the display.
Shows survey-line distance (if depressed) on top of the display.
Enables the scroll-window display.
Shows the linear velocity for a line drawn by the mouse.
Clears any lines drawn by using the mouse.

8

PS - Seismic Data Display

4.1 Control Dialog
Double click on the display (or click the
button in the "View" tab of the tool bar on top) to invoke the
control dialog that contains all the controls related to display of seismic data with options available as
shown below.

Wiggle
Size

Horizontal wiggle size can be set by specifying display gain (dB) and amplitude in trace
spacing. For example, an amplitude of "1.0" will make the maximum value of a trace
take one trace space if there is no display gain applied (i.e., "0" dB).
Fill type
Area of wiggle to be filled (with black) in either positive (+) or negative (-) amplitude
direction. All wiggle displays in this guide are in positive (+) fill type. Positive
amplitudes always kick to the right side on display.
Normalization Wiggle size can be normalized with respect to maximum amplitude of either entire
record ("Global") or each trace ("Trace").
Display type Seismic amplitudes can be displayed in either wiggle type (below left) or variable area
type (below right).

Scale
Both vertical (time) and horizontal (trace) display sizes can be expanded in proportion to the specified
number.
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Range
Range of display in time (ms) and traces can be specified.
Labeling
Horizontal ("Trace") labeling can be specified in "Trace no." and "Offset." "Header #" displays value of
the corresponding header word number in the trace. Description of each header word is listed in the
green bar below the edit box. Distance within the survey line can also be specified if "Survey line
distance if found" box is checked. Labeling frequency determines how often the horizontal labeling is
rendered. "Title" is the label displayed on top of each display.
Vertical ("Time") labeling can be specified in the "Interval" box. Labeling will be rendered at every
"Major" time (ms), while tick marks will be rendered on every "Minor" time (ms). Time lines will be
drawn horizontally if "Draw Time Line" box is checked. All time labeling can be specified in seconds if
"Draw in seconds" box is checked. "Title" is the time-axis title.
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5. Process

Toggles display between the original "unprocessed" record and the most current
"processed" record.
Toggles display between the most current and the previous "processed" records.
Displays processing history of the current record displayed (if it exists).
If depressed, can apply frequency-domain filtering to all or selected traces of the record
currently displayed or multiple records specified (see section 5.1 for more details). The
asterisk (*) indicates that right clicking will invoke the control dialog.
If depressed, can perform frequency-wave number (f-k) domain filtering to all traces of
the record currently displayed or multiple records specified (see section 5.2 for more
details). The asterisk (*) indicates that right clicking will invoke the control dialog.
If depressed, can perform automatic-gain-control (AGC) to all traces of the record
currently displayed or multiple records specified (see section 5.3 for more details). The
asterisk (*) indicates that right clicking will invoke the control dialog.
If depressed, can perform muting (i.e., erasing data by filling with zeros) the top or
bottom portion of the record currently displayed or multiple records specified (see
section 5.4 for more details). The asterisk (*) indicates that right clicking will invoke the
control dialog.
If depressed, can perform swept-frequency-record (SFR) to the record currently
displayed or multiple records specified (see section 5.5 for more details). The asterisk (*)
indicates that right clicking will invoke the control dialog.
Can perform back-scattering-analysis (BSA) to the current seismic data file (see section
5.6 for more details).
Will generate a dispersion image for the current record displayed by using the
parameters automatically detected by the program. The generated image will be
displayed in a separate chart (see section 5.7 for more details).
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Can add random noise to the current record displayed or multiple records
specified (see section 5.8 for more details).
Can perform static correction to the current record displayed (see section 5.9 for more
details).
Can generate amplitude spectrum of the current record displayed (see section 5.10 for
more details).

5.1 Filter
Depress the Filter button and the following instruction dialog will appear. Double click at the center of
the zone of interest in the seismic display, or drag the mouse to draw a rectangular zone of interest and
then double click.

The following spectral control dialog will appear in which the overall amplitude spectra of the entire
(blue curve) and the selected (red curve) zones of the record are displayed in the chart. The trapezoidal
window specified by the four (4) filter parameters (F1, F2, F3, and F4) are also displayed (black curve).
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Filter Type
Four (4) types of filtering are available. "Band Cut" will cut (i.e., filter out) the amplitudes within the
frequencies of the trapezoidal window defined by the four (4) filter parameters (F1, F2, F3, and F4).
"High Cut" will cut amplitudes above frequencies in the window specified by the two filter parameters
F1 and F2. "Low Cut" will cut amplitudes below the frequencies in the window specified by the two filter
parameters F3 and F4. "Band Pass" will pass all the amplitudes at frequencies within the trapezoidal
window specified by the four filter parameters (F1, F2, F3, and F4). "Horizontal Events" will filter out
those arrival patterns that tend to be aligned along the horizontal line (i.e., arriving at the same time). If
this option is chosen, an edit box to specify the filter extent will appear. An example of filtering
"Horizontal Events" is illustrated in the user guide "Back Scattering Analysis (BSA)."
Multiple Filtering
Multiple "Band Pass" filtering can be applied to the same record currently displayed. Multiple sets of
four (4) filter parameters (separated by a space) can be specified in the list box as illustrated below.
Click "Run Multiple Band-Pass filtering" button to launch it, and a new seismic display window will
appear to display the output.

If you right-click the "Filter" button, then the general control dialog will appear with the following
options available.
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Filter options
Filter degree determines the band width of the four (4) filter parameters automatically based on the
relative spectral contents of the entire and specified zones of the current record. The "Weak" option
will choose a relatively narrow bandwidth, while the "Strong" will choose the broadest bandwidth. The
"Display spectrum and control dialog" will enable the display of spectral control dialog on executing the
filtering so that more detailed spectral controls can be chosen.

Save output
Check the "Save output" check box to save output as a separate file (*.dat). Record range for filtering
can be specified by selecting "Begin" and "End" record numbers as shown below.
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5.2 F-K
Depress the "F-K" button to execute the f-k filtering. The following information dialog will appear that
instructs how to execute the filtering (default filter type is "Fan Cut").

You can draw two linear slopes on the display with the mouse to define the range of linear seismic
events (i.e., "Fan") to be filtered, as illustrated below. Then, double click on the display to execute the
filtering.

If you right click the "F-K" button, the control dialog will appear with the following options available.
Type

Fan Cut

Filters out all linear events that fall within the specified range of slopes (i.e., "fan").

Fan Pass

Filters out all linear events that fall outside the specified range of slopes (i.e., "fan").

Horizontal Cut

Filters out all horizontal events.

Horizontal Pass

Filters out all non-horizontal linear events.
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FFT

Scaling size of the Fast Fourier Transformation (FFT) can be specified for time (t) and space (x) axes.
Sizes are directly proportional to the discrete intervals in frequency (f) and wavenumber (k) axes that
can influence the performance of the filtering. A larger size can sometimes lead to the more delicate
filtering performance, but it can prolong processing time. "Tapering" determines the smoothness of the
cutting edges in f-k domain that is related to the computational artifacts. The higher value in tapering
(i.e., smoother tapering) will result in less computational artifacts at the expense of less aggressive
filtering.
Band-Pass Filtering

The frequency-domain band-pass filtering can be applied before f-k filtering takes place. The specified
four (4) filter parameters define the trapezoidal pass band. To apply this filtering, check the "Apply
Band-Pass Filtering" box.
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Input and Output

The record range to which the f-k filtering is to be applied can be specified by selecting "Begin" and
"End" record numbers. A separate output file can be generated if the "Save output" box is checked.
Filtering Velocity

The range of linear velocities (i.e., slopes) for filtering can be numerically specified in the "Slowest" and
"Fastest" boxes rather than being determined by the two linear slopes drawn by mouse. If non-zero
values are specified in the two boxes, then double click on the seismic display to execute filtering
without drawing two linear lines.
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5.3 AGC
Depress the "AGC" button to apply automatic gain control. The following information dialog will appear
that instructs how to execute it (i.e., double click at the center of the zone of interest in the seismic
display, or drag the mouse to specify a rectangular zone and then double click).

If you right click the "AGC" button, a the control dialog will appear with the following options available.
AGC Degree
Degree of AGC is determined by the size of the time window that evaluates the average amplitude.
Three options ("Weak", "Mild", or "Strong") are available in the "AGC Degree" radio box, or a specific
window size (ms) can be specified in the edit box as shown below.
Record(s)
Record range to which AGC will be applied can be specified by selecting "Begin" and "End" record
numbers as illustrated below. Output can be saved as a separate file if "Save output" check box is
checked.
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5.4 Mute
Depress the "Mute" button to apply the linear mute. The following information dialog will appear that
instructs how to execute it (i.e., drag mouse to draw a straight line for mute boundary and then double
click on the seismic display).

Display on left below illustrates the stage right after drawing the straight line, and display on the right
illustrates the stage after execution of the mute by double click.

If you right click the "Mute" button, then the control dialog will appear with options available as shown
below. The "Mute type" tab contains the options for the type; i.e., muting top or bottom. The above
example illustrates muting "top." In the "Tapering" tab, you can specify the degree of tapering along the
mute boundary. It can be selected from the "Degree" radio box, or you can enter a specific value in the
edit box. In the "Record(s)" tab, you can specify to save output as a separate file by checking the "Save
output" box. You can also specify the range of records to process by selecting "Begin" and "End" record
numbers.
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5.5 SFR
Depress the "SFR" button to apply the SFR (swept-frequency-record) process (see Park et al., 1998). The
information dialog shown on the left will appear that instructs how to execute it (i.e., double click on the
seismic display). The execution will proceed and output saved with a default name [e.g., *(SFR).dat] that
can be displayed in a separate window as illustrated below.

Display below shows an example output of SFR process.

If you right click the "SFR" button, then the control dialog will appear with options available as shown
below.

Frequency (HZ)
Frequency range of the sweep can be specified by entering specific numbers in the "Begin" and "End"
edit boxes. This sweep can be saved as a separate file (*.dat) if "Save sweep (*.dat)" box is checked.
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Time
Total (ms)

Total time length of processed output in milliseconds (ms). This will be the same
as sweep time plus listening time.

Sweep Time (ms)

Time length of the sweep in milliseconds (ms).

Listening Time (ms) Time length after the end of sweep to "listen" in milliseconds (ms).
Output decimation

Output SFR can be decimated (i.e., down-sampled) before saving. Ratio indicates
how often output will be sampled. For example, a ratio of "2" indicates output
will be re-sampled every other sample. The corresponding Nyquist (i.e., Max)
frequency (Hz) will be updated in the box below as the ratio changes.
Tapering

Window lengths of tapering at the beginning and ending portions of SFR can be specified by entering
specific numbers in the "Begin of sweep" and "End of sweep" edit boxes. A longer tapering window (i.e.,
the smoother tapering) will result in less computational artifacts.

Records
Range of records to which SFR will be applied can be chosen by selecting "Begin" and "End" record
numbers. Output file name can be specified by clicking "Save Output As (*.dat)" button.
Process
Type of process can be specified in the "Options" radio box. The "SFR" option will simply stretch the
input time series (i.e., one trace) by convolving it with the designed sweep function. This is the
operation indicated by equation (5) in Park et al. (1999). The "SFR + LMO Correction" option will apply
the linear-move-out (LMO) correction to the SFR by using the dispersion information provided by a
separate file (*.dc). This is the operation called "Dynamic Linear Move Out (DLMO)" correction in Park
et al. (1998). The "SFR + LMO + Stacking" option will apply the stacking (i.e., averaging data values in the
same time) to the output record from the "SFR + LMO" operation. In this case, the offset (i.e., distances
from source) range for stacking can be chosen by specifying values in the "MIN" and "MAX" edit boxes.
Surface coordinate information of output stacked records can be viewed by clicking the "Coordinates"
button, which will display the information in a separate list box as illustrated above. The last two
options (i.e., "SFR + LMO" and "SFR + LMO + Stacking") will ask user to provide the file name (*.dc) for
the dispersion information.
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5.6 BSA
Click "BSA" button to apply "Back Scattering Analysis (BSA)" to the current seismic data set. The
following control dialog will appear in which all related parameters can be specified. See the PS User
Guide "Back Scattering Analysis" for more details.

5.7 OT
Click the "OT" button to generate a dispersion image for the current seismic record displayed. The
program will detect surface wavefields in the input record and determine appropriate processing
parameters (e.g., frequency and phase velocity ranges) that are used to generate the dispersion image
record, which will be displayed in a separate display window as illustrated below. See PS User Guide
"Dispersion Image Generation" for more details.
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5.8 Noise

Depress the "Noise" button to add random noise to the seismic data. The control dialog will appear with
following options available.
Noise degree (%)
Reference amplitude

Apply filtering
Apply to all records

Relative extent (%) of noise to be added with respect to the total wavefield
energy of each trace calculated by FFT.
An arbitrary amplitude can be specified that is used as a "reference" to calculate
the noise degree (%). If "max. input data" is checked, then it shows the value
for the current record displayed.
Band-pass filtering can be applied after adding random noise by specifying the
four (4) filter parameters (F1, F2, F3, and F4) to define the pass band (HZ).
If checked, noise will be added to all records in the input file. In this case, the
output will be saved as a separate file.

5.9 Static
Depress the "Static" button to apply static correction to the current record displayed. The following
information dialog will appear that instructs how to execute it (i.e., double click at the center of the zone
of interest, or drag mouse to draw a rectangular zone and then double click).

The display below illustrates the instance of drawing a rectangular zone to generate a "pilot wavelet" by
averaging (i.e., stacking) the wavelets inside the zone, and then user will double click on the display. The
next display shows the output after the static correction has been applied, showing that "static" effects
have been greatly reduced.
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If the operation is executed by a double click without drawing the rectangular zone, then the control
dialog will appear with following available options.
Start and end trace no. for reference window:
The trace range to construct the "pilot wavelet" by summing data values in the specified traces. Use "0"
to indicate the default values in the input record (for example, "0" for start and end means the 1st and
last traces in the input record).
Start and end time for reference window (ms):
Time range (ms) to construct the "pilot wavelet" from the traces specified above. Use "0" to indicate
the default values in the input record (for example, "0" for start and end times means the beginning and
ending times of each trace).
Max. static limit (ms):
Maximum limit (ms) in the static correction to apply. Use a greater value (e.g., 500) if the input record's
static is especially severe.
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Moving-window traces/side:
Number of traces on each side (before and after) to add to the current trace before the static correction
is applied. This will generate an "averaged" current trace by stacking ambient traces so that a "smooth"
correction can be applied.

5.10 Spectra
Press down the "Spectra (
)" button to generate amplitude spectra of traces in the current
record displayed. The following information dialog (on left) will appear that instructs how to execute it
(i.e., double click in display to generate spectra for all traces in the display, or drag mouse to draw a
rectangular zone of interest and then double click). Output "spectra" traces will be displayed in a
separate window as shown below (right).

Each "amplitude spectrum" trace represents the amplitude variation with frequency for the
corresponding trace in the input seismic record.
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If you right click the "Spectra (
available as shown below.

)" button, then a control dialog will appear with the options

Spectra
The type of output can be selected from two options—"Trace" and "X-Y Chart." The output displayed
previously is the "Trace" type, and the other type is displayed below. Output frequency interval (Hz) and
maximum frequency can be specified within the highest (Nyquist) frequency available.
Spectra Record(s)
Frequency range (Hz) and interval (Hz) of output spectra records can be specified. Each trace can be
normalized (with a normalization amplitude of "100") before the calculation of its spectrum if the "Apply
trace normalization" box is checked. The spectra records (of "Trace" type) can be generated for all input
records if the "Apply to all records" box is checked. In this case, the output file name (*.dat) can be
specified by clicking "Save Output As (*.dat)" button.
The following display illustrates the output of "X-Y Chart" type. Individual trace has its own spectrum
data (curve) (*.SPC) that can be saved by clicking "Save" button on top of the display window. This
output can be displayed from the main menu by selecting "Display" → "Spectra Display" as shown below.
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6. Records

This tab has tools to navigate through different records in the input file. A specific record can be chosen
by selecting a record number in the dropdown box on the left, or by moving the track bar on right.

7. References
Park, C.B., Miller, R.D., and Xia, J., 1998, Ground roll as a tool to image near-surface anomaly: 68th
Annual International Meeting of Society of Exploration Geophysicists (SEG), Expanded Abstracts,
p. 874-877.
Park, C.B., Miller, R.D., and Xia, J., 1999, Multichannel analysis of surface waves: Geophysics, v. 64, n. 3,
pp. 800-808.
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Control Dialog

Double click on the display (or click the
button in the "View" tab of the tool bar on top) to invoke the
control dialog that contains all the controls related to display of seismic data with options available as
shown below.

Wiggle
Size

Horizontal wiggle size can be set by specifying display gain (dB) and amplitude in trace
spacing. For example, an amplitude of "1.0" will make the maximum value of a trace
take one trace space if there is no display gain applied (i.e., "0" dB).
Fill type
Area of wiggle to be filled (with black) in either positive (+) or negative (-) amplitude
direction. All wiggle displays in this guide are in positive (+) fill type. Positive
amplitudes always kick to the right side on display.
Normalization Wiggle size can be normalized with respect to maximum amplitude of either entire
record ("Global") or each trace ("Trace").
Display type Seismic amplitudes can be displayed in either wiggle type (below left) or variable area
type (below right).
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Scale
Both vertical (time) and horizontal (trace) display sizes can be expanded in proportion to the specified
number.

Range
Range of display in time (ms) and traces can be specified.
Labeling
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Horizontal ("Trace") labeling can be specified in "Trace no." and "Offset." "Header #" displays value of
the corresponding header word number in the trace. Description of each header word is listed in the
green bar below the edit box. Distance within the survey line can also be specified if "Survey line
distance if found" box is checked. Labeling frequency determines how often the horizontal labeling is
rendered. "Title" is the label displayed on top of each display.
Vertical ("Time") labeling can be specified in the "Interval" box. Labeling will be rendered at every
"Major" time (ms), while tick marks will be rendered on every "Minor" time (ms). Time lines will be
drawn horizontally if "Draw Time Line" box is checked. All time labeling can be specified in seconds if
"Draw in seconds" box is checked. "Title" is the time-axis title.
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Dispersion-Data Display

1. Overview
This module is mainly for the display of dispersion data that can be either a curve (*.DC) extracted from
a dispersion image or the dispersion image [*(*OT).DAT] processed from seismic records. To open such
a file, go to "Display" → "Dispersion Data [*.dc, *(*OT).dat]" in the main menu as illustrated below.

Display of dispersion images is extremely important for the accurate extraction of dispersion curves (the
2nd step of the two-step dispersion analysis) from dispersion images previously generated from seismic
records (1st step of the analysis). It will help understand the overall variation pattern of dispersion over
the entire survey area, and therefore will help to make an accurate interpretation of the fundamental
mode during the curve extraction.
In addition to displaying, this module can perform editing of dispersion data such as deleting (or adding)
data points in the curve, saving selected dispersion image records as a separate file (*.DAT), and combining the current dispersion image record with an external (e.g., passive) dispersion image record. This
module can also perform several data processing tasks. For example, a selected dispersion curve can be
inverted to generate the 1-D shear-wave velocity (Vs) profile. Or, an imported external curve can be
added to (or subtracted from) the curve selected in the display module. The overall average phase
velocity of the curve can also be calculated and displayed.
Three (3) types of special processing tasks are included when a dispersion image file is open: "OT-Filt",
"OT-Stk", and "F-Sum."
OT-Filt

Applies smoothing of dispersion image by filtering amplitudes along the frequency axis. This
can be useful when the overall image pattern is so complicated that no meaningful
interpretation can be made (below left). By applying this filtering, a few consistent patterns
may become obvious as illustrated below (right) where, at least, the lowest phase velocity
pattern (at ~200 m/sec) is noticeable that can be interpreted as (~90% of) the velocity (Vs)
for the shallowest depths.
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OT-Stk

Applies stacking of ambient (i.e., previous and next) dispersion image records on top of the
current image. This can help interpretation of a complicated dispersion pattern. The image
shown below left becomes more obvious in its pattern when stacked with the previous and
next dispersion images (below right).

F-Sum

Displays the energy summation of the currently displayed dispersion image along the frequency axis. The image shown below is used as an example. It is the stack of all dispersion
images processed from the sample data set, "DippingBedrock.DAT" [see PS User Guide
"Generating 2-D Cross Section (Working with Sample Data)" for more information about the
data], and several distinctive patterns are annotated on the image with interpretations
related to the following explanations. This model data set was produced by using a 2-D
velocity (Vs) model of a dipping bedrock surface with bedrock velocities of Vs = 1000 m/sec
and Vp = 1985 m/sec and the overburden Vs = 200 m/sec. When the frequency summation
is applied to the dispersion image by clicking this "F-Sum" button, the curve of the summed
energy is displayed as shown below where the first peak occurs at 190 m/sec, the second
peak at 840 m/sec, and the last peak at 1940 m/sec. These values are close to Vs of
overburden, Vs of bedrock, and Vp of bedrock, respectively. The study (Park, 2015)
indicates these energy peaks represent the sum of wavefields from direct arrival of shear
waves, S-waves, and P-wave refractions from bedrock surface, respectively. The study by
Pugin et al. (2010) also indicates both S- and P-waves are generated at the source point
even if a vertical-impact seismic source is used, and they are also generated through mode
conversion when refraction and reflection occur. Park (2015) indicates that Vs evaluation of
overburden and bedrock through this method ("F-Sum") provides about 80%─100% of true
values, whereas Vp evaluation of bedrock provides about 90%─100% of true value. Future
publications will provide detailed theoretical descriptions about this method and provide
guides on data acquisition and processing to fully utilize this approach.
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2. Dispersion Curve (*.DC)
To display dispersion curve(s), go to "Display" → "Dispersion Data" → "Dispersion Curve (*.DC)" in the
main menu. Multiple files can be selected at the same time as illustrated below.

The top tool panels consists of four (4) tabs: "Files", "Curves", "Scale", and "Process". Each tab is
explained below.

2.1 Files

Open

Opens a dispersion curve (*.DC) file in the current tab. Right click to open dispersion
image [*(*OT).DAT] file.

New

Opens a dispersion curve (*.DC) file in a new tab. Right click to open dispersion image
[*(*OT).DAT] file.

Save (

)

Saves current chart image as a graphic file (*.BMP, *.JPG).

Save (

)

Saves a selected curve as a separate file (*.DC).

Print

Prints current chart image and processing history of the file (if exists and chosen).

Export

Saves current display settings as a separate data base file (*.DB_).

Import

Imports a previously saved data base file (*.DB_) of all chart display settings.

Help

Displays current help file for "Dispersion-Data Display."
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2.2 Curves

Legend

Shows/hides legend of curves linked to the chart.

S/N

Shows/hides signal-to-noise ratio (S/N) curves of the existing dispersion curves. If a
curve has been selected, then its overall signal-to-noise (SN) (%) is displayed in a
separate pie-chart in the upper-right corner as illustrated below. A curve can be
selected (or deselected) by clicking either the curve itself or its title in the legend.
Multiple selections can be made by "shift" clicking.

Clear

Shows/hides selected curves. Right-click to permanently remove them from the chart.

Select

Selects/deselects all curves in the chart at once.

View

Views contents of the curve file (*.DC).

Edit

If depressed, editing of a selected curve is enabled. To delete a data point, click that
point. To delete a group of data points, draw a rectangle to select them. To move a
data point, click and drag it. To add a data point, click anyplace outside the existing
points. Click the "Undo" button to abort previous edit action(s).

Undo

Aborts previous edit action(s).

Lamda

Data points are displayed in wavelength () versus phase velocity (Cf) by converting the
frequency (f) axis into the wavelength (m) axis. Each point's wavelength () is calculated
as  = Cf/f.

X-coord

Shows the corresponding surface coordinate of the selected curve.
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2.3 Scale

Controls

Displays the following dialog that contains all chart-related controls. For full description
of these controls, see PS User Guide "Chart Controls" that can be displayed by clicking
the help ( ) button in the upper-right corner.

Full

Makes the display in the full size of the input data, both vertically and horizontally.

Y*

Increases (right click = decreases) the vertical (Y) scale of the chart.

X*

Increases (right click = decreases) the horizontal (X) scale of the chart.

Zoom

Zooms in by drawing a rectangular zone on the chart.

Grids

Shows/hides dotted grid lines in both vertical and horizontal directions.

Set

Makes current chart settings the default settings.

Get*

Restores saved default settings for a chart. Right-click to restore the last settings
previously used.
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2.4 Process

INVR*

Performs the inversion process to generate the 1-D shear-wave velocity (Vs) profile from
the selected dispersion curve in the chart. On first clicking the button, the inversion
control dialog (below left) will appear and then an automatic inversion will proceed to
generate the final output displayed below right. For full description of the inversion, see
PS User Guide "Inversion" or click the "Help ( )" button on the dialog.

Add-Sub

Can add (+) [or subtract (-)] another dispersion curve (*.DC) to (or from) the current
dispersion curve selected in the chart. The following dialog will appear where the
operation type can be selected and the other file (*.DC) can be imported.

Vave

Displays average phase velocity of the selected dispersion curve as illustrated below.
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3. Dispersion Image [*(*OT).DAT]
To display a dispersion image file [*(*OT).DAT], go to "Display" → "Dispersion Data" → "Dispersion
Image" in the main menu as illustrated below.

When the input file has multiple records of dispersion images that have different surface coordinates (of
station numbers and distances), then there will be a separate "Surface Location" chart displayed at the
top as shown below. The surface location of the current dispersion image record is indicated by the
asterisk mark (*) in this chart and the numerical number of this record is displayed in the caption of the
form on top [e.g., "Surface Location = 17.2 (m)"]. Coordinates of this chart can be toggled between
distance and station number by double clicking on the chart. To make this chart disappear, Ctrl-Shift
click on the dispersion image chart.
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3.1 Multi-OT

First

Displays the first dispersion-image (OT) record in the file.

Previous

Displays the previous dispersion-image (OT) record in the file.

Next

Displays the next dispersion-image (OT) record in the file.

Last

Displays the last dispersion-image (OT) record in the file.

Jump

Displays the dispersion-image (OT) record selected in the following dialog.

Stack

All the (dispersion image) records in the input file [*(*OT).DAT] can be stacked to
generate a stacked image that can be saved as a separate file [*(VStack).DAT], as
illustrated below. In this case, surface coordinates of all records will be averaged to be
encoded in the output stacked image file. The following dispersion image illustrates a
stacked image displayed in a separate tab ("Display 2"). The stacked image can depict
the overall subsurface velocity (Vs) variation in the surveyed area from the patterns of
low and high frequency dispersion.
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Add List

Adds record number for the current dispersion image in the view list. The view list can
be cleared by clicking "Clear" button on right. A record number can be manually added
to the list by clicking the add button ( ), or removed from the list by clicking the delete
button ( ).

View List

Displays dispersion images in the order those record numbers are listed in the "View
List."
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3.2 OT

Gain*

Applies automatic gain control (AGC) to the dispersion image in both vertical and
horizontal directions. Detailed patterns of weak energy can be delineated more vividly
as illustrated below (left) when gain is applied to the stacked dispersion image
previously shown. Right click the button to display the control dialog shown below
(right) where the AGC window can be adjusted for both directions.

Refresh

Refreshes the graphical display so that the most recent updates of display parameters
can be accordingly accommodated if not previously done.

Norm

Applies the normalized display along the phase-velocity (vertical) axis so that variation
along the frequency (horizontal) axis can be more emphasized as shown below.

History

Displays the complete processing history that generated the current dispersion image
file, as illustrated below.
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Cut

Displays the following control dialog that allows you to "cut" part (or all) of dispersionimage records in the input file to be saved as another file (*.DAT). Many options are
available for the "cut", which are explained in the PS User Guide "Seismic-Data Display"
(section 3.2).

Header

Views all the header elements of the current dispersion-image record as illustrated
below.
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Info

Displays an information box (shown below) showing key information about the input
file, such as frequency and phase velocity ranges and intervals, surface locations, etc.

Air*

Displays the possible pattern of constant velocity air waves as it appears on the
dispersion image. The image below left shows a constant velocity pattern with velocity
lower than 500 m/sec at frequencies higher than 20 Hz, which coincides with the airwave pattern displayed by white dots on right. Right click the button to show the
control dialog (shown below) where velocity, distance unit, and temperature can be
specified for the air-wave pattern.

Combine*

Combines the current dispersion image with another image to be imported as illustrated
below ("Open" dialog). Once the external image file is imported, the following control
dialog with four (4) tabs will appear where all the combining-related parameters can be
properly set. This dialog can also be display by right clicking the button. Each tab of this
control dialog is explained below.
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Records
Current record and imported record numbers are indicated in the boxes. Relative
amplitude ratio can be specified in the "Exp" boxes that indicate the power to be
applied to each amplitude. If the "Combine imported record to all other records also"
box is checked, then the same imported record will be combined to all the records in the
input file. Combined record(s) can be saved as a separate file (*.DAT) by clicking the
"Save Combined OT As" button. Otherwise, the combining will take place only within
the display window. The imported record can be replaced by a different record by
clicking "Import Other (OT) File" button, and output can be appended to an existing file
(*.DAT) by checking the "Append output" box.
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Combine Options
Both records can be combined "as they are" without any additional operations applied,
or they can be combined "after normalization" applied. The normalization type can be
selected between "Global" and "Frequency" specified in the "Normalization" radio box.
The "Global" option will scale both records so that the maximum amplitudes are the
same, whereas the "Frequency" option will make the maximum amplitudes of each
frequency sample have the same value (e.g., "100"). An additional option is provided in
the "Norm. Amplitudes" box where the normalization amplitudes of both imported and
current records can be specified (for either "Global" or "Frequency" normalization). The
"Mid-Station #" box indicates the surface coordinate (the station number) of the
combined record, which by default is that of the current record.
Attributes
This is a "read-only" tab where information about current and imported records is
displayed; for example, ranges and increments (Min., Max., and Inc.) in frequency,
phase velocity, record numbers, and mid station.
Coordinates
Check the "Combine OT's of same Mid-Station #'s" box to combine only those records
in the current and imported files that have the same surface coordinates (station
number). In this case, the tolerance between the two numbers can be specified in the
"Tolerance of station #'s" box where, for example, a tolerance of "10" indicates that the
program will combine those two records that have the minimum difference in midstation numbers within this range ("10"). Checking the "Update surface coordinates in
combined OT" box will put the averaged surface coordinate in the combined record.
Otherwise, the surface coordinate of the current record will be used for the combined
record.
X-coord

Displays the surface coordinates of all dispersion-image records as illustrated below.
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3.3 Process

F-Sum*

Displays the energy summation of the currently displayed dispersion image along the
frequency axis. The image below is used as an example. On first clicking the button, a
control dialog (on right) will appear (which can also be invoked by right-clicking the
button) that has controls for the summation. The summation range in frequency (HZ)
can be specified in the "Start" and "End" boxes; the phase velocity range can be
similarly specified. Zero ("0") values indicate default values in the input record. The
"Min. amplitude to sum (0.0-1.0)" indicates the lowest amplitudes to be included in the
summation. Check the "Display output in a separate chart" box to display the summed
curve in a separate chart as illustrated below. Check the "Save output data (curve) as a
file (*.dc)" box to save the summed curve as a file (*.DC) with the same format as an
ordinary dispersion-curve file (so that it can be displayed using the same module).
Output file name can be specified by clicking the "Save Output As (*.dc)" button.

To display the phase velocity of a specific peak, select the curve (by clicking the curve
itself or its title in the legend), depress the "Edit" button, and then depress the "Shift"
key while drawing a rectangle around the peak as illustrated below.
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OT-Stk*

On first clicking the button, the following control dialog will appear (which can also be
invoked by right clicking the button) where the number of stacking records on each side
("Previous" and "Next") can be specified. Then, the stacked dispersion image will be
displayed. As long as this button is actively depressed, the displayed image will always
be the stacked image of previous and next records (as well as current record) whenever
navigating through different records.

OT-Filt*

On first clicking the button, the following control dialog will appear (which can also be
invoked by right clicking the button) where the number of stacking samples on each side
("Previous" and "Next") of the current sample in the frequency axis can be specified.
Then, the "smoothed" dispersion image will be displayed. As long as this button is
actively depressed, the displayed image will always be the smoothed image (with
averaged amplitude) of previous and next samples (as well as current sample) whenever
navigating through different records.
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4. Dispersion Analysis

This tab is visible only when a dispersion image is displayed for the purpose of "dispersion-curve
extraction." Detailed explanations about the function of each button and the way they are
implemented are described in the PS User Guide "Dispersion Curve Extraction (1-D Profile)."
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PS - Velocity (Vs) Display (1D Profile)

1. Overview
This module is specifically for the 1-D layered-earth model (*.LYR) that is obtained from the inversion of
one measured dispersion curve (*.DC). In addition to display, this module can perform editing of the
model such as changing velocities and depths of layers and remapping current layer model into different
depth model, etc. It can also apply certain processes such as calculating average shear-wave velocity (Vs)
for a certain depth (or layer) range (e.g., Vs30m), combining with other models, generating an average
model from multiple models, exporting current 1-D (depth) velocity (Vs) structure into an existing 2-D Vs
file, etc. Furthermore, those forward modeling schemes are also included that can generate theoretical
dispersion curves, seismic records, and dispersion images by using the current model displayed as input.
To display a layered-earth file (*.LYR), in the main menu go to "Display" → "S-Velocity (Vs) Data" → "1-D
Vs Profile (*.LYR)" and then select such a file as illustrated below.

The program will ask if the linked (measured and modeled) dispersion curves are also to be displayed.
The information about them is encoded in the input LYR file. If it is chosen by clicking "Yes" as shown
below, then a message box will appear that instructs how to manually edit the input layered-earth
model. This means the "real-time manual inversion" is enabled as shown below.
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The display below shows the shear-wave velocity (Vs) profile of the input LYR file among other
additional parameters included in the file [i.e., Vp, Poissons' ratio (), density (), and Q values (Qs and
Qp)]. The two dispersion curves are also displayed with one of the two vertical axes converted to a
frequency (Hz) axis. The match between the two is indicated on top of the form [e.g., "Dispersion Curve
Match (%): 87.69"]. As velocities are manually changed by using the mouse, the corresponding modeled
dispersion curve will be updated and the new match will be displayed on top so that the manual
inversion can be "steered" in the most favorable direction. In addition, an automatic inversion can be
launched at any stage in the sequence of manual inversion that will use the current model as the initial
model to search for a "better" model that gives an improved match in dispersion curves. This is further
explained in section 8 ("Inversion").
In the vertical tool panel displayed on the right side of the form are arranged those buttons that can
display layer parameters such as depth ("Z"), shear-wave velocity ("Vs"), P-wave velocity ("Vp"),
Poisson's ratio (""), density (""), and Q-values ("Qs" and "Qp"). The "Vs/Vp" button, if depressed, will
ensure the ratio between the two velocities (Vs and Vp) remains unchanged when either of the two is
manually changed. Otherwise, the Poisson's ratio () will be updated in response to the change of
either velocity (Vs or Vp). The "Vs30m" button will evaluate the seismic site classification code based on
the designation by National Earthquake Hazard Reduction Program (NEHRP) and the International
Building Code (IBC) and display the result inside the chart. Examples of all these cases are illustrated
below.
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Velocities (Vs and Vp) are displayed on the left, and Poisson's ratio () is displayed on the right.

Density () (on the left) and Q values (Qs and Qp) (on the right) are displayed below.

The "Vs30m" is calculated and seismic site class ('C') has been assigned in the chart below.
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The top tool panel contains eight (8) tabs: "Files", "View", "Edit", "Chart", "Layer", "Dispersion",
"Inversion", and "Seismic." The type of task performed by each tab is explained below.
Files

Another file can be opened to replace the current file or to be added into the current
display. The current layered-earth model can be saved into another file (*.LYR) or its
image can be saved as a graphic file (*.BMP; *.JPG). The current chart image can be
printed, or its contents (i.e., numbers and text) can be printed. Dispersion curve(s) can
also be imported as a comparison with modeled dispersion curve.

View

Chart graphic related parameters can be changed such as axis scales, grid lines, etc.
Contents of the current file (*.LYR) can be viewed in a separate window. The seismic
site classification table (*.PDF) can also be displayed.

Edit

The current model can be changed manually by using the mouse or typing values in the
appropriate boxes displayed in a tabular form. A new layer model can be created.

Chart

All chart controls are included that can control display attributes of layer parameters.

Layer

Layer-related operations can be performed such as stretching the depth scale,
calculating average velocity (Vs or Vp) for a specified range, generating an average layer
model (*.LYR) from multiple models, summing (or subtracting) two models, remapping
into another "reference" depth model, etc.

Dispersion

Theoretical dispersion curves of any mode (e.g., fundamental, 1st higher, 2nd higher,
etc.) can be generated via forward modeling by using current velocity (Vs and Vp) and
density () model as input. Detailed explanations about this modeling are provided in
the PS User Guide "Modeling Dispersion Curves."

Inversion

Automatic inversion can be performed that uses the current velocity (Vs) model as the
initial model. Complete inversion parameters can be controlled that are fully explained
in the PS User Guide "Inversion."

Seismic

A seismic record and the corresponding dispersion image can be generated from the
current model that includes velocities (Vs and Vp), density (), and Q values (Qs and Qp).
Details about this modeling is provided in the PS User Guide "Modeling Seismic Data."
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2. Files

Open

Opens a different layered-earth file (*.LYR) to replace the current one.

New

Opens another layered-earth file (*.LYR) to display in the same chart.

Save

Saves the current layered-earth file as a separate file (*.LYR).

*.bmp

Saves the current chart image as a graphic file (*.BMP, *.JPG).

Print (

)

Prints the current chart image.

Print (

)

Prints contents (i.e., numbers and texts) of the current layered-earth file (*.LYR).

Open DC

Opens and displays a dispersion curve file (*.DC).
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3. View

Grids

Displays dotted horizontal and vertical grid lines on the chart.

X*

Increases (right click = decreases) horizontal axis scale.

Y*

Increases (right click = decreases) vertical axis scale.

Data

Displays data values of a layered-earth file for a complete set of variables as shown
below.

Contents

Shows complete contents (i.e., data values and processing history) of the file.

History

Shows only the processing history portion of the file.

Bounds

Displays (as illustrated below) numerical limits (lower and upper bounds) of each layer's
velocity (Vs) that fall under 99% confidence of inversion. This evaluation is based on the
numerical sensitivity of the Jacobian matrix used during the inversion process.

7

PS - Velocity (Vs) Display (1D Profile)

DC's

If the displayed file (*.LYR) is an inversion output, then the corresponding dispersion
curves (i.e., "measured" and "modeled" curves) can be displayed, if chosen (i.e., "Yes"
below).

Delete

Dispersion curves currently displayed (except for the "modeled" curve) will be deleted.

Vs30m

Displays the seismic site classification table (*.PDF) adopted by National Earthquake
Hazard Reduction Program (NEHRP) and the International Building Code (IBC) as shown
below.
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4. Edit

Edit LYR (

)

Show

Edit LYR (

Depress the Edit LYR button to enable editing of the model displayed in the chart. A
message box (shown below) will appear to instruct how to do it. To change the value of
any layer, click and drag the layer's bar (vertical) line horizontally (left and right). To
change the depth of any layer, click and drag the (top or bottom) boundary (horizontal)
line vertically (up and down). For this, the depth ('Z') button in the tool panel on the
right side must be depressed. Instead of using the mouse, values can be typed in when
the "Show" button is depressed as explained next. [Why italics?]

If this button is depressed, a separate panel will appear on the top of the chart (shown
below) where edit boxes are arranged. Value of individual variables (e.g., Vs, Vp, etc.) in
the displayed model (*.LYR) can be changed by typing in the appropriate box. Display of
the model will be accordingly updated as values are changed.

)

Click the button for a separate display where numerical values of all layer variables are
displayed in a table (shown below). Individual items can be changed by manually typing.
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New LYR

Click this button to replace the current layered-earth model (displayed in the chart) with
a new model with initial values that can be specified in the dialog as shown below.

Remap

The current layered-earth model can be remapped according to a new depth model,
which is defined by another ("reference") model. The following message will appear
and then a file for the new depth model will have to be imported as shown below. The
current layered-earth model will be accordingly updated on the display.

Unit

Click this button to change the distance unit of the model. Two options are available;
(1) simple change of labeling and (2) converting values of related data into those of the
other unit. The dialog shown below illustrates the two options.
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5. Chart

Show All

Displays the following control dialog that contains all the chart-related controls. A full
description of common chart controls is provided in the PS User Guide “Chart Controls."
The "Curve To Apply" box at the bottom of the dialog below is unique to this module of
1-D Vs display. Click an appropriate item in the box to select the corresponding variable
in the model to apply the changes.

Data

Displays the dialog above with the "Data" tab opened.

Axis

Displays the dialog above with the "Axis" tab opened.

Label

Displays the dialog above with the "Labeling" tab opened.

Panel

Displays the dialog above with the "Panel" tab opened.
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6. Layer

Scale*

Depth scale of current layer model can be enlarged (normal click) or reduced (right click)
by a preset amount (10 %) each time the button is clicked. The example below shows
how the original layer model (left) is enlarged in depth scale after a few normal clicks
(right).

Vave

Average velocity (Vs or Vp) can be calculated for a specified range of depth or Layers. A
control dialog will appear as shown below where the type of velocity ["S-Velocity (Vs)"
or "P-Velocity (Vp)"] can be selected. Type of average can also be selected in the
"Average type" box where either "Depth" (left) or "Layers" (right) can be selected. If
the former is selected, then the maximum depth is specified in the "Maximum depth
(Zmax)" box. If the latter ("Layers") is selected, then a separate box will appear where
the layer range is specified in the "Start No." and "End No." boxes. If the last layer
("Half Space") is included in the range, then its depth ratio (used during the calculation
of relative contribution) is specified in the "Half-Space (HS) Ratio*" box.

Click "OK" button to show the calculated average velocity. The two examples shown
below illustrate the output values in the above two cases of average type.
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Average

This will produce an average model (*.LYR) from multiple models (*.LYR's) to be
imported. The existing model(s) currently displayed will not be automatically included
in the average process. On clicking the button, this information will be displayed in the
message box shown below ("INFO" box). Then, a multiple number of LYR files will have
to be imported that may have different depth models (i.e., different number of layers
and different maximum depths) as shown below ("Open" dialog). Then, another
message box (2nd "INFO" box) will indicate a "reference" file will have to be imported
that will be used as the depth model for the output file (*.LYR) (2nd "Open" dialog).
Then, the last message box (last "INFO" box) will instruct how to specify the output file
name (*.LYR) ("Save As" dialog). Then, the output will be displayed in the current form
by replacing the previous model as shown below.
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Bounds

Theoretical limits of velocity for each layer (i.e., lower and upper bounds) can be
calculated based on each layer's sensitivity on the "reference" dispersion curve. Then,
calculated bounds can be used as relative confidence levels if the model (*.LYR) is an
inversion output from a measured dispersion curve (*.DC). In this case the velocity
range between the two limits may indicate such a range within which the "true"
solution can exist with a certain probability, for example, of 99%. In this sense, the
bounds of each layer can represent relative confidence levels. On the other hand, if the
current model is not an output from inversion and there is no measured and modeled
dispersions curve linked to it, then a "fictitious" dispersion curve can be modeled within
a specified frequency range and then the bounds calculated based on this curve. In this
case, the calculated bounds can represent the relative "accuracy" level of each layer
that can be evaluated from a possible MASW survey over such a velocity model.
If the current model (*.LYR) is an output from the inversion of a measured dispersion
curve (*.DC), then the program will calculate the bounds based on the measured
dispersion curve specified within the model file (*.LYR). In this case, existing bounds
(calculated during the inversion process) will be replaced by the new calculations as
informed by a message box shown below (on the left). If there is no dispersion curve
linked to current model (*.LYR) (or if the measured dispersion curve is not found), the
following dialog (on the right) will appear where the frequency range can be specified to
design a "fictitious" curve in the "Start..." and "End..." boxes. The "Bounds limit..." is an
arbitrary amount of overall change in dispersion curve to calculate the bounds.
"Account for mode jump" and "Use 'Lamb-Wave' approximation" are applied only
when the velocity model includes "significant" velocity inversion on top (see PS User
Guide "Modeling Dispersion Curves" for more details). Calculated bounds will be
displayed in the chart at the end.
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+/- (

)

Two layered-earth model files (LYR's) (one currently displayed and one to be imported)
can be added (+) or subtracted (-). When this button is clicked, the following dialog will
appear where the operation type ["Subtract (-)" or "Add (+)"] is specified. Then,
another dialog will ask if output is to be in percent (%). (The example below shows a
choice of "No.") Then, open the other file (*.LYR) and specify output file name (*.LYR).
(The example below opens the same file for demonstration purposes.) The output
summed file (in red) is displayed below along with the original file (in blue) to illustrate
what it looks like. The two files have to have a common (the same) depth model to
perform this operation.
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2-D Vs

Current 1-D shear-wave velocity (Vs) model can be written as part of the 2-D velocity
(Vs) cross section. It can be added to an existing file if the "Append output" box is
checked. Check the "Export confidence data if exists" box if the confidence estimation
(calculated from bounds of each layer) is also written in the separate file, whose file
name has a post fix of "(2DConf).txt" after the output file name specified by clicking the
"Output File Name [*(2DVs).txt]" button. Surface (X) location can be specified in the
"Output surface (X) coordinate" box where the default value is copied from the input
file (*.LYR) if it has such information in it.
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7. Dispersion

RUN

Generates dispersion curve(s) from the current layered-earth model (*.LYR) displayed in
the chart by running forward modeling. On clicking the button, the control dialog (on
the left) will appear where parameters of the dispersion curve (e.g., frequency range,
frequency interval, number of data points, etc.) can be specified. See PS User Guide
"Modeling Dispersion Curves" for detailed explanation about this dialog. Click "OK" and
the calculated dispersion curve will be displayed on the chart as illustrated below. It can
be noticed one of the two vertical axes is now converted into the frequency (Hz) axis.

Edit RUN

If this button is depressed, then the dispersion-curve generation will take place in real
time as a response to an edit of the layer model by using the mouse (e.g., changing
velocity or depth of a layer). The message box below (on the left) informs about this.
However, for this to take place, the layer-edit mode has to have been enabled by
depressing the "Edit LYR" button in the "Edit" tab of top tool panel. Otherwise, the
program will instruct as illustrated below (on the right).

The following example illustrates how the 5th layer's velocity (Vs) is changed by using
the mouse after depressing the "Edit RUN" button; the calculated dispersion curve is
displayed with one of the two vertical axes (right axis) converted into a frequency (Hz)
axis. A control dialog for dispersion-curve generation may appear first if not previously
displayed.
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Ctrls

Displays the control dialog shown below that contains all the parameters related to the
forward modeling of dispersion curve(s). See PS User Guide "Modeling Dispersion
Curves" for details.

Frq

The control dialog will appear with the "Frequency (Hz)" tab selected where frequency
related parameters can be specified as illustrated above.

Root

The control dialog will appear with the "Searching option" tab selected where "root
searching" parameters (in solving the characteristic equation) can be specified as
illustrated below.
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Inverse

The control dialog will appear with the "Inverse velocity (Vs)" tab selected where those
parameters related to "inverse velocity" structure of input velocity (Vs) model can be
specified as illustrated below.
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8. Inversion

This inversion tab enables the inversion of a measured dispersion curve through forward modeling.
Therefore, the layered-earth model (*.LYR) currently displayed must be an inversion output and the
corresponding measured dispersion curve has to be displayed also. The message dialog (below left)
indicates the input file is an inversion output file and asks if the measured dispersion curve should be
displayed. Click "Yes" to display it and then another message box will appear as shown (below right)
that instructs how to change an individual layer’s velocity and depth.

When the file (*.LYR) is displayed with corresponding (measured and modeled) dispersion curves as
shown below, then the match between the two curves is displayed on top of the form [e.g., "Dispersion
Curve Match (%): 87.69"] that is the best match found from the previous inversion process. Then, all the
buttons (i.e., options) will have been set so that the manual layer edit by mouse is enabled and the
corresponding real-time update of modeled dispersion curve is also enabled. Then, the new match will
be displayed on top to indicate whether the updated velocity model is a "better solution" or not. The
example shown below illustrates this improvement of match that changed from 87.69 % to 87.94 %
(indicated by red arrow) after the 5th layer's velocity has been changed (indicated by the yellow arrow).
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RUN

Clicking this button will launch the "automatic" inversion that uses the current layeredearth model displayed on the chart as the initial model. The process will update the
model only when it can find a "better solution" as described above. The example below
illustrates a case in which the match further improved from 87.94% to 91.08%. By
properly combining the manual inversion described above and this automatic inversion,
it is possible to find a velocity model that is most accurate from the numerical
perspective and yet more realistic.
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Ctrls

Display the following control dialog that contains all the parameters related to the
automatic inversion. See PS User Guide "Inversion" for detailed description of these
parameters.
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9. Seismic

Multichannel seismic record(s) can be modeled using the current 1-D (depth) model (*.LYR) displayed on
the chart as an input layered-earth model. This is the modeling by the reflectivity method described in
the PS User Guide "Modeling Seismic Data." On clicking the button, the following control dialog will
appear that contains all the parameters related to the modeling. See the PS User Guide ("Modeling
Seismic Data") for detailed description of these parameters.

The following illustrates the modeling output of a seismic record (left) and the corresponding dispersion
image (right) calculated from the layered-earth model last displayed.
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PS - Velocity (Vs) Display (2-D Cross Section)

1. Overview
This module is primarily for the display of inversion results of 2-D shear-wave velocity (Vs) cross sections
[*(Vs2D).TXT]. However, other types of text data produced from various stages during the use of this
program can also be displayed by using this module. Examples may include the 2-D Vs confidence map
[*(2DConf).TXT], Young's modulus map [*(YoungsModulus).TXT], Shear modulus map
[*(ShearModulus).TXT], depth-slice map [*(DS).TXT], etc.
In addition to the purpose of display, this module can also perform editing of input data such as
changing surface (or depth) coordinates in the Vs cross section file. It can also apply certain processes,
such as generating a depth slice map from multiple Vs cross sections, generating an average 1-D Vs
profile, converting Vs data into Young's and Shear modulus data, and so forth.
To display one of these files, in the main menu go to "Display" → "S-Velocity (Vs) Data" → "2-D Vs Cross
Section (*.TXT)" and then select a text file, as shown below.

The module has a top tool panel consisting of five (5) tabs: "Files", "View", "Edit", "Process", and "Chart",
as shown below. Types of task controlled by each tab are briefly described below.
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Files

Another file (*.txt) can be opened to replace current file displayed, or to display it in a
new tab (e.g., "Display 2" tab). A multiple number of files (up to ten [10]) can be
displayed in different tabs. This makes it convenient, for example, to compare 2-D Vs
cross sections from different sites, different processing sequences, with different display
attributes, etc. The chart image can be saved and printed. A complete set of chart
control variables can be saved as default and then can be retrieved whenever necessary.

View

All display attributes can be accessed and controlled. A complete listing of the previous
processing history can also be displayed if the file [e.g., *(HST).TXT] was saved. Contents
of an input data file can also be viewed. The Vs confidence map [*(2DConf).TXT] can be
displayed in the next tab. The complete description of all chart-related controls is
provided in the PS User Guide "Chart Controls."

Edit

Values and related labels in the input file can be edited. For example, the distance unit
can be changed, or surface coordinates can be shifted by a certain value. The interpreted bedrock topography can be digitized and corresponding coordinates can be
saved as a separate file (*.TXT).

Process

Input data can be processed to generate various types of other useful data. For
example, Vs values can be converted to Young's (E) and Shear () moduli by providing
density and Poisson's ratio information, which can be typed in (for constant values), or
imported from an external file (*.TXT) (for variable values). Depth (Z)-slice maps
[*(DS).TXT] can be generated from a multiple number of Vs cross sections obtained from
parallel survey lines. Two cross sections can be subtracted or added for specific
comparison purposes. The entire data can be averaged to generate an average 1-D
(depth) profile [*(2DVs).LYR]. The bedrock topography can be drawn on the cross
section by the program from a value specified for the iso-velocity contour line (e.g., Vs =
500 m/sec).

Chart

Complete or a portion of the chart-related variables can be saved or retrieved simply by
clicking one button.
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2. Files

Open

Opens another file (*.txt) to replace current file displayed.

New

Opens another file (*.txt) to be displayed in a new tab. The following example shows
the display window with three (3) files opened on three different tabs ("Display 1",
"Display 2", and "Display 3").

*.bmp

Saves chart image as a graphic file (*.bmp, *.jpg).

Print

Prints the current chart image with additional information that can be specified in a
separate control dialog to follow.

Export

Saves all current settings for chart display as a separate data base file (*.DB_), as
illustrated below.

Import

Imports a previously saved file (*.DB_) that contains all chart display settings, as
illustrated below.
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3. View

Controls

Shows a dialog that contains all the chart controls, as shown below. Functions of this
control dialog are explained in PS User Guide "Chart Controls."

Grid

Displays dotted horizontal and vertical grid lines on the chart.

X*

Increases (right click = decreases) horizontal chart scale. Click chart axis for dialog.

Y*

Increases (right click = decreases) vertical chart scale. Click chart axis for separate dialog.

Zoom

Zooms in a specific area in the chart by drawing a rectangle with the mouse.

Full Size

Displays input data set in its full range in both horizontal and vertical axes.

Refresh

Refreshes the current chart image to apply the most current changes made.

Contents

Displays 3-column data of the input file in a separate window, as illustrated below.

History

Displays a separate history file (if it exists) that contains a complete history of previous
processing, as illustrated below.
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2D Conf

Displays 2D velocity (Vs) confidence file [*(2DConf).txt] corresponding to the 2D velocity
file [*(2DVs).txt], as illustrated below. The confidence distribution indicates numerical
sensitivity during the inversion that can be used as an indirect measure of confidence
level at the corresponding area of the 2D velocity (Vs) cross section.

Click a chart axis to display a separate axis control dialog, as shown below. The following dialog appears
on clicking the depth axis of the chart above.

Axis range can be specified by putting values in the "MIN" and "MAX" boxes. Increment of axis labeling
is specified in "INCREMENT" box. Check "Grid visible" box to display dotted grid lines overlapped on
chart. Check "Automatic scale" box if the scale is to be automatically configured based on the input data
range. Check "Grid to data limits" box to limit the gridding range only within the input data range.
Otherwise, gridding can be extended outside the data limits.
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4. Edit

Digitize

If this button is depressed, then the following message box will appear. The message
instructs that a multiple number of points in the chart can be clicked that may follow a
certain horizon of interest in the chart (for example, the interpreted bedrock
topography). The 2D Vs cross section below illustrates this procedure.

Once all points of interest are clicked, then depress the "Digitize" button to save the
points as a separate file (*.txt), an example of which is opened below using Notepad.
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Edit Values (

)

Values in the input file (*.txt) can be edited in various ways. For example, the
surface (X) coordinates in the input file (i.e., the 1st-column values) can be
increased by "10.0", as illustrated below in the control dialog that will appear
once this button is clicked. The type of variable can be selected in the "Variable
to edit" radio box, and the type of operation can be selected in the "Operation"
radio box. The amount of edit can be specified in the "Edit Value" box.
If the distance unit is to be changed, then select the "Convert Distance Unit" tab
where the specific unit, "feet" or "meter", can be selected.

Labels for the horizontal and vertical axes can be edited in the "Axis Labels" tab.
In this case, make sure to check the "Update Axes Labels" box after editing the
necessary labels. Click the "OK" button to save the edited data as a separate file
as illustrated below [*(Edit).txt].

8

PS - Velocity (Vs) Display (2-D Cross Section)

5. Process

Bedrock*

A line of iso-velocity (Vs) (for example, Vs = 500 m/sec) can be drawn on top of the
current chart image to represent an interface of specific interest (e.g., overburden/
bedrock interface). Click the button to draw the line as illustrated below, the velocity
(Vs) of which can be specified in a separate control dialog, also shown below.

The iso-velocity can be specified in the "Contour velocity (m/sec)" box. The "Min.
search depth" indicates the minimum depth below which the searching will start. The
"Curve smoothing (%)" will apply the moving-window smoothing (i.e., averaging) to the
original searched line. The attributes of the contour line can be specified in the
"Contour Line Attributes" box that includes "Line width", "Mark style", and "Color..."
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1-D Vs

The average 1-D velocity (Vs) can be generated by summing all the velocity values along
the surface direction in the chart. Then, this 1-D Vs model is saved as a separate
layered-earth file (*.lyr) as illustrated below. The output is saved with "(AveVs)" post fix
at the end of the file name. The chart below shows the average 1-D Vs of the saved file.

Z-Slice

A depth-slice map [*(DS).txt] can be generated from multiple 2-D Vs cross sections
oriented in parallel with each other. First, open multiple 2-D Vs cross sections in
different tabs (e.g., "Display 1", "Display 2", etc.). Then, select a specific display (e.g.,
"Display 1") and click "Z-Slice" button to invoke the following control dialog.
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The dialog above shows that a depth-slice map will be created for the 5-10 m depth
range as specified in "Begin" and "End" boxes. A transverse (Y) coordinate ("-5") is
specified in the "Orthogonal (Y) coordinate" box. Then, click "Save To (*.txt)" button to
specify the output file name, as illustrated below. If output data is to be added to an
existing file [*(DS).txt], then make sure the "Append output" box is checked. Also, check
the "Update labels" box to carry the new labeling information into the output that can
be specified in the "X-axis (longitudinal)", "Y-axis (transverse)", "Map title", and "Value
title" boxes. Click the "OK" button to output current depth-slice data.

A message box like the one below will indicate the current depth-slice data will be saved
as a separate file (*.dc) in the same format used in the dispersion-curve file (*.dc) so
that it can be displayed using the same module (go to "Display" → "Dispersion Data" →
"Dispersion Curve" in the main menu).

The following depth-slice map [*(DC).txt] is opened using the same module used to
display a 2-D Vs cross section (i.e., "Display" → "S-Velocity Data" → "2-D Cross Section"
in the main menu).
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This depth-slice map previously displayed was created using the same (instead of
different) 2-D Vs cross sections displayed in three (3) different tabs. However, three
different longitudinal (Y) coordinates (-5, 0, and 5) were assigned for the "Orthogonal
coordinate" during the construction (to simulate cross sections at different transverse
locations). The individual output from one 2-D Vs cross section that was previously
saved as a dispersion-curve file (*.dc) is displayed below to illustrate what it may look
like.

Sum/Subtract (

) Two 2-D Vs cross section files can be summed together or one can be
subtracted from another. Click the button to display the following control
dialog. The file displayed in the selected tab (e.g., "Display 1" tab) is always
considered to be the "Current File." Then, choose an operation in the yellow
box [i.e., sum (+) or subtract (-)]. The "Target File" can be selected from the files
listed in the combo box to the right that shows all the files open in different tabs.
Default is the one adjacent to current file (i.e., next or previous file). Click
"Output" button to specify the output file name and path.

Check "Apply to GRID's" box if the operation is to be applied to the grid data of
each file that is already created at the time of display. Otherwise, the operation
will be applied to the original data set in the input text files by applying
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interpolation (and extrapolation if necessary) to the appropriate surface
locations. Check the "Output in percents (%)" box if output data are to be
scaled in percents (with respect to the current file). Check "Display Output" box
to display the output automatically.
Check "Update Axis Labels" if output data will have different labels, and update
them accordingly in the "X-axis (longitudinal)", "Y-axis (transverse)", "Map
title", and "Value title" boxes. The "Y-axis (transverse)" is the depth axis for a
2-D cross section.
The example below tries to subtract (-) the cross section in "Display 2" from the
one in "Display 1" tab, both of which are inversion outputs from the same set of
dispersion curves. In this case, the purpose of this operation is to check where
major differences exist between the two outputs from the same input data set.
The subtracted results are displayed in "Display 3" tab.

Young's

Shear-wave velocities (Vs's) in the 2-D cross section can be converted to Young's
where  = density (kg/m3) and =
modulus (E) using the equation of E=2
Poisson's ratio. Two additional variables, density () and Poisson's ratio ( ), have to be
provided. Click this button to display the following dialog where two options are
available for that: (1) use constant values for both, and (2) import an external text file
that contains the distribution of both in 4-column format; X, Z, , and (an example file
is displayed later). Both cases are illustrated below.
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Check the "Use constant values for both" to use constant values throughout the entire
section. Then, the following dialog will appear where both values can be entered. Click
"OK" and then another dialog to specify output file name (*.txt) will appear. The output
will be displayed in another window as illustrated below where output values are
displayed in 50-5000 MPa.

The following illustrates the option of using an external file. Check the "Use a text file
with a format: [X Y (or Z) Rho Pos] without []" and click the "OK" button. A file open
dialog ("Open Density & Poisson's Ratio File") will appear and in this example the file
"RhoPos.txt" is imported, contents of which are shown below in Notepad. Click "OK"
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and a "Save As" dialog to specify output file name (*.txt) will appear. The output will be
displayed in another window, as illustrated below, where output values are displayed in
10-10000 MPa. A message dialog will also appear that indicates separate text files of
density [*(Density).TXT] and Poisson's ratio [*(Pos).TXT] will be generated and saved.
Both of these saved files are also displayed below.
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Shear

Shear-wave velocities (Vs's) in the 2-D cross section can be converted to Shear modulus
, where  = density (kg/m3). Therefore, one additional
() using the equation, =
variable of density () has to be provided. Click the button to display the following
dialog where two options are available for that variable: (1) use constant value of  for
the entire section, or (2) import an external text file that contains the distribution of  in
3-column format—X, Z, and  (an example file is displayed later).

Check "Use a constant value" to use a constant value throughout the entire section.
The following dialog will appear where the value (e.g., "2000") can be entered. Click
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"OK" and then a "Save As" dialog will appear for you to specify output file name (*.txt).
The output will be displayed in another window, as illustrated below, where output
values are displayed in 50-5000 MPa.

The following is an example of choosing the "Import a text file with a format: [X Y (or Z)
Rho] without []" option. Click the "OK" button to close the dialog and the "Open
Density File" dialog will appear. Choose the external file ("Rho.txt"), contents of which
are displayed in Notepad containing density values at two different depths (Z = -1.0 and
-15.0) and at two different locations (X = 20 and 70). Once the file is imported, the
output shear modulus map will be displayed, as illustrated below, where values are
displayed in 50-5000 MPa.
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6. Chart

Chart control variables of the current display (e.g., axis range, color scale, etc.) can be saved as default
by clicking the "Set" buttons, while the saved default variables can be retrieved by clicking the "Get"
buttons. The entire set of variables are saved and retrieved by clicking the Set ( ) and Get ( )
buttons, respectively. Axis variables (minimum, maximum, and increment) for the horizontal axis are
saved and retrieved by the Set (
) and Get (
) buttons, respectively. Axis variables for the
vertical axis are saved and retrieved by the Set (
) and Get (
) buttons, respectively. The color
bar variables (minimum, maximum, and value title) are saved and retrieved by the Set (
) and Get
(
) buttons, respectively.
When the "Get" button ( ) for the entire set of variables is clicked, the following dialog will appear
where individual variables can be selected to import.

19

ParkSEIS User Manual

8.6

Chart Controls

ParkSEIS

MASW

PS - Chart Controls

Table of Contents
Page

1.

Data

2

2.

Axis

3

3.

Labeling

4

4.

Panel

5

5.

Drawing

6

6.

Complete Gridding Controls

8

1

PS - Chart Controls

1. Data

File to apply

Selects the specific dispersion curve file, if multiple curves exist in the chart, to
which the changes will be applied.

Line

Line style of curve can be selected. "Thickness" will be applied to the selected curve.
If "For All" box is checked, then the displayed thickness will be applied all curves in
the chart. "Color" will determine the line color for the selected curve.

Mark

Style of mark for each data point (e.g., circle, rectangle, etc.) can be selected, and its
"Size" can be specified. If "For All" box is checked, then the displayed size will be
applied to all curves in the chart. "Color" will be applied to the marks of the
selected curve.

Curve to apply

Can choose if changes are to be applied to dispersion curve, signal-to-noise (SN)
ratio curve, or both.

The "Display overtone record if exists" box, if checked, will display the corresponding dispersion image
("overtone record") on the background. This applies only if the curve was extracted previously from a
dispersion image and the corresponding overtone record exists. This information is encoded in the
dispersion curve file (*.dc).
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2. Axis

Horizontal

"Axis" placement (top or bottom) for horizontal direction, and value range ("MIN",
"MAX", and "Increment") can be specified. If "Grid visible" box is checked, then vertical
dotted grid lines will be drawn. Format of axis labels can be specified in "Values
Format" box. Axis title is specified in "Title" box. Fonts for axis title and labels can be
specified by clicking "Title Font" and "Label Font" buttons, respectively.

Vertical

"Axis" placement (left or right) for vertical direction, and value range ("MIN", "MAX",
and "Increment") can be specified. If "Grid visible" box is checked, then horizontal
dotted grid lines will be drawn. If "Log Scale" box is checked, then the axis scale will be
in logarithmic scale. Format of the axis labels can be specified in "Values Format" box.
Axis title is specified in "Title" box. Fonts for axis title and labels can be specified by
clicking "Title Font" and "Label Font" buttons, respectively.

If "Auto Scale Axes" box is checked, then both horizontal and vertical axes scales will be determined
automatically based on the value ranges.
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3. Labeling

Title

Chart title is specified in the box. Its alignment can be selected in the "Alignment" radio
box. Title font can be specified by clicking "Font" button.

Legend

Legend location can be selected in the "Position" radio box and will be visible only if
"Visible" box is checked. Legend font can be specified by clicking "Font" button.

If "List file name" box is checked, then name of the input file will be shown at the bottom of the chart.
If "Draw distance scale" box is checked, then a line scale will be drawn at the bottom of the chart for the
distance specified in the "Distance" box.

4

PS - Chart Controls

4. Panel

Bevel

Beveling of the chart boundary can be specified by selecting appropriate types for
"Inner" and "Outer" beveling. Overall size of the beveling can be specified by a
value in the "Width" box.

Gradient

Chart can be gradually colored by combination of two colors if "Panel Gradient
Visible" box is checked. Direction of the coloring can be selected in the "Direction"
radio box. Two colors can be selected by clicking "Start Gradient Color..." and "End
Color..." buttons.

"Panel Color..." will determine the color to paint the entire form outside the chart boundary.
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5. Drawing

Color Scale

Color spectrum can be adjusted by moving node points indicated by upside-down
triangles at the top of the bar. Colors between node points will be linearly
interpolated. Value ranges for the color scale in the bar can be specified by entering
values in "MIN" and "MAX" boxes. Name of the color scale (e.g., "S-Velocity
(m/sec)", etc.) can be specified in the "Title" box. If "Full Range" box is checked,
then the value range (i.e., "MIN" and "MAX") will be set to the minimum and
maximum values of the input data set. "% Scale" will make, if checked, the value
range in percent (%) scale by entering "MIN" and "MAX" with "0" and "100",
respectively. "Gray Scale" box, if checked, will make the color spectrum a gray scale
that is a linear combination of white and black colors. Default button ( ) will
make the current color scale a default, which can be restored by clicking the restore
button ( ). Current color scheme can be saved as a separate file (*.CLR) by clicking
the "Save" button, and a saved file (*.CLR) can be imported by clicking the "Import"
button.

Interpolation

In the Gridding tab the gridding method can be selected from one of the two
options specified in the "Method" radio box—"Bilinear" and "Inverse Distance
Weighted (IDW)." Gridding controls can be accessed by clicking "Complete
Gridding Controls" button. "Smoothing" will apply averaging of color values along
the horizontal and vertical directions. If checked, "Grid to horizontal limits" will
apply extrapolation of data outside the horizontal (i.e., left and right) boundaries
determined by the input data. If checked, "Grid to vertical limits" will apply
extrapolation of data outside the vertical (i.e., top and bottom) boundaries
determined by the input data.
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Interpolation

In the Display tab the normalization method can be selected in the "Normalization"
radio box. Display gain in decibels can be specified in "Display Gain (DB)" box. The
value specified in the "Display Power" will be applied as a power to the input data
before calculation of the corresponding pixel color. A Display Power value higher
than one (1) will emphasize the main trend of variation such as the pattern of
fundamental-mode energy in the dispersion image display. If the "Full data size
display" box is checked, then display will always be limited within the range of the
input data set without any extrapolations applied.

Surface Data Points By default all surface coordinates of input data are listed in the box. Data points at
individual surface locations can be selected or deselected by checking or unchecking the corresponding items in the box. The chart image will update only after the
"Update Image" button is clicked. Real-time update can be applied on the chart
itself by clicking the "Data Points" marks (triangles) indicated at the bottom of the
chart as illustrated below.

Click "Update Image" button at the bottom of the control dialog whenever changes are made.
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6. Complete Gridding Controls

Gridding controls are displayed above; on the left "Bilinear" gridding interpolation is selected, and on
the right "IDW" gridding interpolation is selected.
Input File (*.TXT)

Lists name and location (file path) of input data file (*.TXT). This is a noneditable area.

Input TXT Data

Lists complete set of input data in X (surface) and Z (depth) coordinates and
also in value. Ranges ("MIN" and "MAX") are displayed for both coordinates.
This is a non-editable area.

Size of Output Grid (*.GRD) Size of the grid data can be specified by entering specific values in
"Minimum", "Maximum", and "Interval" boxes for both X and Z coordinates.
The "Number of data points" in the output grid will be accordingly updated
as values are changed. Conversely, the value in "Interval" box will be
updated as the value in "Number of data points" is changed. The "Y3D" box
indicates the transverse (Y) coordinate for the current 2D grid, which is used
for 3D gridding. The "Smoothing" box, if checked, will apply the movingwindow averaging of data values in the calculated grid by the amount (%)
specified in "X (%)" and "Y (%)" boxes.
The "Gridding Interpolation" radio box is used to select a specific type of
interpolation method ("Bilinear" or "IDW") when generating the grid data.
The IDW method will take a significantly longer computation time. If “IDW”
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is selected, then additional controls will appear in the lower part of the
window, as illustrated in the above dialog on right.
The "Interpolation at Input Locations" radio box contains interpolation
options to be applied to each surface (X) location of input data. Then, the
method chosen in "Gridding Interpolation" radio box will fill the data
between those surface locations of input data.
If the "Non-Negative Value" box is checked, then interpolated data will
always be positive values.
When the inverse-distance-weighted (IDW) interpolation method has been selected, additional options
are available (shown in the above dialog on right). In the "Weighting for Spatial Direction" box, the
"Vertical" and "Horizontal" slide bars indicate relative weights applied to the vertical and horizontal
distances, respectively, when a specific data point is used to calculate its contribution to the value at
current location. The "Distance Weighting" slide bar indicates the relative power used in the inverse
weighting function. The "weaker" weighting means a higher power in the denominator of the inverse
function.
Output Grid File

Whenever a grid data is generated, it is automatically saved in the same
location where input data file (*.txt) exists. This location can be changed by
clicking the "Browse..." button.
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1. Overview
A (Rayleigh) dispersion curve consists of phase velocities at different frequencies that represent
theoretically possible propagation modes of (Rayleigh) surface waves. For a given frequency, there are
multiple phase velocities at which surface waves can travel; the slowest velocity is called the
fundamental mode (M0), the next higher velocity is called the 1st higher mode (M1), the next higher
one is called the 2nd higher mode (M2), and so on. Collection of such phase velocities of the same
mode is called the fundamental-mode (M0) dispersion curve, the first higher mode the (M1) dispersion
curve, and so on. In theory, the ultimate governing equation that predicts possible phase velocities at a
given frequency is the elastic-wave equation (Sheriff and Geldart, 1982). A derived formulation predicts
that phase velocities are determined by solving a characteristic equation (also called "dispersion
function") of a layered-earth model that consists of shear-wave velocity (Vs), compressional-wave
velocity (Vp), and density () parameters assigned to horizontally homogeneous layers of different
thicknesses (h's). In practice, however, numerical approaches are taken to find the closest values
("roots") to the theoretical solutions. According to Schwab and Knopoff (1972), roots to the dispersion
function are searched by continuously changing the possible phase velocity for a given frequency until
the function becomes the opposite sign—a numerical method called the bisection (Press et al., 1992).
This module of the ParkSEIS calculates Rayleigh-wave dispersion curves based on the FORTRAN IV
program presented in Schwab and Knopoff (1972). The input to this module is a layered-earth model
(*.LYR) that can be obtained either as an output from the inversion of a measured dispersion curve or as
a separate model artificially created by using the "1-D Vs Profile" display module included in the main
menu. In fact, this (forward) modeling module is used in the inversion analysis that calculates the
theoretical M0 dispersion curve from the velocity (Vs) model that is continuously updated during the
inversion process. Although the input file (*.LYR) includes attenuation parameters (Qs and Qp) for each
layer, they are not used during the dispersion-curve modeling and only the four aforementioned
parameters (Vs, Vp, , and h) are used. Generation of an accurate dispersion curve will depend on the
way the bisection method searches for the root by continuously updating the testing phase velocity. A
smaller increment during the update procedure can increase the accuracy in the phase velocity as well
as in modal identity (M0, M1, etc.), but at the expense of longer computing time. This is controlled by a
parameter called "Search integrity in phase velocity" included in the "Searching option" tab. The default
value (100) is determined through an extensive test with diverse layer models and therefore usually
sufficient to achieve the highest practical accuracy needed in most cases. However, the higher integrity
(that will make the bisection interval smaller) can always be tested to examine if different results are
produced.
As far as the velocity (Vs) structure of the input layer model does not include the "inverse velocity" on
top (i.e., Vs of top layer is higher than that of the underlying layer), the modeled dispersion curves
usually follow those dispersion trends observed in reality. However, with an inverse Vs structure (for
example, pavement or a stiff layer on the surface), the observed dispersion trend is determined not only
by the trend of the fundamental mode (M0) but also by a trend created from the mixture of successive
higher modes for those frequencies where corresponding wavelengths ('s) become comparable to the
thickness (h) of the top layer (e.g.,  ≤ 6h). This "mixed" dispersion trend is often referred as the
"apparent" dispersion curve (AM0). The transition from one mode to next ("mode jump") usually occurs
at the point where the two curves get closest to each other in phase velocity while searching from the
low-frequency end (Figure 1). This is the way the modeling algorithm generates the apparent dispersion
curve ["*(AM0).dc"] under such an inverse velocity structure by calculating two successive modes of
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dispersion curves and searching for the proximity point. Generation of an AM0 curve takes significantly
longer computing time because of the necessity to calculate multiple modes. The calculation of an AM0
curve becomes challenging at such high frequencies where wavelengths become close to the thickness
of the top layer itself. This is because of the theoretical limit that Rayleigh waves can exist only at phase
velocities slower than the velocity (Vs) of the half space (Thrower, 1965). Higher mode calculation in
this frequency (wavelength) range becomes less accurate and the calculated AM0 curve starts to deviate
from the real trend observed (Figure 2). Ryden et al. (2004) indicated that the accurate calculation of
higher modes should include the dispersion function solutions in complex-number domain (instead of
the real number) that take significantly longer computing time. In addition, a separate calculation of the
excitability function should also be accompanied in order to determine the realistic trend for the AM0
curve. These reasons make it impractical to include the complex-domain approach as a routine
approach. On the other hand, Martincek (1994) verified that the AM0 trend can be replaced with a
sufficient accuracy by the fundamental-mode asymmetric Lamb-wave dispersion curve (A0) (Ryden et al.,
2003) for high frequencies where corresponding wavelengths become shorter than six to seven times
the thickness of the top layer (i.e.,  ≤ 6h-7h) (Figure 2). Therefore, choosing the "Apply Lamb approx. at
high-frequency end" option is recommended whenever the calculated AM0 curve shows erratic patterns.
The "Apply Lamb approx. at high-frequency end" option is included in the "Inverse velocity (Vs)" tab.

Figure 1. Dispersion image and modal dispersion curves (M0-M5) modeled from the velocity (Vs) model
displayed in Figure 2(a). The dispersion image indicates that the actual observed dispersion trend
follows the "apparent" dispersion curve (AM0) that is created by continuous mode jumping between the
two successive modes of curves at the place where they get closest to each other.
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Figure 2. (a) An "inverse" velocity (Vs) model used to model the seismic record displayed in (b) by using
the reflectivity method. Corresponding dispersion image is displayed in (c) where the fundamentalmode (M0) and apparent (AM0) dispersion curves are also displayed. It is noticed that the calculation of
the AM0 curve becomes unstable at high frequencies (e.g.,≥ 250 Hz). The Lamb-wave approximation of
the apparent curve, "AM0 (Lamb Approx.)", is also displayed to indicate that it can be a more accurate
and reliable alternative at such frequencies where corresponding wavelengths come close to the
thickness of the top layer itself.
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2. Importing Input Data (*.LYR)
In the main menu, go to "Modeling" → "Dispersion Curve(s) from 1D Layered-Earth Model (*.LYR)" and
then select a file.
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3. Frequency

1 A different input file (*.LYR) can be selected.
○
2 Input layered-earth model that includes the velocity (Vs) model can be displayed as illustrated below.
○

3 Numerical values of each parameter can be viewed and edited as illustrated below.
○
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4
○
Frequency range of the dispersion is specified.
5 Total number of data points in the dispersion curve can be specified if the "Stretching interval" is
○
chosen.
6
○
Frequency interval can be uneven so that it corresponds to approximately even wavelength
4 is ignored.
intervals. If this option is chosen, the frequency interval in ○
7 Maximum mode of dispersion curve to be modeled.
○
8 Displays output modeled curves in the current chart. This option is enabled only when the module
○
is reached from the 1-D Vs profile display window.
9 Displays output modeled curves within the chart in a separate display window.
○
10 File name of the output curve(s) can be specified. Default names are "InputFileName(M0).DC",
○
"InputFileName(M1).DC", etc.
11 Executes the modeling process and displays the output in the current chart. This is enabled only
○
when this module is reached from the 1-D Vs profile display window.
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4. Searching Option

12 Specifies the integrity of the root searching process. A higher number will lead to searching with a
○
smaller increment in testing phase velocities. More detailed explanations are provided in the
Overview.
13 The maximum bound in the searching phase velocity. If excessively higher modes (e.g., ≥ M20) are
○
to be modeled, the value may need to increase (e.g., 5).
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5. Inverse Velocity (Vs)

14 The apparent dispersion curve (AM0) explained in the Overview is produced in addition to the
○

7 . More detailed explanations are provided in the Overview.
modal dispersion curves specified in ○
15 The apparent dispersion curve (AM0) is replaced by the fundamental-mode asymmetric Lamb
○
dispersion curve for such high frequencies where corresponding wavelengths become close to the
thickness of the top layer. More detailed explanations are provided in the Overview.
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6. Execute Modeling
Click "OK" button to execute the modeling.

This is an output example with even frequency interval (1 Hz).
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This is an output example with a "stretching" frequency interval.
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Modeling Seismic Data

1. Overview
This module generates a multichannel seismic record from a layered-earth model (*.LYR) by
incorporating an impulsive seismic source and multichannel recording configuration. The input model
(*.LYR) consists of both elastic and inelastic properties of material assigned into each (laterally
homogeneous) layer of a specific thickness (h); the elastic properties include compressional (Vp) and
shear-wave (Vs) velocities and density (), and the inelastic properties include the attenuation (quality)
factors (Qp and Qs) for the P and S waves.
The modeling algorithm is based on the reflectivity method in its original codes developed by Fuchs and
Muller (1971), provided by Dr. Klaus Holliger at the Swiss Federal Institute of Technology and Dr.
Michael Roth at the Norwegian Seismic Array (NORSAR). Dr. Adam O'Neill at Kyoto University then
altered and recompiled the codes to produce a DOS executable ("ss4exe.exe") that has been shared
(with a readme file) among researchers in the field of seismology. Special acknowledgments go to all of
them, especially to Dr. O'Neill.
The reflectivity modeling provides the most realistic MASW seismic data for the following three reasons.
First, in theory, each MASW record represents a 1-D (depth) measurement of subsurface materials and
the reflectivity modeling is truly a 1-D algorithm based on the laterally homogeneous medium. Second,
surface waves are considered, from theoretical perspectives, as being generated through a complicated
interference of reflections and refractions of (pure and mode converted) P and S waves and the
reflectivity method is known to model such wave phenomena in a stratified medium in the most
accurate manner at a relatively low computation cost. Lastly, the modeling can incorporate not only
elastic (such as Vp, Vs, and ) but also inelastic (Qp and Qs) properties in the wavefield calculation, and
this ability of modeling makes the modeled dispersion image appear closest to the real one observed
from the field record.

The user interface to perform modeling has been built based on the documentation provided in the
readme file. The interface consists of five (5) main tabs (Figure 1): "Data Acquisition", "Slowness",
"Dispersion", "Output", and "Multi-Value Run" tabs. Among them the first tab ("Data Acquisition") is
most important. It contains all the acquisition parameters of field geometry (receiver spacing, source
offset, type of receiver array, etc.), recording (number of channels, sampling interval, recording time,
etc.), and source characteristics (spectral contents, source location, etc.). The "Slowness" tab contains
those parameters related to the slowness (or wave number) integration in the reflectivity formulation
for which default values are sufficient in most cases. The "Dispersion" tab provides options to generate
dispersion images and/or curves as output in addition to the seismic data. The output file name can be
specified, as well as the record number for the output seismic record, in the "Output" tab. The "MultiValue Run" tab holds those parameters that can execute the modeling multiple times by successively
changing one of the parameters in the input model (*.LYR) (for example, by incrementing Vs values in all
layers by 50 m/sec each time) or in the source offset (for example, by incrementing X1 by 5-m each
time). Output records from this execution are saved in the same file with different record numbers,
which are indicative of the value used to generate the particular record.
All parameters previously used (if they exist) are automatically imported as default values at the
appearance of the dialog shown in Figure 2. They can also be checked from the display of modeled
seismic data by clicking the processing history button as illustrated in Figure 3.
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Figure 1. The modeling dialog consisting of five (5) main tabs.

Figure 2. Previously used parameters are imported, if they exist, at the appearance of the dialog.

Figure 3. Modeling parameters can be listed in a separate window (lower) by clicking the processing
history button in the seismic data display window (upper).
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2. Importing Input Data
There are two ways to import input data: 1) by importing a layered-earth model file (*.LYR) or 2) by
importing a previously saved file (*.RFL) of entire modeling parameters including the input layered-earth
model file.
To import a layered-earth model file, go to "Modeling" → "Seismic Data from Layered-Earth Model
(*.LYR)" and then select a file.

To import a previously saved set of modeling parameters, including the layered-earth model (*.LYR), go
to "Modeling" → "Seismic Data from Saved List of Modeling Parameters (*.RFL)" and then select a file.
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3. Data Acquisition
3.1 Seismic Source
3.1.1 Type

1 Displays input layered-earth model (*.LYR) for examination and editing purposes as shown below.
○

2 Imports a saved file (*.RFL) of modeling parameters.
○
3 Saves the current set of modeling parameters under a specified name (*.RFL) including the layered○
earth model file (*.LYR).
4 Type of wavelet used for seismic source.
○
5 Source ghost can be included if chosen.
○
6 Type of source (omni-directional explosion or vertical source).
○

5

Modeling Seismic Data
3.1.2 Wavelet

1 Nyquist frequency (Hz) determined by current sampling interval (specified in "Recording" tab).
○
2 Frequency of source wavelet based on preset ranges (full, low, medium, and high).
○
3 Bandwidth of source wavelet based on preset ranges (full, medium, and narrow).
○
4 Enables detailed specification of source frequencies as shown below.
○

5 Center frequency (Hz) of the amplitude spectrum.
○
6 Four frequency parameters that define the trapezoidal amplitude spectrum of source wavelet.
○
7 Goes back to the previous state of amplitude spectrum display.
○

6

Modeling Seismic Data
3.1.3 Location

1 Layer number, among the multiple layers in the input file (*.LYR), for the source location.
○
2 Number of sources.
○
3 Recording delay time in sec (positive value for delay, negative value for pre-trigger).
○
4 Source strength (little influence on the output because output amplitudes are normalized).
○
5 Coordinates (X, Y, and Z) of the source location. Coordinates are determined by parameters related
○
to the field geometry set in the "Recording" tab; therefore, these values should not be manually
overwritten.
6 Displays source/receiver (SR) configuration so that the source location can be manually changed.
○
This option is available only when an "arbitrary" receiver array is chosen in the "Recording" tab.
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3.2 Recording
3.2.1 Source/Receiver (SR) Array

1 Number of channels used for modeling. There are preset values in the box, but any number can be
○
typed in manually.
2 Source offset (X1), which is the distance between the closest (1st) channel and the source. A
○
negative value will put the source at the end of the receiver array (i.e., off the last channel). This
option is applicable only for the "Fixed spacing linear array."
3 Receiver spacing that is applicable only for the "Fixed spacing linear array."
○
4 Minimum and maximum offsets (i.e., X coordinates) for the linear array that are determined by the
○
1 ,○
2 , and ○
3 . The 1st channel is always located at X = 0.0 for the linear array.
parameters in ○
5 Azimuth of source with respect to the linear array. This can be used to introduce an offline offset
○
for the source.
6 Type of receiver array. If "Arbitrary receiver array" is chosen, then you can make a new "arbitrary"
○
receiver array (RA) by running the source/receiver (SR) setup Wizard or you can import a previouslysaved receiver array file (*.TXT) as illustrated below.
7 Distance unit of either feet or meters.
○
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If the first option is chosen, the following SR-setup Wizard will start. Refer to the user guide
"Source/Receiver (SR) Setup" for more information about this Wizard.

If the second option ("Import") is chosen, then you can import an existing file ["*(RA).TXT"]. A "circle"
receiver array (RA) with a source point is imported in the illustration below that was previously created
by running the SR-setup Wizard. You can further edit receiver and source locations in the display after
depressing the appropriate button (i.e., "Edit (Receiver)" or "Edit (Source)" button).
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8 Launches the source/receiver (SR) setup Wizard.
○
9 Imports an existing receiver array (RA) file ["*(RA).TXT"] that also includes the coordinates (X, Y, and
○
Z) of the source.
10 Displays the array (with source) in a separate window where locations can be edited if necessary.
○
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3.2.2 Recording Parameters

1 Sampling interval (dt) in milliseconds (ms). The corresponding Nyquist (i.e., maximum) frequency
○
will be updated in the label as the interval is changed.
2 Number of samples in each channel's data (trace) in power of 2.
○
3 Total recording time (T) determined from ○
1 and ○
2 .
○
4 Recording option for wavefield (displacement or velocity).
○
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4. Slowness

1 Minimum for calculation of MM, MP matrices; a fraction of minimum shear-wave velocity (Vs-min).
○
2 Lower bound for integration; a fraction of minimum shear-wave velocity (Vs-min).
○
3 Lower bound of taper to damp numerical arrivals of CMI; a fraction of minimum shear-wave velocity
○
(Vs-min).
4 Upper bound of taper to damp numerical arrivals of CMA; a fraction of maximum compressional
○
wave velocity (Vp-max).
5 Upper bound for integration; a fraction of maximum compressional wave velocity (Vp-max).
○
6 Maximum for calculation of MM, MP matrices; a fraction of maximum compressional wave velocity
○
(Vp-max).
7 Number of slownesses for integration; usually 100 to 400 (0=default).
○
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5. Dispersion
5.1 Image

1 If checked, generates dispersion image for the modeled seismic data.
○
2 Specifies frequency range and interval for the dispersion image.
○
3 Specifies phase velocity range and interval for the dispersion image.
○
4 Specifies white balance for the dispersion image. The "White Balance (%)" will add, if a non-zero
○
value is chosen, an infinitesimal amount of random noise during the wavefield transformation (FFT)
that will suppress most of computational artifacts (e.g., linear streaks). However, it will mask useful
dispersion patterns of weak energy (if they exist) especially at the lowest frequency end of the
image.
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5.2 Curve

1 If checked, dispersion curve(s) will be generated based on the velocity (Vs and Vp), density (), and
○
thicknesses (h's) of the input layered-earth model (*.LYR). The following dialog for "Dispersion
Curve Generation" will appear so that all the necessary parameters can be specified. Refer to the
user guide for "Modeling Dispersion Curves" for more details on this dialog.
2 If clicked, dispersion curves will be displayed in the chart as illustrated above.
○
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6. Output

1 Can specify output file name [for example, "Seismic.dat"] that is common to all types of outputs.
○
For example, the output seismic data will be saved as "Seismicv.dat" and "Seismich.dat" for the
vertical and horizontal (longitudinal) components, respectively, of velocity (or displacement) output.
Dispersion images, if chosen, will be saved as "Seismicv(ActiveOT).dat" and "Seismich(ActiveOT).dat"
for the vertical and horizontal components, respectively, of output. Rayleigh-wave dispersion
curves will be saved as "Seismic(M0).dc", "Seismic(M1).dc", etc., for the fundamental-mode, 1st
higher mode, etc., dispersion curves.
2 Appends output seismic data at the end of an existing seismic data file. To be compatible, it is
○
important that the "new" and "old (existing)" seismic data in the file have the same number of
samples and the same sampling interval.
3 An arbitrary record number for the output.
○
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7. Multi-Value Run
This "multi-value run" is used to successively execute the multiple modeling instances without user's
intervention that take slightly different values in one of the modeling parameters such as velocity (Vs or
Vp) or depth in one or all layers in the input layered-earth model. Output seismic records will have
different record numbers that are usually determined by the specific value (of whatever parameter is
modeled to change) multiplied by ten (10).

1 Layer number to change successively; 1=1st layer, 2=2nd layer, etc. "0" means all layers in the input
○
2 .
will be changed by the same amount specified in ○
2 Increment of the value (of whatever parameter chosen) to change each time (+ or -). This will make
○
the value change by the same amount each time.
3 If "Get value list (*.txt)" option is checked, then an external text file can be imported that simply
○
2 . After importing
contains numbers (one number per line). This will override the option chosen in ○
the file, the contents of the file will be displayed in the combo box as illustrated below.

4 Parameter (or variable) of the modeling to be changed each time.
○
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5 If checked, the "multi-value run" will be enabled. Otherwise, the modeling will be the regular
○
"single run" modeling that generates only one record of seismic data.
6 Number of multiple runs. If option ○
3 is chosen, then this number will reflect the number of values
○
included in the imported file.
7 If checked, each layered-earth model (*.LYR) will be saved separately with a file name appended
○
with the record number; for example, "Seismic(50).LYR", "Seismic(100).LYR", etc.
8 If this option is checked and a velocity (Vs or Vp) is chosen in ○
4 as the parameter to be changed,
○
then the other velocity (Vp or Vs) will be changed accordingly based on the Poisson's ratio (POS). If
this option is not checked, then the POS (not the other velocity) will be accordingly changed.
9 If this option is checked and a Q-factor (Qs or Qp) is chosen in ○
4 , then the other Q-factor (Qp or Qs)
○
will be changed in such a way that the original ratio of Qs/Qp will remain the same.
10 If this option is checked and the Vs is chosen in ○
4 , then POS (and Vp) and Q-factors (Qs and Qp) will
○
be dynamically determined based on the value of Vs. For example, if Vs = 100 m/sec, then POS=0.48
(and Vp=510 m/sec) and Qs=5, Qp=20 will be used.
11 If this option is checked and the Z (Bottom) is chosen in 4, then the "Value increment per record" in
○
2 becomes a scaling factor (i.e., a value to be multiplied rather than added). For example, if "1.5" is
○
2 (and "0" is entered in ○
1 ), then all layers' depths (Z's) will be "stretched down" (i.e.,
assigned in ○
deepened) by 1.5 times each time. The following message box will be displayed when this option is
chosen.
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12 If this option is checked, then the "multi-value" will switch to the source offset (X1) from one of the
○
4 with the following inquiry box.
layer parameters displayed in ○

13 Specifies a constant value (+ or -) of the source offset (X1) to be added each time.
○
14 If "Get value list (*.txt)" option is checked as illustrated below, then an external text file can be
○
imported that simply contains numbers (one number per line). This will override the option chosen
13 . After importing the file, the contents of the file will be displayed in the combo box as
in ○
illustrated below.
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8. Execute Modeling and Outputs
Click the "RUN" button and the modeling will start the process by calculating the wavefield. The
following illustrates for an instance of "Multi-Run" that generates ten (10) output seismic records.

When the modeling is completed, a seismic-data display window will appear with two tabs of displays.
The first tab, "Display 1", will show the vertical component (*v.dat); the second tab, "Display 2", will
show the horizontal component (*h.dat), as illustrated below.
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If the "Generate image [*(OT).dat]" option was chosen, then the following dispersion-image display
window will appear with two tabs activated. The first tab will show the vertical component
["*v(OT).dat"] seismic data sets, and the second tab will show the horizontal component ["*h(OT).dat"]
seismic data sets, as illustrated below.
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PS - Utility

1. Overview
Non-standard processing modules that are not part of the normal MASW processing procedure, but
often necessary and useful, are included under "Utility" in the main menu.

These modules will be used more often as the user becomes more familiar with the standard processing
flow and therefore becomes more creative in handling those processing results obtained at various
stages. The ultimate goal of using the utility modules will be to understand more precisely about data
set at different stages of the processing sequence through various approaches of non-conventional nonstandard evaluation procedures.
Most modules, except for "Format TEXT data" and "Make Common Seismic Gathers", are accessible
within the same "Utility" dialog (Figure 1). The other two modules have their own separate dialogs as
illustrated in Figure 2. The type of task each module performs is briefly explained below.
Format SEG-2 Files
The basic and minimum input data element for PS is one record that consists of a suite of an individual
channel's recordings, called "traces." The field records should be saved in the SEG-2 format (Pullan,
1990), which is an engineering standard that most engineering seismograph have adopted as the default
output format. Other text data files can be converted to the PS format by using a conversion module
("TXT2PS") that can be foud under "Utility" in the main menu. All SEG-2 records are internally converted
to PS format as soon as they are imported by the program, and all intermediate and final outputs of
seismic data sets will be in this PS format.
All SEG-2 records imported by the ParkSEIS (PS) software are first internally converted to another format
called "PS format" that is a modification of the "KGS format (or modified SEG-Y format)" (WinSeis User's
Manual, 1997). This conversion is necessary to handle seismic data in a faster and more accurate
manner for advanced and non-conventional wavefield operations commonly used in various stages of
MASW data processing. In PS format, each channel's data set (called a "trace") is saved as a combination of a header (of 120 elements of 2-byte integer each), followed by data samples (of 4-byte floatingpoint value each). A complete listing of the "PS Header" can be displayed by choosing "PS Header" on
the main menu's "Info" item. All output of seismic data are saved in PS format with the "DAT" extension
(e.g., "Output.dat").
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Format TEXT data
Sometimes, seismic data are prepared from a variety of different sources that may include seismographs
from different manufacturers, output from numerical modeling, etc. In spite of different data formats
adopted in each case, they can be at least prepared in text format. When that is done, these text data
samples can be converted to PS format by using this module.
Make Common Seismic Gathers
A normal seismic record in either SEG-2 or PS format has a collection of seismic data that were
generated from the same seismic source ("shot"). Therefore, it is also called a "common shot gather." A
collection of multiple common shot gathers (i.e., a normal seismic data file in PS format) can be
rearranged into different types of "common" gathers based on the primary sorting index. This module
can rearrange input seismic data of any type (e.g., common-shot gathers, common-offset gathers, etc.)
into the following types of common gathers: offset (CO), receiver station (CRS), source station (CSS),
source-receiver mid points (CMP), field record number (CFR), recording channels (CRC), and header
word (CHW). In the case of common header word (CHW) gathers, a header word number is specified
that is used as the primary sorting index to generate different output records. Usefulness of the
common-offset (CO) gathers is further explained in the PS User Guide "Back-Scattering Analysis (BSA)
and Common-Offset (CO) Sections."
Make Seismic Walkaway Record
It is sometimes useful to make a seismic record of an extended offset (i.e., source-receiver distance)
range simply by combining multiple records obtained at the same surface location but with different
source offsets. This "extended offset" record is called a walkaway (or noise analysis) record (Telford
et al., 1976; Sheriff, 2002). In seismic data analysis, a walkaway record can be extremely useful in
understanding the behavior of seismic body and surface waves in their propagation velocities and
attenuation properties. Furthermore, it can produce a dispersion image of an increased resolution
achieved by the extended aperture (i.e., offset) of measurement that can delineate multi-modal
dispersion patterns more clearly.
Edit Seismic-Data Trace Header
It is sometimes necessary to change one or more of trace header elements to accommodate some
experimental modifications or to rectify some minor error introduced during the previous processing
(e.g., changing distance unit from feet to meters). This module can accomplish such a task.
Stack (+/-) Seismic Records
This module can stack two different records by summing (+) or subtracting (-) data values. A scaling
factor can be applied to each record, if necessary, before the operation. This module can be useful
when handling seismic records and dispersion image records (also called "overtone" records) to meet
some experimental purposes.
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Make 2D Vs Map from Layers
Inversion of one dispersion curve (*.dc) will generate its own output of one layered-earth model (*.LYR).
The 2D shear-wave velocity (Vs) cross section is created by combining a multiple number of such LYR
files at the end of the inversion that processed a multiple number of input dispersion curves. This
module can generate such a 2D Vs cross section from a multiple number of LYR files of your own
selection.
Remap Layers
One or more layered-earth model (*.LYR) files can be remapped according to a common depth model,
which is defined by another "reference" LYR file. This remapping can be useful when comparing files
(LYR's) of different depth models, or constructing a 2D Vs cross section from multiple LYR files to bypass
some unfavorable interpolation effects introduced by the plotting module.

Figure 1. Utility dialog.

Figure 2. Dialogs for "Format TEXT data" (left) and "Make Common Seismic Gathers" (right) modules.
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2. Format SEG-2 Files
In main menu, go to "Utility" → "Format SEG-2 Files (*.dat)(*.*)." Select SEG-2 file(s) at the same time
as shown below.

Then, a file save dialog (with a title of "Save Output As") will appear to get the name of the output file
that will contain all the formatted files ("records") within the same file.

Imported files are listed in the "Input Files" box on top left corner that shows the order of appearance in
the output. Click "Run Format" button to start the format.
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Saved output seismic data of PS format will be displayed. A text window showing the contents of the
"File Descriptor" in the first file of the input SEG-2 files will be displayed also. It lists the name of
another text file that contains the entire format history contents for all the channel's data (i.e., "traces")
["PS(FormatHistory).TXT"], an example of which is displayed below using the Windows Notepad.
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3. Format TXT data
Seismic data in text format can be converted to PS format using this module. In the main menu, go to
"Utility" → "Format TEXT data (*.txt)." Then, import a text file that contains seismic data (and possibly
with header information) in text format.

A control dialog will appear that contains all the controls related to input and output formatted data
that are grouped into four (4) different steps as shown below.

STEP 1
Select the way text data are arranged in the input file. Input text data can be arranged in one of the two
formats—serial or parallel. If data values are arranged one trace after another, possibly with a common
header at the beginning of each trace, then it is regarded as "serial" format. On the other hand, if one
line of text in the input file contains data values for all traces at one time sample without header information, then it is regarded as "parallel" format. Move to the next step by selecting the "STEP 2" tab.
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STEP 2
Specify input header information here. If there is a file header at the beginning of the input file, then its
number of elements can be specified in "# of file header elements" box. If each trace has its own
header of common format, then the total number of trace header elements can be specified in the "# of
trace header elements" box. If there are no file or trace headers, then the corresponding box should
show a value of "0". The total number of traces is specified in the "# of traces" box, and the total
number of data samples per trace is specified in the "# of data samples per trace" box. The sampling
interval can be specified in the "Sampling interval in millisecond (ms)" box. An arbitrary number can be
assigned in the "Record number" box that will be the output record number. Move to the next step by
selecting the "STEP 3" tab.

STEP 3
Specify output file name here. If formatted output data are to be added at the end of an existing file,
then check "Append output" box. Make sure existing data and the new data have the same number of
samples per trace and also the same sampling interval.
STEP 4
Click "RUN" button to start the conversion. Converted output will be displayed.
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4. Make Common Seismic Gathers
In the main menu, go to "Utility" → "Make Common Seismic Gathers" as shown below. Then, the
control dialog will appear in which the specific type of output gather (e.g., common-offset gather) can
be selected. If the type of output gather is already known, then go to "Utility" → "Make Common
Seismic Gathers of" and select the appropriate option as also illustrated below.

Then, import a normal seismic data file of PS format that has source/receiver (SR) setup encoded [i.e.,
"*(SR).dat"] as illustrated below. If the input file does not have such information encoded, then the type
of output gather will be limited.
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The input file name is displayed in the top box, which can be replaced by clicking the button (
at the end of the box. All controls are arranged in three (3) tabs.

) placed

Type of gather
Type of output gather is selected here. If the type was already known and selected from the main menu,
then the corresponding option will have been selected and the next tab, "Arrangement", will be
displayed. "Type of gather" will determine the primary information that will be used to make a common
collection of traces to be grouped as one "record" in the output file. [Secondary information that will be
used to determine the order of arrangement within the same record will be selected next in the
"Arrangement" tab.]
Offset (CO)

Traces of the same source distance (also called "offset") will be grouped as
one record. Record number will indicate the corresponding offset
multiplied by "10" (e.g., 1000 for common-offset of 10 meters). Trace
header word #19 will be used as the primary sorting index. Output file
name will have "(CO)" appended as postfix [e.g., "Output(CO).dat"].

Receiver Station (CRS)

Traces of the same receiver locations (i.e., the same receiver station
numbers) will be grouped as one record. Record number will indicate the
corresponding station number. Trace header word #86 will be used as the
primary sorting index. Output file name will have "(CRS)" appended as
postfix [e.g., "Output(CRS).dat"].

Source Station (CSS)

Traces of the same source locations (i.e., the same source station numbers)
will be grouped as one record. Record number will indicate the
corresponding station number. Trace header word #87 will be used as the
primary sorting index. Output file name will have "(CSS)" appended as
postfix [e.g., "Output(CSS).dat"].

Mid-Point (CMP)

Traces of the same source-receiver-mid-point locations will be grouped as
one record. Record number will indicate the sum of both source and
receiver station numbers. Trace header words #86 (receiver station) and
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#87 (source station) will be used as the primary sorting indices. If
"Common-Mid-Point (CMP) in surface distance" box displayed in "Output"
tab is checked, then the primary sorting indices will be header words #36
(receiver distance) and #39 (source distance), and the output record
number will be the sum of both distances multiplied by 10. Output file
name will have "(CMP)" appended as postfix [e.g., "Output(CMP).dat"].
Field Record (CFR) Number Traces of the same original field record numbers will be grouped as one
record. Record number will indicate the corresponding record number.
Trace header word #6 will be used as the primary sorting index. Output file
name will have "(CFR)" appended as postfix [e.g., "Output(CFR).dat"].
Recording-Channel (CRC)

Traces of the same channel numbers will be grouped as one record. Record
number will indicate the corresponding channel number. Trace header
word #8 will be used as the primary sorting index. Output file name will
have "(CRC)" appended as postfix [e.g., "Output(CRC).dat"].

Header-Word (CHW)

Traces of the same value in the specified header word# will be grouped as
one record. Record number will indicate the corresponding value in the
header. The number (#) of header word will have to be specified in the
separate "Header Word # (1-120)" box located below the radio group box.
Output file name will have "(CHW)" appended as postfix [e.g.,
"Output(CHW).dat"].
Arrangement

The secondary sorting index is specified in this tab, which is used to determine the order of output for
those traces within the same record.
order of occurrence

Output traces will be arranged in the order of their appearance in the
original input file.

receiver station

Output traces will be arranged in the order of receiver station numbers
(header word #86).

source station

Output traces will be arranged in the order of source station numbers
(header word #87).

receiver distance

Output traces will be arranged in the order of receiver distances (header
word #36).

source distance

Output traces will be arranged in the order of source distances (header
word #39).

record number

Output traces will be arranged in the order of record numbers (header word
#92).

common-mid-point (CMP) Output traces will be arranged in the order of CMP numbers (header word
#12).
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Output
Output traces can be written either in an "increasing number" order or a "decreasing number" order of
the values selected as the secondary sorting index in the "Arrangement" tab. "Min. number of traces in
each gather" will determine the smallest number of output traces within a record and will not output
those records with a lesser number of traces. The "Common-Mid-Point (CMP) in surface distance"
check box will be enabled if "Common-Mid-Point (CMP)" is selected as the primary sorting index. If this
box is checked, the output CMP (header word #12) will be encoded as a sum of source and receiver
distances.
Click "OK" to start the process that will ask for the output file name, if not previously specified.

Output will be displayed in a new window. The common-offset gathers will be displayed in the
"variable-area" format as default mode of display. Display can be changed back to the normal black &
white wiggle-type display by depressing the "Variable Area Display" button in "View" tab of the top tool
panel.
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5. Make Seismic Walkaway Record
In main menu, go to "Utility" → "Make Seismic Walkaway Record" as shown below. A dialog with all
control options will appear with a brief instructional message as illustrated below. Input records are
opened in the order of their appearance in the output walkaway record from "left" to "right" as the
output is displayed in a separate window.

Click the "Open File" button in a separate tab to import one input record. This procedure always starts
from "#1" tab and moves to next tab progressively (e.g., "#2", then "#3", etc.) up to maximum five (5)
tabs. The same file can be used to open in each tab. Then, different records have to be selected in each
of the input display windows (e.g., "Record #1", "Record #2", etc.). The display order of traces in each
input window can be changed (i.e., "flipped") by checking the "Flip Horizontally" box in each tab.
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The example below illustrates opening the same file ["Line1(SR).dat"] for "# 1" and "# 2" input files. But
records of "5" and "8", respectively, are selected in each of the display windows.
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Check the "Use displayed traces only" box to use only part (not full) of the traces in the input record. To
select these traces, use the "Zoom In" button in the "View" tab of the top tool panel. Then, only those
selected (i.e., displayed) traces will be included for the generation of the walkaway record. The full
length of time will be used for these selected traces regardless of the displayed lengths. Record number
of the output can be specified in the "Output Record #" box.
Click "Make" button to generate the walkaway record that will be displayed in a separate window as
illustrated above.

Click "Save" button to save the displayed walkaway record as a separate file. If necessary, it can be
appended to an existing file by checking "Append Output" box.
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6. Edit Seismic-Data Trace Header
Value(s) of trace header element(s) can be changed. In the main menu, go to "Utility" → "Edit SeismicData Trace Header" to select a seismic data file as illustrated below.

A control dialog will appear with following options available. At any time, the input file can be replaced
by a new file by clicking the "Open (*.dat)" button in the dialog. The header word # can be selected in
the green box ("Word No.") by selecting or typing an appropriate number (1-120). The content of the
selected element will be displayed on the top green bar. The full contents of PS headers can be
displayed by clicking the button ( ) placed at the end of this bar. The current value of the selected
element will be displayed in "Value" box. If only one header element is to be changed, then specify the
new value in this box and click the "Apply" button to start the process. If "Save as a separate file" box
has been checked, then it will ask for output file name before starting the process.
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If any common properties such as distance unit, sampling interval, record number, etc., are to be
changed, then check the "Enable multi-edit option" box so that the additonal options listed in the
separate tabs at the bottom of the page will be enabled.

Coordinates/Stations
To change coordinate(s) (i.e., distances) of source and/or receivers, select the "Coordinates (X, Y, Z)" tab,
check the appropriate box(es) ("Receiver" or "Source"), and enter the amount of change in the "Value"
box. Select the type of change by selecting the proper type ["Add (+)" or "Multiply (x)"].
To change station(s) of source and/or receivers, select the "Stations" tab and check the appropriate
box(es) ("Receiver" or "Source") and enter the amount of change in the "Value" box. Select the type of
change by selecting the proper type ["Add (+)" or "Multiply (x)"].
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Type/Range
The type of data (determined by the value in header word #1) can be changed by selecting an appropriate type in the "Data" radio group box. The type of receiver array (1D or 2D) can be selected in the
"Rcv array" box. The MASW survey type (e.g., active, passive, and active/passive combined types) can
be changed by selecting an appropriate option in the "MASW survey" radio box.
The range of records and traces to which the change will be applied can be specified in the "Record" and
"Trace" boxes, respectively.

Click the "Apply" button to start the process. If "Save as a separate file" box has been checked, then the
program will ask for output file name.
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7. Stack (+/-) Seismic Records
Two seismic records can be stacked on top of each other by either summing two amplitudes or
subtracting one from the other. In the main menu, go to "Utility" → "Stack (+/-) Seismic Records" and
the utility form with the "Edit Record(s)" tab selected will appear as shown below.

Open two seismic data files by clicking "Open 1st Record" and "Open 2nd Record" buttons, respectively,
as illustrated below. Each file will be displayed in a separate window.

19

PS - Utility
Check the "Apply to all records" box if individual records are to be stacked on top of each other in the
order they appear in each file. Otherwise, the records displayed in each window will be stacked.
Choose the "Stack Type" (i.e., + or -) and adjust relative amplitude ratios, if necessary, in the "Amplitude
Ratio" box. These ratios will be applied to each record before the operation. Check the "Append
output" box if output records are to be added at the end of an existing file.
Click the "Run Stack" button to start the process. The program will ask for the output file name and
then display output in a separate window as illustrated below.
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8. Make 2D Vs Map from Layers
A 2-D shear-wave velocity (Vs) cross section can be generated from a multiple number of layered-earth
models (*.LYR). In the main menu, go to "Utility" → "make 2D Vs Map from Layers (*.LYR's)" that will
request to import multiple files of LYR extension. The files can also be imported from the utility form by
clicking the "Import Layer Models (*.LYR)" button as illustrated below.

Select multiple files (*.LYR's) at the same time as illustrated below.
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The following control dialog will appear. Click the "Output File Name [*(2DVs).txt]" button to specify the
name of the output file that will be saved as a text file.

Check "Export confidence data if exists [*(2DConf).txt]" box to make the corresponding 2D confidence
(%) cross section map. If input layered-earth files were created from the inversion process, then each of
them will contain the inversion confidence information (as well as the surface coordinate of the original
seismic record) that will be used to generate the map. Output will be appended to an existing file (*.txt)
if "Append output*" box is checked. In this case, the existing data for the same surface coordinate(s)
will be replaced by the new output data. Click the "OK" button to start the process that will display the
output in a separate window as illustrated below.
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9. Remap Layers
One or a multiple number of layered-earth models (*.LYR's) can be "remapped" based on the new depth
model, which is defined by another "reference" model (*.LYR).
In the main menu, go to "Utility" → "Remap Layers (*.LYR's)" as shown below. This will be identical to
clicking the "Open Layer Model(s) (*.LYR)" button in the corresponding tab ("Layers") of the utility form.
The program will invoke a file open dialog to import one or more layer model (*.LYR) files.
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Select all files at the same time as illustrated below. After that, the program will ask to open another file
(*.LYR) for the reference depth model.

Once the "reference" file is imported, then all the previously imported input files (*.LYR's) will be
remapped in their depth model according to the depth model in the reference file. They will be saved
with "(Remap)" postfix appended at the end of the original file name.
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10. Show Utility Dialog
All previously explained tasks, except for "3. Format TEXT data" and "4. Make Common Seismic
Gathers", can be accessed in the utility form. To open these tasks from the main menu, go to "Utility" →
"Show Utility Dialog" to display the form as illustrated below.

Each tab in the utility form is explained below.
Format

This tab contains the module to perform the task of "Format SEG-2 Files" explained in
section 2.

Header

The module to perform "Edit Seismic-Data Trace Header" explained in section 6 is in this
tab.

Walkaway

"Make Seismic Walkaway Record" explained in section 5 can be performed in this tab.

Edit Record(s) The task of "Stack (+/-) Seismic Records" can be performed in this tab, which is
explained in section 7.
Layers

The two tasks of "Make 2D Vs Map from Layers" (section 8) and "Remap Layers" (section
9) can be performed in this tab.
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1. Overview
The most common output of a 2-D shear-wave velocity (Vs) cross section shows only a general velocity
(Vs) variation trend that often may not have sufficient resolution to detect small-scale anomalies such as
underground utility pipes and tunnels. This is because MASW is not an imaging method that is based on
the focusing principle (Claerbout, 1985) (Figure 1). The approach for normal MASW analysis is based on
the layered-earth surface-wave propagation in which only the vertical variation is considered. Therefore,
the solution of the individual 1-D (depth) velocity (Vs) profile obtained from each field record represents
the "best" vertical velocity (Vs) model by laterally averaging subsurface properties under the receiver
array used to acquire the record. In this case, an anomaly whose size (D) is smaller than a few receiver
spacings (dx) (e.g., D ≤ 2dx for 24-channel acquisition) may not be able to make a significant impact on
the dispersion property of surface waves. As a consequence, the 2-D velocity (Vs) cross section may not
be the optimal approach to detect anomalies. On the other hand, a small object can generate strong
back-scattered surface waves that can be visually identified sometimes over many receiver stations in
the field records (Figure 2).
Horizontally travelling surface waves impinging into an object are scattered into all directions as if the
object is a new source point (Huygen's Principle). Those travelling backward along the receiver line are
called back-scattered surface waves (Figure 3), which make a distinctive arrival pattern of opposing
slope in comparison to those of forward propagation travelling directly from the source (Figure 2). By
observing the surface location where the feature originates, the anomaly is detected in its horizontal
coordinate (Figures 2 and 3). Although the back-scattering does not noticeably influence dispersion
analysis that focuses only to the forward propagation, the feature itself can be used to detect anomalies.
In this case, the horizontal accuracy can be as high as one receiver spacing (1dx), although the vertical
(depth) accuracy may be less (Figure 4).
The minimum dimension of an object to be detected by body (reflected) wave is ultimately determined
by wavelength of the impinging wave. A shorter wavelength will be needed to detect a smaller object.
The same principle must apply to the back scattering of surface waves. In surface waves, however,
penetration depth (Zp) is in proportion to wavelength of surface waves (); the longer wavelength
penetrates deeper. In general, one wavelength is considered the penetration depth (Zp ≈ 1) as most of
the surface wave energy (≥ 99%) is confined for depths shallower than that (Richart et al., 1970) (Figure
5). Then, the minimum size of the (void) anomaly (Dmin) that can be detected by back scattering
becomes a function of its depth of existence (Za); Dmin ≈ Za with ( < 0.5). Although no such
theoretical studies have been reported, observations made based on the real and numerical
experiments indicate that it is a small fraction of Za; for example, Dmin ≈ 0.2Za. This relationship
accounts for not only the wavelength-dependent aspect of detectability but also the amplitude (A) of
surface wave that decreases exponentially with depth (Z) (Sheriff and Geldart, 1985); i.e., A ≈ exp (-Z)
with  > 0.0.
The approximate depth of the anomaly can be depicted from the spectral characteristics of the backscattering feature by utilizing the wavelength () dependent penetration depth (Zp) of surface waves
(Zp ≈ ). The back scattering can occur only when Zp exceeds the top of the anomaly of size D existing at
depth Za (Figure 5); i.e., Zp > Za-D/2. Depending on the spectral characteristics of impinging surface
waves and also on the ambient noise characteristics, the wavelength that gives the strongest back
scattering may change. There are no systematic studies reported that address this subject through
theoretical analysis. However, empirical observations indicate that an approximate relationship should
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follow the trend illustrated in Figure 6. It shows that, for a given size D (≈ 0.2Za), the back scattering
amplitude increases with wavelength once it penetrates deeper than top of the anomaly (i.e., Zp ≈  >
Za-D/2), and the maximum amplitude occurs when Zp ≈  ≈ 2Za (Figure 6). Then, the amplitude
gradually decreases as Zp (or ) further increases. The specific shape of the curve illustrated in Figure 6
and the wavelength that gives the strongest back scattering (i.e.,  ≈ 2Za) should change to a certain
extent depending on the size (D) of the anomaly as well as the spectral characteristics of impinging
surface waves.
The relationship of Zp ≈  ≈ 2Za that gives the strongest back scattering provides a way of approximately
evaluating the depth of anomaly (Za) that is responsible for the observed back-scattering feature. For
example, if its dominant frequency is observed as fa and the corresponding phase velocity in the
measured dispersion curve is Cf, then its depth is calculated as Za ≈ (1/2)  = (1/2)(Cf/fa). Therefore, if
fa = 20 Hz and Cf = 160 m/sec, then Za ≈ 4 m. This is an approximate evaluation of the depth to the
(vertical) center of the anomaly. Depth to the top of the anomaly (ZT) can usually be estimated more
accurately than Za through successive narrow-band-pass (NBP) filtering. For example, if the backscattering feature completely disappears after a NBP filtering with pass-band parameters of 45 Hz-50Hz
-50 Hz-55 Hz (i.e., NBP filtering centered at 50 Hz) has been applied and Cf = 150 m/sec at 50 Hz (from
measured dispersion curve), then ZT > 3 m (i.e., top of the anomaly is deeper than 3 m).
The back-scattering analysis (BSA) algorithm incorporated in this software tries to enhance those backscattered surface waves as much as possible. It first applies the linear-move-out (LMO) correction by
Park et al. (1998) (Figure 7) to each field record by using the dispersion information analyzed from either
that particular record or from the average dispersion image of the entire field records. This LMO
correction will remove the source-receiver offset effect and make all forward propagation of surface
waves aligned at the same arrival time (of zero for zero-phase source wavelet). On the other hand, the
back scattered surface waves will remain as slant arrivals of opposing slopes, but with even steeper
slopes than before the correction (Figure 3). After this, the LMO-corrected records are stacked
according to their common-receiver locations. This will make the back scattering events constructively
overlapped and the feature will become more pronounced in the final BSA section. Input seismic data
to BSA must have source/receiver (SR) setup encoded and dispersion curve(s) must be available.
Therefore, it is recommended to apply BSA only after the normal processing sequence to produce 2-D
velocity (Vs) cross section has been completed (Figure 8). A single dispersion curve (obtained from the
stacked "average" dispersion image or obtained from the dispersion image of a representative field
record; for example, a field record at a "normal" area without any anomaly) or multiple curves can be
imported for the analysis. In the case of multiple dispersion curves, the program will use the curve from
the location closest to the record being processed for the LMO correction.
A common-offset section is constructed simply by gathering those traces from multiple field records that
have the same (common) offset between source and receiver, and then arranging them in the order of
surface distance (or station number) along the survey line (Figure 9). In theory, therefore, N different
common-offset (CO) sections can be constructed from a set of field records acquired by using the Nchannel acquisition system through the conventional roll-along survey method. Although this process is
an extremely simple task that involves only a rearrangement of acquired data, its utility can often be
beyond expectations. A real example is presented in Figure 10 where the analyzed 2-D velocity (Vs)
cross section shows a bedrock trough. A common-offset (40-m) section also shows a similar feature
created by the later arrival of surface waves in the area of deeper bedrock, whereas another commonoffset (10-m) section does not show such a feature. This is because the penetration depth (or dominant
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wavelength) of surface waves recorded by using a specific offset is in proportion to the offset itself. As a
rule of thumb, the maximum penetration depth (Zmax) is about the half of the offset (d); i.e., Zmax ≈
0.5d. The lower-frequency nature of surface waves observed in the longer common-offset (40-m) in
Figure 10 indicates the section contains those longer wavelengths of surface waves penetrating deeper.
In this way, visual inspection of different common-offset sections can depict lateral variation of
subsurface materials at different depth ranges. Application of successive narrow-band-pass (NBP)
filtering to a given common-offset section can control the focusing depths even in a more delicate
manner. For example, if a NBP with 30-Hz center frequency is applied to a common-offset section and
its corresponding phase velocity is 150 m/sec, then the focusing depth (Zf) is about the half the
wavelength; i.e., Zf ≈ 2.5 m. In this case, it is assumed the common offset is longer than this wavelength
(5 m).
A sample data set ["...\Sample Data\VOID\VOID(SR).dat"] is provided for the purpose of implementing
the back-scattering-analysis (BSA) and common-offset (CO) section construction. It is a numerical
(modeling) data set consisting of fifty (50) records of 24-channel acquisition (Figure 11) generated using
the algorithm introduced in Park and Miller (2008). The data set is in PS format and has the
source/receiver setup already encoded. The modeling algorithm simply introduces phase shifts to a
given frequency band of seismic source wavelet according to the source-receiver distance and
frequency-phase velocity relationship depicted in the input dispersion curve. The subsurface model
used to generate the input dispersion curve consisted of two layers of overburden and bedrock (Figure
12). Then, a void of 2-m size was conceptually introduced at a depth of 5 m below the surface distance
of 44-m (station #1044) (Figure 12). The void existence was incorporated into the modeling by adding
wavefields that are generated from the source point, travel to the void, and then back scattered into
receivers located at the back-scattering side (rather than forward propagation side). Amplitude of the
scattered surface wave is calculated during modeling through a summation of surface wave amplitudes,
which exponentially decrease with depth, only for those depths coinciding with depth range of the void.
Figure 11 shows three (3) of these modeled records (from a total of 50) selected from the beginning, in
the middle, and at the end of the survey line. The first two records in the figure contain the backscattering feature (visible only with a high display gain), whereas the last record is free of back scattering.
Although generation of the common-offset sections can be implemented from a seismic data set of PS
format with or without the source/receiver (SR) setup encoded, application is recommended only after
the SR setup has been applied (Figure 8).
Both BSA and common-offset sections are displayed in variable-area format by default, but such
sections can be displayed in the conventional wiggle format by releasing the variable-area display
button in the "View" tab of the display.
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Figure 1. Comparison of MASW as a characterization method and reflection as an imaging method by
using a subsurface model consisting of layers and a small-size anomaly (void).

Figure 2. A field record acquired over a shallow tunnel at about 2-m depth that shows back-scattered
surface waves from the tunnel as well as forward propagation of surface waves.
5
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Figure 3. Schematic illustrating how back-scattered surface waves are generated (top) and two backscattering-analysis (BSA) sections analyzed from two sets of real data.

Figure 4. Two sets of back-scattering-analysis (BSA) sections analyzed from real and model data sets
that show the features originating from the exact known surface locations; 124-ft for the real data and
44-m for the model data.
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Figure 5. A schematic illustrating that the penetration depth of surface waves is about one wavelength
in which most of the energy (~99%) is confined (illustrated by the amplitude variation with depth). It
also illustrates that the back-scattering occurs only for those surface waves penetrating deeper than the
anomaly (void).

Figure 6. A conceptual graph that shows how the amplitude of the back-scattered surface waves
changes with wavelength () once it becomes longer than the depth to the top of the anomaly. Then,
the maximum amplitude occurs when it becomes approximately twice the anomaly depth (=2Za).
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Figure 7. Algorithmic description of the linear-move-out (LMO) correction used in Park et al. (1998).
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Figure 8. Flowchart showing the stages where the common-offset section construction and the backscattering-analysis (BSA) are most optimally implemented. It also shows the general steps taken during
the normal MASW process to produce a 2-D velocity (Vs) cross section.
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Figure 9. A common-offset (CO) section of a specific offset (e.g., 60-ft) is constructed by gathering those
traces collected at the corresponding offset (60-ft) from all field records and then rearranging them in
the order of appearance.
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Figure 10. A real data example of the 2-D velocity (Vs) cross section and two common-offset sections
constructed from the same seismic data used for the cross section. The longer offset (40-m) section
shows the surface-wave arrival pattern that mimics the bedrock topography observed in the 2-D Vs
cross section.
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Figure 11. Source/receiver (SR) chart for the sample data set ["VOID(SR).DAT"] and its three (3) (out of
50 total) records selected from the beginning, in the middle, and at the end of the modeled survey line.

Figure 12. Subsurface model used to generate the sample data set ["VOID(SR).DAT"] (a) and the
dispersion curve and spectral shape of the source wavelet used during the modeling (b).
12
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2. Back-Scattering Analysis (BSA)
2.1 BSA Tab

1 Dispersion curves are imported. Either one or multiple curves can be imported.
○
2 Output file name is specified.
○
3 Runs the BSA operation.
○
4 Selects the searching range either in distance or station numbers.
○
5 Searching range is specified for the BSA.
○

6 Specifies the frequency range (within the range in the input dispersion curve) that is used for the
○
linear-move-out (LMO) correction.
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7 Filters out all the forward propagation of surface waves to leave only back scattered surface waves.
○
8 Filters out only those surface waves generated directly from the source.
○
9 Applies LMO correction and stacks all the corrected traces according to the common-receiver
○
locations. No pre-filtering is applied.

10 Adds time on top of the output BSA section.
○
11 Surface range within which back-scattered surface wavefields are collected.
○
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2.2 FV-LMO Tab

1 Dispersion curves are imported. Either one or multiple curves can be imported.
○
2 Output file name can be specified.
○
3 Executes the FV-LMO operation.
○
4 Specifies the record range for the operation.
○

5 Specifies the frequency range (within the range of the input dispersion curve).
○
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6 An arbitrary reference offset against which the LMO correction is applied.
○

2.3 TAVO Tab

1 Specifies type of horizontal axis in the output data [to be displayed as a dispersion curve (*.DC)].
○
2 Specifies the horizontal range in the output data.
○
3 Output file name (*.DC) can be specified.
○
4 Executes the trace-amplitude-variation with offset (TAVO) operation.
○
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3. BSA  "Working with Sample Data [VOID(SR).DAT]"
3.1 Running BSA
In the main menu, go to "Process" → "Back-Scattering Analysis (BSA)" and then select the sample data in
"...\Sample Data\VOID\VOID(SR).DAT."

3.1.1 Generating BSA Section
Click the "Run BSA" button. "Dispersion" and "Output" will be automatically executed in the order.
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Import the dispersion curve file ("VOID.DC") that was used to generate the sample data set. You can
also use your own dispersion curve file processed from the sample data by following the normal
procedure of dispersion analysis as explained in section 3.2.

Then, specify the output file name.

After this, the BSA operation will be executed and the final BSA section will be displayed. Default display
mode for BSA section is a variable-area display as shown below. The target back-scattering feature
originating from the surface location of the anomaly (44-m) is indicated in the figure below. All other
less conspicuous slant features are computational artifacts.
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3.1.2 Horizontal Event (HE) Filtering
The back-scattering feature usually can be enhanced by filtering out the horizontal arrivals by using the
"Horizontal Event (HE)" filtering. Select the "Process" tab in the BSA display window. Click the "Filter"
button, and then double click anyplace in the display. The filtering dialog will appear as shown below.

Choose "Horizontal Events", specify the "Horizontal Window (%)", and then click OK. A value less than
or equal to 5 (%) is usually optimal. A smaller number would be necessary for the window value if the
horizontal event has the higher dominant frequency, and vice versa.
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The filtered BSA section shows much higher amplitudes for the back-scattering feature than before.

You can save this output as a separate file. Choose the "File" tab and then click the "Save" button
indicated in the dialog. This saved data file [*(HE=5).DAT] will be used for depth evaluation of the
anomaly. After saving the file, close the current display window.
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3.1.3 Depth Evaluation
In the main menu, go to "Display" → "Seismic Data." Then, open the file previously saved [*(HE=5).DAT].

Successive narrow-band-pass (NBP) filtering will be applied to this data set to see when the backscattering feature completely disappears. Choose the "Process" tab, and then click the "Filter" button.
Double click anyplace in the display. The filtering dialog will appear.
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Specify four (4) filter parameters as shown below to apply NBP filtering centered at 20 Hz.

The output from the NBP filtering below shows the feature still remaining. Another NBP filtering with a
higher center frequency now has to be applied. Currently, the "PROCESSED" (i.e., "NBP filtering applied")
data is displayed.
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First, the original data before filtering has to be displayed in the window. For that, click the toggle
button (the one marked on the right below) to display the data without "(PROCESSED)" title on top.
Then, click the "Filter" button and double click the display to launch the filtering dialog again.

This time, specify four (4) filter parameters as shown below to apply NBP filtering centered at 30 Hz.
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The output from the NBP filtering still shows the back-scattering feature, but with much less amplitude
this time. Therefore, it may be necessary to apply, at least, one more filtering with an even higher
center frequency.

Again, specify four (4) filter parameters as shown below to apply NBP filtering centered at 40 Hz.
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This output shows the back-scattering feature almost disappeared. Now, apply another round of
filtering to see if it removes the feature completely.

Specify four (4) filter parameters as shown below to apply NBP filtering centered at 50 Hz.
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This time the feature seems to be completely removed. So, the phase velocity at 50-Hz is about 150
m/sec as shown in Figure 12 in the Overview section. This means its wavelength is 3 m, so the top of the
anomaly is deeper than 3 m. Actual depth is 4 m.
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3.2 Generating Average Dispersion Curve
This section describes how to prepare one dispersion curve that represents the average dispersion
property over the entire surveyed distance. Although you can import all the dispersion curves
processed from all the records in the input seismic data set, the most optimal BSA output is often
generated when this "representative" dispersion curve is used for the process. This section will
demonstrate how to generate all individual dispersion images from the sample data set (of 50 records).
Dispersion images will be stacked to produce one "stacked" dispersion image, from which the
representative dispersion curve will be extracted and saved to be imported at the beginning of the BSA
process.
In the main menu, go to "Dispersion" → "Make Dispersion Image From S/R Coded Data" and import the
same data set [VOID(SR).DAT].

See PS User Guide "Dispersion Image Generation" for details about this part of the analysis.
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Then, click the "Run Dispersion Image" button in the dialog.

At the end of the process, click "No" and go to the main menu.

In the main menu, go to "Display" → "Dispersion Data" → "Dispersion Image" and then select the
previously processed data set [VOID(SR)(ActiveOT).DAT].
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Choose the "Multi-OT" tab, and click the "Stack" button to specify the output file name [*(VStack).DAT].

It will ask how the surface coordinates of the stacked dispersion image should follow. It does not matter
for the purpose of getting only one dispersion curve. Click "Yes" and then "No" to the option to display
the stacked dispersion image.

Then, in the main menu, go to "Dispersion" → "Get Dispersion Curve(s) From Image Data" and import
the previously saved stacked image [*(VStack).DAT].
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The following display window, in which you can extract the dispersion curve from the image, will appear.
Although detailed instructions about how to extract a dispersion curve from the dispersion image is
explained in the user guide of "Dispersion Curve Extraction (1-D Profile)" [or "*(2-D Cross Section)"], the
simplest sequence would be, first, click the "Bounds" button and then click several points (e.g., five or
more) on the dispersion trend to mark the lower and upper bounds within which the curve will be
extracted based on the maximum amplitude at each frequency. Then, click the "Extract" button to
extract the curve shown in the image below. Click "Save" to save the extracted curve (*.DC). This is the
"average" dispersion curve that is representative of the entire survey area and you can import it during
the BSA operation.
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3.3 Running FV-LMO
In the main menu, go to "Process" → "Back-Scattering Analysis (BSA)" and then select the sample data in
"...\Sample Data\VOID\VOID(SR).DAT."

Select the "FV-LMO" tab in the dialog, and then click the "Run FV-LMO" button as shown below.
"Dispersion" and "Output" will be automatically executed in the order.
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Import the dispersion curve file ("VOID.DC") that was used to generate the sample data set. You can
also use your own dispersion curve file processed from the sample data by following the normal
procedure of dispersion analysis as explained in section 3.2.

Then, specify output file name [*(FV-LMO).DAT].

The output will be displayed in a separate window as shown below.
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3.4 Running TAVO
In the main menu, go to "Process" → "Back-Scattering Analysis (BSA)" and then select the sample data in
"...\Sample Data\VOID\VOID(SR).DAT."

Select the "TAVO" tab in the dialog, and choose the type of horizontal coordinate for the output.
Default type is "distance" as shown below. Then, click "Run TAVO" button as shown below. It will ask
for the output file name specification. Output will be saved according to the dispersion curve format
(*.DC) so that they can be displayed using the corresponding module ("Display" → "Dispersion Curve") in
the main menu.
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Output will be displayed in a separate window as shown below. Each record's output of TAVO is saved
as one dispersion curve file (*.DC). There will be a total of fifty (50) files saved and displayed in the
window.
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4. Common-Offset Section  "Working with Sample Data"
In the main menu, go to "Process" → "Common-Offset (CO) Section" and then select the sample data in
"...\Sample Data\VOID\VOID(SR).DAT."

4.1 Generating Common-Offset Sections
The following dialog will display that has options for output trace arrangement. Click the indicated
button to specify the output file name.
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The generation will be automatically executed and the output will be displayed.

To zoom in to the top 1-sec portion of the output, select the "View" tab, press the "zoom-in" button
once and then drag mouse to encompass the portion of display as illustrated below.

The record number displayed on top indicates the corresponding common offset multiplied by 100; for
example, "600" for 6-m common offset as illustrated below. Different common-offset sections can be
viewed by pressing one of the four record-scan buttons in the "Data" tab, one of which is indicated
below. One side of the symmetric scattering feature on a common-offset section, which appears similar
to the hyperbolic arrival pattern of body-wave diffraction, can be identified as slant patterns (sloping
down from right to left) originating from the corresponding surface location (44-m).
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Another common-offset section (17-m) is displayed below that shows a similar feature from the void
location.

This shows the longest common-offset section (29-m).
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4.2 Horizontal Event (HE) Filtering
Usually, the scattering feature can be enhanced by filtering out the horizontal arrivals using "Horizontal
Event (HE)" filtering. To do that, select the "Process" tab in the BSA display window. Then, right-click
the "Filter" button to display the dialog shown below. Check "Save output" and enter
"VOID(SR)(CO)(HE=5)" for output file name when prompted as illustrated in the "Save As" dialog.

Then, (normal) click the "Filter" button and double click any place in the display as illustrated below.
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Choose "Horizontal Events", specify a value (e.g., "5") in the "Horizontal Window (%)", and then click OK
to execute filtering for all records. A value less than or equal to 5 (%) is usually optimal. A smaller
number would be necessary if the horizontal event has the higher dominant frequency, and vice versa.
Click "Yes" to display output.

The display normalization option can be changed by using the button (1) in the "View" tab. Surface
coordinates of the display can also be chosen for trace number (2), station number (3), and the surveyline distance (3) buttons; (3) and (4) represent the source-receiver center coordinates.
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Double click any place in the display to show the following control dialog in which all display
characteristics can be modified. For example, labeling characteristics on the horizontal (surface) and
vertical (time) axes can be changed in the "Labeling" tab as shown below.

The following section shows the horizontal coordinate of the center station number between source and
receiver for the shortest (6-m) common-offset section.
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The following section shows the horizontal coordinate of the center station number between source and
receiver for the intermediate (17-m) common-offset section.

The following section shows the horizontal coordinate of the center station number between source and
receiver for the longest (29-m) common-offset section.
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1. Overview
The most common purpose for running a passive MASW survey is to increase the investigation depth
(Zmax) beyond the limit of most active surveys (e.g., 30 m). There are two conditions that have to be
met to increase Zmax; a more powerful source that can generate "strong" low frequencies (long wavelengths) of surface waves, and a longer receiver array that can effectively record such long wavelengths.
The impact power (E) of an active source like a sledge hammer can be increased by adding more weight
(m) and/or increasing the impact speed (v) because it is the kinetic energy [E = (1/2)mv2] that is
transformed into the elastic (seismic) energy upon impact. In this way, an accelerated weight drop
source can generate a greater E than a sledge hammer. In reality, however, this artificial increase of E
can be limited because it eventually faces the obstacle of operational and economical cost. That's why
the passive MASW surveys utilizing ambient vibrations (usually generated from traffic) have become
popular. Figure 1 illustrates the comparison of E from typical active and passive sources. It indicates the
common passive E is greater than the active E by a few orders of magnitude. These surface waves from
of traffic origin are generated from irregular places on the road when vehicles are travelling over them
(Figure 2). The usual frequency range is from a few to a few tens of hertz (e.g., 1-30 Hz) and the low-end
frequencies (e.g., 1-10 Hz) are most useful because they are not easily generated with sufficient energy
using typical active sources, but are often critical to increase Zmax beyond the common range (e.g., ≥ 30
m). It is speculated that the combination of the large mass and shock-absorbing mechanism (tire and
suspension spring) of the vehicle facilitates the generation of such low frequency surface waves.
The array length (L) has to be in proportion to the Zmax; the longer array is needed for a deeper
investigation. The most commonly used relationship between the two is minL ≤ Zmax ≤ maxL, with min
= 0.5 and max = 1.0. Although the actual relationship can be influenced by other acquisition and
processing factors such as signal-to-noise (SN) ratio of acquired data and the specific algorithm used
during the dispersion analysis, the most common rule of thumb is L = 2Zmax (Figure 3). In this case, it is
usually assumed that the optimum source offset (X1) is about 1/4 of the array length; i.e., X1 = (1/4)L
(Park et al., 1999; Park et al., 2002; Park and Carnevale, 2010). It is also the source offset (X1) that can
contribute positively in increasing Zmax (Park and Carnevale, 2010; Yoon and Rix, 2009). Therefore,
some studies indicate it should be X1 + L = 2Zmax (Yoon and Rix, 2009). In this case, X1 should remain
within a reasonable range to avoid the use of an excessively short (or long) array; for example, X1 + L =
2Zmax with X1 ≤ L. However, it seems that the significance of X1 can vary with site geology (i.e., velocity
structure) and it can be out of the equation as far as the array length (L) becomes sufficiently long for
Zmax (for example, L ≥ 2Zmax). With a passive survey, the dimension (D) of the array is set
approximately twice Zmax (Figure 4); D ≈ 2Zmax. This also applies to the active/passive combined
survey that is essentially identical to the active survey using a long recording time (e.g., T ≥ 30 sec) as
further explained below.
Although it is always recommended to use a 2-D array for a passive survey such as a circle or an Lshaped array for the maximized accuracy in dispersion analysis, it is not always convenient to secure
such spacious areas, especially during an urban survey. Deployment of the conventional linear (1-D)
array is often the only option available. The most convenient way of utilizing passive surface waves
during an active survey for the 2-D velocity (Vs) profiling is the active/passive combined survey. This is
the same as an ordinary active survey that uses the linear array and continues to make measurements at
successive locations by moving the source/receiver configuration (i.e., a roll-along survey). The only
difference is its recording time (e.g., T ≥ 30-sec) significantly longer than the usual time used in an active
2
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survey (e.g., T=2-sec). The first 1-2 seconds of the record will contain most of the active surface waves,
while the rest of the record contains ambient vibrations of passive surface waves. In this way, it is a
combination of the conventional active survey and the passive survey using the 1-D (linear) receiver
array. Although the dimension of the passive array in this case (i.e., D=L) will be shorter than the length
usually recommended for a passive survey (e.g., D≈2L), the recorded strong low-frequency surface
waves will increase the chance of imaging dispersion patterns at the lowest frequencies with the highest
definition that the given array can ever provide. This is the way the investigation depth can exceed the
range that can be achieved by an active survey alone; for example, Zmax ≥ L.
A passive MASW can be executed during either 1-D or 2-D velocity (Vs) profiling for the purpose of an
increased investigation depth (Zmax). During the survey for 1-D Vs profiling, the separate active survey
has to be performed near the center of the array used for the passive survey. The field geometry for the
active survey can be chosen in such a way that it can cover depths about half the Zmax aimed for during
the passive survey. During the survey for 2-D velocity (Vs) profiling, the passive survey can be arranged
at one location (e.g., at the center of the survey line) or multiple locations (e.g., at the beginning, the
center, and the end of the survey line) with a dimension (D) of D ≥ 2L as illustrated in Figure 5.
There are two ways to utilize passive MASW data (Figure 6)—providing the fundamental-mode (M0)
dispersion at such low frequencies where the active data usually fails to show any meaningful patterns
(Figure 6a); and providing dispersion patterns that, when combined with patterns analyzed from the
active data, can make the overall modal interpretation more effective (Figure 6b). In any case, the
passive data is not used by itself and always used in combination with active data. The former way of
utilization is most common because it directly leads to an increased Zmax. The latter is chosen when it
is necessary to accurately interpret those complicated dispersion patterns otherwise interpreted
erroneously or that are difficult to interpret at all. The more accurate dispersion analysis facilitated in
this way will result in the more accurate velocity (Vs) profile at the end. This type of utilization, however,
requires a systematic preparation of data acquisition and processing steps, and therefore is usually
implemented for research purposes or for certain special projects. The two types of utilization are
illustrated in Figure 6 using real field data sets.
In theory, it is the 2-D receiver array (e.g., circle), rather than a 1-D linear array, that can ensure the
most accurate dispersion analysis because of the two unknowns in passive surveys that do not exist in
the active surveys—the excitation time and location of the source. The former is not an obstacle in
most data-processing algorithm used nowadays that require only the relative (not absolute) arrival
times of surface waves. The source location, however, is important because it directly influences the
phase relationship of surface waves depending on the distance (r) and azimuth () of the source location.
The original formulation of SPAC (spatial autocorrelation) method by Aki (1957) was based on the
assumption that recorded passive surface waves are plane waves generated from an infinite distance
(i.e., r >> D) with their azimuths distributed throughout all 360 degrees (i.e., omni-directional plane
waves). This assumption made it possible to cancel out the two variables (r and ) from the equation
through a proper summation process. The method by Park et al. (2004) also adopted this "omnidirectional plane wave" assumption so that it can construct the dispersion image through the energy
summation in r and , which in ultimate mathematical formulation can become identical to SPAC. Park
and Miller (2008), however, indicated that those passive surface waves culturally generated (for
example, from traffic) rather than naturally generated (for example, from tidal motion) do not meet the
assumption. This research indicated that passive surface waves are often generated from one or a few
irregular surface points on the road near the receiver array so that they usually take the "uni-directional
cylindrical" (rather than "omni-directional planar") propagation. If the dispersion analysis scheme by
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SPAC or Park et al. (2004) is used in this case, the processed image suffers from a low definition as well
as biased trend of dispersion. In addition, Park (2008) indicated that it is the accurate resolution in
azimuth () once the distance (r) becomes greater than the array dimension (D) that is most critical in
constructing an accurate image with the highest definition ever possible. Park (2010) further improved
this concept by dividing a long (e.g., 30-sec) passive record into many subrecords of shorter time (e.g., 2sec), each of which is treated as an independent record potentially containing surface waves generated
from one (dominating) surface location near the receiver array (r > D). Therefore, use this method from
Park (2010) for dispersion analysis of passive MASW data is highly recommended, especially when a 2-D
receiver array is used. It will provide a useful dispersion image, even when all other methods fail to
provide any recognizable pattern. It can also provide a quality image from the passive data collected by
using the 1-D (linear) array. In this case, however, the search for azimuth () will take place only in
forward (=0) and reverse (=180) propagations instead of the full 360 search. Park and Miller (2008)
indicated that phase velocities can be overestimated if a 1-D array is used during a passive survey.
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Figure 1. Comparison of impact energy from typical active and passive sources.

Figure 2. Irregular road surfaces that generate surface waves when vehicles are moving over them.
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Figure 3. Relationship between the receiver array length (L) and maximum investigation depth (Zmax)
used during an active survey.

Figure 4. Relationship between the receiver array dimension (D) and maximum investigation depth
(Zmax) used during a passive survey.
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Figure 5. Illustration showing that the passive survey with a 2-D receiver array may be most optimally
executed at a place near the center of an active survey line.

Figure 6. Two possible ways of utilizing the passive dispersion image. The first (a) provides the trend of
fundamental-mode (M0) dispersion at the lower frequencies; the second (b) provides a constraint for
more accurate modal interpretation of observed dispersion trends.
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2. Passive MASW ─ Sample Data Sets
To practice generating the shear-wave velocity (Vs) profiles (1-D or 2-D), various sample data sets are
provided in the "...\Sample Data\" folder in the application directory. Three types of data are
provided—data sets obtained from active ("...\Active\"), passive ("...\Passive\"), and combined
("...\Combined\") MASW surveys. All sample data sets are provided in PS format. See PS User Guide
"Sample Data" for more details.

2.1 Passive Survey Data Set
Four (4) passive survey data sets are provided that were recorded using four (4) different types of 2-D
receiver arrays (RA's)—circle ["...\PAS(Circle-RA).dat"], cross ["...\PAS(Cross-RA).dat"], L-shape
["...\PAS(L-RA).dat"], and random ["...\PAS(Random-RA).dat"]. A passive data set recorded using a 1-D
(linear) receiver array is considered identical to the data set from the active/passive combined survey
described below. The data analysis procedure is demonstrated from source/receiver (SR) setup to
dispersion imaging steps, while the remaining steps will be identical to those demonstrated in the active
data sets. Because the most common way of utilizing passive data is to provide useful dispersion
information at such low frequencies where active data usually does not provide objective dispersion
trends, it is also demonstrated to combine the passive and active dispersion images. All passive data
sets are synthetic (model) data created by using the reflectivity modeling module included in the main
menu [see PS User Guide "Modeling Seismic Data" for details]. A 48-channel acquisition of relatively
short recording time (T≈8 sec) with a 4-ms sampling interval (dt) was used during the modeling.
Although the actual recording time for a passive survey will be usually much longer than this (for
example, T = 30 sec), the short recording time was due to the limitation in the modeling module.
Generation of surface waves (from 5 to 100 Hz) was simulated during the modeling by placing multiple
(4) active source points at a certain distance (i.e., approximately the same distance as the dimension of
the receiver array) away from the 2-D RA distributed along the full 360-degree azimuth range with an
equal interval of 90 degrees, as shown in Figures 7-10. Excitation time of each source point was
modeled with a 2-sec interval between the two successive points (for example, 1-sec, 3-sec, 5-sec, and
7-sec for source points at 0 degrees, 90 degrees, 180 degrees, and 270 degrees, respectively). This
azimuth and source excitation time information is obtained as by-products during the dispersion
imaging process by Park (2010) (see PS User Guide "Dispersion Image Generation" for more details).
How to display this information after generation of the dispersion image from the passive data set is
also demonstrated.

2.2 Active/Passive Combined Survey Data Set
A real data set of 24-channel acquisition with 120-sec recording time (4-ms sampling interval) is
provided in "...\Combined\RDMASW.dat." This data was acquired along the roadside (RD) of a local
highway. There are a total of eighteen (18) field records included in the data set. It was acquired during
a roll-along active MASW survey using a land streamer of 4.5-Hz geophones with 4-ft interval (i.e., dx=4
ft) that moved over a relatively short surface distance of 18 successive shot points separated by 8-ft (i.e.,
dSR=2dx) for the purpose of experimentation (Figure 11). A sledge hammer (10-lb) was used as the
source to deliver an impact at 24-ft (i.e., X1=6dx) ahead of the first (1st) channel. All acquisition
geometry parameters (X1, dx, and dSR) were identical to those used during the active survey. However,
recording parameters of T=120 sec with dt=4 ms were used, which are significantly different from those
used during the active survey (i.e., T=1 sec with dt=0.5 ms). The objective with this combined-survey
8
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was to demonstrate the advantage of this longer recording time adopted during an active survey
(making it an active/passive combined survey) so the chance of capturing lower frequencies (longer
wavelengths) of surface waves from ambient vibrations of cultural (e.g., traffic) and/or natural (e.g.,
ocean surf activities) origins are increased. This advantage will eventually lead to the generation of a
velocity (Vs) profile (1-D or 2-D) with the deepest investigation depth ever possible with a given
acquisition configuration and/or a velocity profile with the most accurate bedrock velocity (or velocity at
depths in general) as a result of including lower frequencies in the analyzed dispersion curve. In theory,
two conditions have to be met to increase the investigation depth (or velocity accuracy at depths)—
generation of low frequency (long wavelength) components of surface waves and the use of a long
receiver array to capture such low frequencies (long wavelengths). The former is the condition to
generate such surface waves responding to subsurface velocity (Vs) at deep depths, whereas the latter is
the condition to analyze propagation properties (phase velocities) of such low frequency components as
accurately as possible. Increasing the recording time will make the receiver array "listen" to the ambient
vibration right after it finishes "listening" to the active surface waves coming from the active source
point. In this way, the chance of recording lower-frequency components will be increased. However, in
theory, accurate analysis of phase velocity for these components requires the use of a "wide
measurement aperture", which is the long receiver array. This indicates that recording low frequency by
itself will be limited in increasing the investigation depth (or accuracy of velocity at depths) unless
accompanied by the use of an accordingly long receiver array (RA). On the other hand, the use of a long
RA decreases lateral resolution in the final output of a 2-D Vs cross section. In reality, therefore, the
advantage of the combined survey will be maximized only when a moderately long receiver array (e.g.,
> 100-ft) ─ a trade-off between investigation depth and lateral resolution ─ is used at the place where
relatively strong ambient vibration prevails with dominant frequencies (e.g., ≤ 15 Hz) lower than those
expected in active surveys (e.g., ≥ 15 Hz).
The sample data set "RDMASW.dat" was obtained along the roadside of a local highway using a 10-lb
sledge hammer source to trigger a 120-sec recording at each place of measurement. To illustrate the
advantage of this survey in comparison to the active survey with a short recording time (T=1 sec), a set
of active data was prepared by selecting only the first 1-sec portion of all 18 field records and then the
normal active-data analysis procedure was applied to it. Figure 12a shows the average dispersion image
obtained by sacking all (18) individual dispersion images generated from this active data set, and Figure
12b shows the average dispersion image obtained from the combined-survey data set of full 120-sec
recording time. The latter dispersion image clearly shows more energy at lower frequencies (e.g., ≤ 15
Hz) than the former dispersion image does. Figures 13a and 13b show the 2-D Vs cross sections
obtained by processing individual dispersion images included in each set of dispersion-image data. The
same investigation depth of 50 ft, which is considered the optimal depth for the active data set, was
used for construction of a combined-survey Vs cross section. Both sections show relatively shallow
bedrock (≤ 10 ft) with a mild lateral topographic variation. Overburden velocities are shown less than
about 800 ft/sec in both sections. However, bedrock velocities are in a range of 2000-3000 ft/sec in the
active section, whereas they are 3000-4000 ft/sec in the combined-survey section. Bedrock velocities in
the latter section would be more reliable.
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Figure 7. Configuration of circle receiver array and incoming direction of surface waves.

Figure 8. Configuration of cross receiver array and incoming direction of surface waves.
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Figure 9. Configuration of L-shape receiver array and incoming direction of surface waves.

Figure 10. Configuration of random receiver array and incoming direction of surface waves.
11

PS - Passive MASW (Data Acquisition and Processing)

Figure 11. Source/receiver (SR) configuration used during the combined survey.

(a)

(b)

Figure 12. Average dispersion image for the first 1-sec portion (a) and the entire 120-sec portion (b) of
the combined survey data set.
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(a)

(b)

Figure 13. 2-D shear-wave velocity (Vs) cross sections obtained from the first 1-sec portion (a) and the
entire 120-sec portion (b) of the combined survey data.
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3. Passive MASW ─ Data Processing
The entire procedure of processing passive data is demonstrated in sections 3 and 4 of the PS User
Guide "Sample Data."

3.1 Passive Data From 2-D Receiver Array
See section 3.1 of the user guide "Sample Data."

3.2 Passive Data From 1-D Receiver Array
See section 3.2 of the user guide "Sample Data."

3.3 Adding Passive Dispersion Image To Active Image
See section 3.3 of the user guide "Sample Data."

3.4 Data From Active/Passive Combined Survey
See section 4 of the user guide "Sample Data."
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1. Overview
For the practice purpose of generating the shear-wave velocity (Vs) profiles (1-D or 2-D), various types of
sample data sets are provided in the "...\Sample Data\" folder in the application directory. Three types
of data exist in the folder; data sets obtained from active ("...\Active\"), passive ("...\Passive\"), and
combined ("...\Combined\") MASW surveys. All sample data sets are provided in PS-format.

1.1 Active Survey Data Set
There are two different types of active data sets; one that is used to generate a 1-D Vs profile
["SampleData(Vs1D).dat"] and another to produce a 2-D Vs cross section ["SampleData(Vs2D).dat"]. The
entire procedures of data analysis using these two data sets are explained in separate user guides of
"Generating 1-D Profile (Working with Sample Data)" and "Generating 2-D Cross Section (Working with
Sample Data)", respectively.

1.2 Passive Survey Data Set
Four (4) passive survey data sets are provided that were recorded using four (4) different types of 2-D
receiver arrays (RA's)—circle ["...\PAS(Circle-RA).dat"], cross ["...\PAS(Cross-RA).dat"], L-shape
["...\PAS(L-RA).dat"], and random ["...\PAS(Random-RA).dat"]. A passive data set recorded using a 1-D
(linear) receiver array is considered identical to the data set from the active/passive combined survey
described below. The data analysis procedure is demonstrated from source/receiver (SR) setup to
dispersion imaging steps, while the remaining steps will be identical to those demonstrated in the active
data sets. Because the most common way of utilizing passive data is to provide useful dispersion
information at such low frequencies where active data usually does not provide objective dispersion
trends, it is also demonstrated to combine the passive and active dispersion images. All passive data
sets are synthetic (model) data created by using the reflectivity modeling module included in the main
menu [see the user guide "Modeling (Seismic Data)"]. A 48-channel acquisition of relatively short
recording time (T≈8 sec) with a 4-ms sampling interval (dt) was used during the modeling. Although the
actual recording time for a passive survey will be usually much longer than this (for example, T = 30 sec),
the short recording time was due to the limitation in the modeling module. Generation of surface
waves (from 5 to 100 Hz) was simulated during the modeling by placing multiple (4) active source points
at a certain distance (i.e., approximately the same distance as the dimension of the receiver array) away
from the 2-D RA distributed along the full 360-degree azimuth range with an equal interval of 90
degrees as shown in Figures 1-4. Excitation time of each source point was modeled with a 2-sec interval
between the two successive points (for example, 1-sec, 3-sec, 5-sec, and 7-sec for source points at 0
degrees, 90 degrees, 180 degrees, and 270 degrees, respectively). This azimuth and source excitation
time information is obtained as by-products during the dispersion imaging process by Park (2010) (see
the user guide "Dispersion Image Generation" for more details). How to display this information after
generation of the dispersion image from the passive data set is also demonstrated.

1.3 Active/Passive Combined Survey Data Set
A real data set of 24-channel acquisition with 120-sec recording time (4-ms sampling interval) is
provided in "...\Combined\RDMASW.dat." This data was acquired along the roadside (RD) of a local
highway. There are a total of eighteen (18) field records included in the data set. It was acquired during
2
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a roll-along active MASW survey using a land streamer of 4.5-Hz geophones with 4-ft interval spacing
(i.e., dx=4 ft) that moved over a relatively short surface distance of 18 successive shot points separated
by 8-ft (i.e., dSR=2dx) for the purpose of experimentation (Figure 1). A sledge hammer (10-lb) was
used as the source to deliver an impact at 24-ft (i.e., X1=6dx) ahead of the first (1st) channel. All
acquisition geometry parameters (X1, dx, and dSR) were identical to those used during the active survey.
However, recording parameters of T=120 sec with dt=4 ms were used, which are significantly different
from those used during the active survey (i.e., T=1 sec with dt=0.5 ms). The objective with this
combined-survey was to demonstrate the advantage of this longer recording time adopted during an
active survey (making it an active/passive combined survey) so the chance of capturing lower
frequencies (longer wavelengths) of surface waves from ambient vibrations of cultural (e.g., traffic)
and/or natural (e.g., ocean surf activities) origins are increased. This advantage will eventually lead to
the generation of a velocity (Vs) profile (1-D or 2-D) with the deepest investigation depth ever possible
with a given acquisition configuration and/or a velocity profile with the most accurate bedrock velocity
(or velocity at depths in general) as a result of including lower frequencies in the analyzed dispersion
curve. In theory, two conditions have to be met to increase the investigation depth (or velocity accuracy
at depths)—generation of low frequency (long wavelength) components of surface waves and the use of
a long receiver array to capture such low frequencies (long wavelengths). The former is the condition to
generate such surface waves responding to subsurface velocity (Vs) at deep depths, whereas the latter is
the condition to analyze propagation properties (phase velocities) of such low frequency components as
accurately as possible. Increasing the recording time will make the receiver array "listen" to the ambient
vibration right after it finishes "listening" to the active surface waves coming from the active source
point. In this way, the chance of recording lower-frequency components will be increased. However, in
theory, accurate analysis of phase velocity for these components requires the use of a "wide
measurement aperture", which is the long receiver array. This indicates that recording low frequency by
itself will be limited in increasing the investigation depth (or accuracy of velocity at depths) unless
accompanied by the use of an accordingly long receiver array (RA). On the other hand, the use of a long
RA decreases lateral resolution in the final output of a 2-D Vs cross section. In reality, therefore, the
advantage of the combined survey will be maximized only when a moderately long receiver array (e.g.,
> 100-ft) ─ a trade-off between investigation depth and lateral resolution ─ is used at the place where
relatively strong ambient vibration prevails with frequencies (e.g., ≤ 15 Hz) lower than those expected in
active surveys (e.g., ≥ 15 Hz).
The sample data set "RDMASW.dat" was obtained along the roadside of a local highway using a 10-lb
sledge hammer source to trigger a 120-sec recording at each place of measurement. To illustrate the
advantage of this survey in comparison to the active survey with a short recording time (T=1 sec), a set
of active data was prepared by selecting only the first 1-sec portion of all 18 field records and then the
normal active-data analysis procedure was applied to it. Figure 6a shows the average dispersion image
obtained by sacking all (18) individual dispersion images generated from this active data set, and Figure
6b shows the average dispersion image obtained from the combined-survey data set of full 120-sec
recording time. The latter dispersion image clearly shows more energy at lower frequencies (e.g., ≤ 15
Hz) than the former dispersion image does. Figures 7a and 7b show the 2-D Vs cross sections obtained
by processing individual dispersion images included in each set of dispersion-image data. The same
investigation depth of 50 ft, which is considered the optimal depth for the active data set, was used for
construction of a combined-survey Vs cross section. Both sections show relatively shallow bedrock (≤ 10
ft) with a mild lateral topographic variation. Overburden velocities are shown less than about 800 ft/sec
in both sections. However, bedrock velocities are in a range of 2000-3000 ft/sec in the active section,
whereas they are 3000-4000 ft/sec in the combined-survey section. Bedrock velocities in the latter
section would be more reliable.
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Figure 1. Configuration of circle receiver array and incoming direction of surface waves.

Figure 2. Configuration of cross receiver array and incoming direction of surface waves.
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Figure 3. Configuration of L-shape receiver array and incoming direction of surface waves.

Figure 4. Configuration of random receiver array and incoming direction of surface waves.
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Figure 5. Source/receiver (SR) configuration used during the combined survey.

(a)

(b)

Figure 6. Average dispersion image for the first 1-sec portion (a) and the entire 120-sec portion (b) of
the combined survey data set.
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(a)

(b)

Figure 7. 2-D shear-wave velocity (Vs) cross sections obtained from the first 1-sec portion (a) and the
entire 120-sec portion (b) of the combined survey data.
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2. Active Survey (1-D and 2-D Vs Profiling)
2.1 1-D Shear-Wave Velocity (Vs) Profiling
See the user guide "Generating 1-D Profile (Working with Sample Data)."

2.2 2-D Shear-Wave Velocity (Vs) Profiling
See the user guide "Generating 2-D Cross Section (Working with Sample Data)."
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3. Passive Survey
3.1 Using 2-D Receiver Array (RA)
3.1.1 Circle RA
Importing input data "PAS(Circle-RA).dat"

Running Source/Receiver (SR) Setup
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Generation of Dispersion Image

Display of (Passive) Source Information (Azimuth and Excitation Times)
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3.1.2 Cross RA
Importing input data "PAS(Cross-RA).dat"

Running Source/Receiver (SR) Setup
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Generating of Dispersion Image
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Display of (Passive) Source Information (Azimuth and Excitation Times)
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3.1.3 L-Shape RA
Importing input data "PAS(L-RA).dat"

Running Source/Receiver (SR) Setup
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Generation of Dispersion Image
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Display of (Passive) Source Information (Azimuth and Excitation Times)
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3.1.4 Random RA
Importing input data "PAS(Random-RA).dat"

Running Source/Receiver (SR) Setup
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Importing Receiver Array (RA) Coordinates ["RA(Random).TXT"]
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Generation of Dispersion Image

Display of (Passive) Source Information (Azimuth and Excitation Times)
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3.2 Using 1-D Receiver Array (RA)
A passive survey using a 1-D linear receiver array is considered identical to the active/passive combined
survey. See section "4. Active/Passive Combined Survey."
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3.3 Combining Active and Passive Dispersion Images
3.3.1 Generating Active Dispersion Image
Importing and Processing Active Data For Combining Purpose

Running Source/Receiver (SR) Setup
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Generation of Dispersion Image
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3.3.2 Combining with Passive (Circle-RA) Dispersion Image
Importing the Passive Dispersion Image ["PAS(Circle-RA)(PassiveOT).dat"]
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Click the vertical axis to change display scale.
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Click horizontal axis to change display scale.

To display grids, depress the "Grids" button in the "Scale" tab.
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Importing Theoretical Dispersion Curves to Display on top of Combined Dispersion Image
(For Interpretation Purposes)
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Select All Modes (M0-M5)

Shift-Click Each Legend to Mark Each Curve
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4. Active/Passive Combined Survey
4.1 Processing Roadside Data ("RDMASW.dat") from Combined Survey
Importing Input Data "RDMASW.dat"

Running Source/Receiver (SR) Setup
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Generation of Dispersion Image

For the remaining procedures, "Dispersion Curve Extraction" and "Inversion", see the corresponding
sections in the user guide of "Generating a 2-D Cross Section (Working with Sample Data)."
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The following cross section is obtained by following the remaining procedures.
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4.2 Processing Active Portion (1-Sec) of "RDMASW.dat"
Importing Input Data "RDMASW(0-1sec).DAT"

Running Source/Receiver (SR) Setup
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The remaining procedure will be identical to that of the "RDMASW.dat" described in section 4.1.
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The 2-D Vs cross section below is obtained by following the remaining procedures.
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Data Structure of ParkSEIS (PS) Format
Each trace consists of 120 elements (#1 - #120) of "header" (INTEGER*2/element) followed by X number of data
elements (FLOAT*4/element) with X specified in header #58. Diagram below illustrates the overall structure of PS
format. The key header elements are specified in the table below. Full description of all (120) header elements is
presented in the next pages.

Full Description of ParkSEIS (PS) Header

+

(Headers in Use as of 9/1/2014)
Word#

1
2
3

4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21**
22
23**
24
25
26
27**
28
29
30
31
32
33
34
35
36
37
38

Description
Data type: 0 = raw field; 1 = CDP gather; 2 = CDP stacked; 3 = record order (record-number index and
trace-number index based on values in trace-header words 3 and 4, respectively); 4 = velocity-scan data
Total recording channels
Trace-header word of record number for this data set:
8 = common recording channel number, 12 = common depth point, 19 = common offset, 86 = common
receiver station number, 87 = common source station number
92 = common source sequence number (For OT, 0=Active, 1=Roadside Passive, 2=Remote Passive)
Trace-header word of trace number within each record (0 = input order of seismic input data)
Trace-direction flag for sorted traces within each record: 1 = ascending; -1 = descending
Original field-record number
Recording-channel number
Repeated shot number (at the same station)
Time/depth flag and multiplication factor (about 1000) to fit word 57 into 16 bits: 0=time; 1 or
more=depth
Common-Mid-Point (CMP) number
Trace number within each record
Trace-identification code: 1 = seismic data; 2 = dead; 9 = velocity flag
Number of vertically summed traces yielding this trace
Number of horizontally summed traces yielding this trace
Feet/meter distance dimension flag: 0=feet; 1=meters
Offset (distance from source to receiver) after multiplication by word 35
Receiver-group elevation
Source elevation

Datum elevation
MASW Survey type (0=Active, 1=Passive, 2=Active/Passive Combined) (For OT, 1=Quad1 used)
MASW Receiver Array Type (1=1D, 2=2D) (For OT, 1=Quad2 used)
For OT, 1=Quad3 used
For OT, 1=Quad4 used
If > 0, Azimuth Data Saved
Fk-filtering working area
Fk-filtering working area
Multiplication factor (e.g., 10) for horizontal distance determined by the 3rd parameter (e.g., 10) in
"*_LOLCATION" and "*_COORDINATE" key words in "...\INI\SEG22KGSKEY.TXT" during format
X-coordinate of receiver after multiplied by word 35 (for OT, always multiplied by 10)
Y-coordinate of receiver after multiplied by word 35 (for OT, always multiplied by 10)
Z-coordinate of receiver after multiplied by word 35 (for OT, always multiplied by 10)

Word#

39
40
41
42
43
44
45
46
47
48
49
50*
51*
52*
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78
79
80
81

Description
X-coordinate of source after multiplied by word 35 (for OT, always multiplied by 10)
Y-coordinate of source after multiplied by word 35 (for OT, always multiplied by 10)
Z-coordinate of source after multiplied by word 35 (for OT, always multiplied by 10)
Reference X-coordinate for 2D Receiver Array after multiplied by word 35
Minimum X used to process OT after multiplied by word 35
Maximum X used to process OT after multiplied by word 35
Offline offset for cylindrical spreading for OT, or receiver spacing x 100 (for air-wave display on OT)

Source static correction (milliseconds)
Receiver-group static correction (milliseconds)
Total static correction (in number of samples) that has been applied to this trace (zero if no static has been
applied)

Recording-delay time (milliseconds)
-55 if stations were inserted by the program (PS)
Receiver spacing after multiplied by word 35
Number samples in this trace
Sample interval in microseconds for this trace
Integer/floating point data flag: 21930 = floating point; any other value indicates integer data

ParkSeis Version Number after multiplied by 10

Analog low-cut frequency (Hz)
Analog high-cut frequency (Hz)

Applied digital low-cut frequency (Hz)
Applied digital high-cut frequency (Hz)

Word#

82
83
84
85
86
87
88
89*
90*
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120
+

Description
Minimum receiver-station number
Maximum receiver-station number
Minimum source-sequence number
Maximum source-sequence number
Receiver-station number for this trace
Source-station number for this trace
Last trace flag: 0 = not last trace; 1 = last trace of this gather
Surface-consistent residual-receiver static (in number of samples) that has been applied to this trace
Surface-consistent residual-source static (in number of samples) that has been applied to this trace
Source-sequence number (SSN)
Processing-history file flag: 0 = no history; non-zero = number of characters in file name that follows
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word
Reserved for processing-history file name; packed ASCII, two ASCII characters per word

Modified from KGS header ("Modified SEG-Y")
*Convention for static corrections: POSITIVE value implies static shift (DOWN) away from zero-time, NEGATIVE value
implies static shift (UP) toward zero-time.
**Elevation can be either absolute (i.e., positively above sea level) or relative (with reference to fixed altitude). In both cases, the
orientation is such that higher elevation is positive. Therefore, increasing depth is indicated by the smaller value for elevation.

